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Chapter 1. Overview of the SAP R/3 print feature

The following describes the benefits derived by business enterprises that use SAP
R/3 and either Infoprint Manager for AIX Version 4 Release 1 or Infoprint
Manager for Windows Version 2 Release 1 to manage their print environments.

Infoprint Manager and SAP R/3
A large international corporation is committed to a SAP R/3 enterprise to manage
their data processing across all departments. They especially appreciate the SAP
R/3 option provided by Infoprint Manager. Infoprint Manager and SAP R/3
combine to provide a robust solution that manages all printing the way SAP R/3
manages and keeps track of their entire business, from external documents sent to
customers, to reports created for internal distribution and printed at the desktop.
Because Infoprint Manager can manage both the high-end production printers and
the low-end desktop (network) printers, it meets their needs as no other print
application on the market today.

SAP R/3 has become a popular choice for medium to large-sized companies that
require an integrated software product to provide basic business automation. The
R/3 client/server application provides business a series of integrated modules that
span the major functions of finance, manufacturing, sales distribution, and human

Figure 1. SAP R/3 Product Logo

Figure 2. An Infoprint Manager SAP R/3 Configuration
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resources. IBM’s four decades of experience in printing and data management
translates into billions of pages printed annually in more that 130 countries,
solidifying our leadership position in the enterprise printing environment.
Integrate IBM’s printing expertise with SAP’s leading business application software
for a winning combination.

Reliable Notification about job status to SAP users
SAP R/3 (Release 4 and above) provides support to closely integrate an external
Output Management System (OMS) with a SAP system. Both Infoprint Manager
for AIX and Infoprint Manager for Windows 2.1 (with PTF UR53740) provide SAP
OMS support.

Using Infoprint Manager SAP OMS support, your SAP users can receive
notifications on the jobs that they have submitted for printing. It also provides
support to allow a SAP user to:
v Cancel one or more jobs
v Query the status of one or more jobs
v Query the status of an Infoprint printer and its jobs

Adding electronic forms, logos, and electronic signatures to text
documents

The Advanced Function Presentation (AFP) data stream that emerges from the
Infoprint SAP transform contains text records that you can enhance through the
addition of electronic forms, logos, and electronic signatures. In addition to the
AFP resources, the Infoprint Manager SAP transform has been enhanced to
support both raw image data (bitmap images) and box shading. The expanded
support for different levels of box shading and the print images that SAP R/3
users have come to expect and appreciate provides a strong, industry standard for
printing from SAP R/3. Print SAP color images in black and white, using the
native Output Text Format (OTF) data stream in either one, four, or eight-bit pixel
images: Infoprint Manager can handle it all. And Infoprint Manager’s double-byte
character set (DBCS) enablement allows support for the Shift-JIS Japanese
language and the Korean language.

Even if you are printing on PCL and PPDS non-impact printers, the SAP Print
feature provides benefit by allowing you to print bar codes without installing
expensive bar code SIMMs on each printer. Infoprint Manager allows a world-class
set of business application modules designed for a client-server environment the
ability to achieve world-class printing.

Reliable management of the print environment
With Infoprint Manager, you can manage printers and devices from a single point
of control. You can track and manage jobs across your enterprise from job
submission to printed output. When output does not print, operators no longer
have to determine whether or not a spool request was generated. Instead of having
to walk over to the printer, they can use the Infoprint Manager graphical user
interface (GUI) to pinpoint where in the process the job is delayed and determine
the appropriate action to resolve the problem. Infoprint Manager provides
automatic workload balancing among printers that you have defined with the
same characteristics. For more information about how to configure printers and
monitor printing across an installation, see either Infoprint Manager for AIX:
Procedures or Infoprint Manager for Windows: Procedures.
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The Infoprint Manager SAP OMS support with PTF U48468 on Infoprint Manager
for AIX or PTF UR53740 on Infoprint Manager for Windows also allows you to
easily:
v Switch the Infoprint Manager system to which you are sending jobs
v Send jobs to multiple Infoprint Manager systems
v Failover to other Infoprint Manager servers in the same Infoprint Manager

system

Scalability of printing across an enterprise
Infoprint Manager allows SAP R/3 customers to access the full range of IBM
Infoprint printers (low-speed to high-speed. simplex or duplex, continuous forms,
or cut sheet) as well as other printers, such as Hewlett-Packard and Lexmark. You
can leverage your investment in printers by sharing your Infoprint-managed
printers with other host, and LAN-based applications. Infoprint Manager provides
the SAP R/3 enterprise with comprehensive print management across an
enterprise of any size, providing print integrity through built-in error recovery.

SAP clients and features
Infoprint Manager provides client support for SAP systems running on AIX,
HP-UX, Sun Solaris, and Windows. By installing an Infoprint Manager SAP Client,
you can always print PCL and PostScript jobs, but to gather the additional support
cited in Table 1, you must install the SAP Print Feature on your Infoprint server.
The Infoprint Manager for AIX and the Infoprint Manager for Windows SAP Print
features contain both the the SAP Output Management support and the SAP
transform that allows SAPGOF device type output to be transformed to AFP for
printing on PCL and IPDS printers. The Infoprint Manager for AIX SAP Print
feature also includes the SAPconnect fax support.

Table 1. SAP Print Feature functions and Operating Systems

Infoprint Manager
Server Systems

OMS Support SAPconnect Fax
Support

SAPGOF device type
(OTF and ABAP)
Support

AIX yes yes yes

Windows yes no yes

January 27, 2003
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Chapter 2. About this publication

This publication describes how a business enterprise that uses SAP R/3 can use
either Infoprint Manager for AIX or Infoprint Manager for Windows to manage its
print environment. This document is divided into four parts that you can use to
plan, implement, and print to Infoprint Manager. Note that some of these topics
repeat sections of installation procedures. You should determine whether you want
to run an OMS or a non-OMS configuration, and then decide which topics best fit
your installation’s print needs. For a description of the benefits provided by and
configuration tasks associated with an OMS configuration, see “An overview of
SAP R/3 and OMS” on page 15.

Who should read this publication
This publication contains information for administrators who create and configure
both the Infoprint environment and the SAP R/3 environment. IBM recommends
that users possess a detailed knowledge of a SAP R/3 environment, as well as
experience administering and maintaining either AIX or Windows operating
systems. In addition to using this publication, you should also consult:
v SAP R/3 online documentation whenever appropriate
v Infoprint Manager for AIX: Getting Started for information about installing the

Infoprint Manager for AIX 4.1 product
v Infoprint Manager for Windows: Getting Started for information about installing the

Infoprint Manager for Windows 2.1 product

Once you have installed the appropriate components on both your Infoprint
server(s) and your SAP server(s), see Infoprint Manager: Reference for information
about the various Infoprint commands, utilities, and attributes available to you
while maintaining the system.

Most recent information
The most recent product information (including updates of this manual and the
related Infoprint Manager publications), is found on the World Wide Web at the
IBM Printing Systems site (http://www.ibm.com/printers). From the Printing
Systems homepage:
1. Under Resources For, click Infoprint Manager.
2. Under Products in the right hand navigation bar, click Infoprint Manager for

AIX or Infoprint Manager for Windows.
3. Under More Information, click Product Library.
4. Click on the appropriate Infoprint Manager publication.

How to use this publication
To insure that your SAP application servers are correctly integrated with the
Infoprint server, you must install the Infoprint Manager SAP client(s) wherever a
Spool Work Process (SWP) resides that will make print requests to Infoprint
Manager logical destinations. The Infoprint Manager SAP Clients include
everything needed to be installed on the SAP application servers. In addition, you
need to install the SAP Print feature on the Infoprint server or servers.
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Note: At a minimum, on every AIX system on which you will be running the SAP
(sap2afp) transform (on your Infoprint servers), you must have the following
fileset installed:
bos.loc.adt.iconv (Language Converter Development Toolkit)

This document consists of the following four parts:
1. Part 1, “Introduction”, on page 1.

This topic consists of this overview chapter, a review of the publications
available for Infoprint Manager, and an overview of Infoprint Manager’s SAP
Print Feature that describes the benefits available to SAP R/3 users.

2. Part 2, “Installing and Configuring Infoprint Manager’s Output Management
(OMS) Support”, on page 13.
This topic provides instructions for installing, configuring, and using Infoprint
Manager when defined as an Output Management System (OMS) with SAP
R/3, Release 4 and above. The Infoprint Manager Output Management System
provides enhanced status reporting for SAP R/3 jobs. Your SAP systems can
reside on either Sun Solaris, HP-UX, AIX, or Windows, and you can have either
Infoprint Manager for AIX or Infoprint Manager for Windows (providing you
have applied PTF UR53740 or higher).

3. Part 3, “Infoprint Manager non-Output Management Support”, on page 67.
This topic provides instructions for installing, configuring, and printing to
Infoprint Manager when not using Output Management System (OMS)
support. Your SAP systems can reside on either Sun Solaris, HP-UX, AIX, or
Windows; your Infoprint server can reside on either AIX or Windows. and SAP
access method L is recommended. You can, however, use access method U
when your SAP applications reside on non-AIX systems, or access method C if
you are submitting jobs from a SAP Windows system to an Infoprint Windows
server. For more information on these methods, see Appendix B, “Alternate
access methods for submitting SAP jobs to Infoprint Manager”, on page 153.

4. Part 4, “Customizing your print environment”, on page 91
This topic provides additional configuration information that you can either
choose or not choose to implement. Please note that the fax options are
available only if you are using Infoprint Manager for AIX, while the Infoprint
Manager SAP transform options apply whether you are using Infoprint
Manager for AIX or Infoprint Manager for Windows.
Infoprint Manager provides two distinct methods for providing fax support to
SAP users: either the SAPcomm interface or the SAPconnect interface, as
described in Chapter 15, “Fax support in SAP R/3”, on page 93. The SAPcomm
interface applies to all SAP releases until SAP Web Server Release 6.10 and 6.20,
providing you the ability to send faxes (fax-out) and works with the OMS
support. The SAPconnect interface supports future releases of SAP R/3 and
provides you with the capability to both send (fax-out) and receive (fax-in)
faxes from your SAP user interface, using your Infoprint Manager AIX server,
but is independent of the OMS support″
You can use the collection of procedures for customizing the Infoprint Manager
SAP data stream transform (sap2afp) and related SAP R/3 print options that
are described in both Chapter 16, “Print support that applies to both Infoprint
AIX and Infoprint Manager Windows servers”, on page 123 and Chapter 17,
“Using bar codes with SAP R/3”, on page 145. These procedures apply for both
Infoprint Manager AIX servers and Infoprint Manager Windows servers.
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SAP R/3 GUI keyboard short cuts
Table 2 provides a list of keyboard short cuts that can be used while performing
some of the procedures described in this book. Because this is an Infoprint
Manager manual, these short cuts are not a complete list of all options available on
the SAP R/3 GUI for all releases. The SAP R/3 GUI window where applicable
column lists particular windows in the SAP R/3 GUI where these short cuts work,
but does not imply that the short cut is exclusive for a particular panel or task. In
addition, the SAP R/3 GUI may change keyboard short cuts from release to
release. IBM recommends that you consult the SAP R/3 online documentation that
comes with the product to verify keyboard short cuts for your particular SAP R/3
release.

Table 2. SAP R/3 keyboard short cuts

Short Cut Key or
Combination

Task SAP R/3 GUI window(s)
where applicable

F2 Choose (checkmark with a
clock) icon

Spool Administration
windows

F2 Change (pencil) icon SAPconnect: Administration
(view) windows

F5 Events icon Status Description window

F6 Extended Admin.: Spool Administration
windows

F7 View a Node SAPconnect: Administration
(view) windows

F8 Change (red pencil) icon Spool Administration
windows

F8 Query icon Status Description pop-up
window (derived from Spool
Output Requests for Spool
Request XXXXXX)

F8 Test RFC connection RFC Destination dest_name
window

F8 View jobs SAPconnect: Administration
(view) windows

F11 Save RFC Destination dest_name
window

Ctrl + S Save (open folder) icon SAP R/3 GUI

Ctrl + F1 Extended config. (photo film
with two cards
superimposed on top) icon

Spool Administration
windows

Ctrl + F5 Create (piece of paper) icon SAPconnect: Administration
(view) windows

Ctrl + F7 Start the send process to test
sending faxes out

SAPconnect: Administration
view) windows

Ctrl + F10 SAPconnect Test routes SAPconnect: Administration
view) windows

shift + F2 Trash can icon Spool Output Requests for
Spool Request XXXXXX

shift + F5 Transport (truck) icon Spool Admin.: Real Output
Management System

January 27, 2003

Chapter 2. About this publication 9



Table 2. SAP R/3 keyboard short cuts (continued)

shift + F6 Transport all (truck) icon Spool Admin.: Real Output
Management System

shift + F6 Spool Requests icon Spool Administration: List
of Output Deviceswindow

The Infoprint publication library
For the most current information, please go to the IBM Printing Systems website at
http://www.ibm.com/printers.

Infoprint Manager for AIX publication library
Infoprint Manager for AIX provides publications in PDF format on a CD-ROM
supplied with the product. You can download PDF versions of these publications
or order printed copies of these publications from IBM at the following website:

http://www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/pbi.cgi?CTY=US

Notes:

1. There is a fee for the printed manuals.
2. You can use the form number specified for a publication to download a PDF

version or order a printed version.

Here is the list of publications for Infoprint Manager for AIX:
v IBM Infoprint Manager for AIX: Introduction and Planning Guide, G544-5833. This

publication gives an overview of Infoprint Manager for AIX, introduces its
concepts, and helps you prepare to use it. It addresses migration from previous
versions of the product. Finally, this publication explains the differences between
the AIX and Windows versions of Infoprint.

v IBM Infoprint Manager for AIX: Getting Started, G544-5817. This publication helps
you install and configure IBM Infoprint Manager for AIX. It focuses primarily on
server and client system software configuration.

v Guidelines for Installing Infoprint Manager for AIX 4.1 in an HACMP Configuration,
G544-5818. This publication helps you install and configure HACMP with IBM
Infoprint Manager for AIX. It also tells you how to use HACMP with IBM
Infoprint Manager for AIX.

v IBM Infoprint Manager for AIX: Procedures, G544-5815. This publication describes
the primary tasks necessary for setting up an Infoprint environment, submitting
print jobs, scheduling jobs, and managing the print environment. This
publication contains all the IBM Infoprint Manager for AIX procedures that are
available as topics on the web in book format, including an index and table of
contents for ease of retrievability.

v IBM Infoprint Manager: Reference, S544-5475. For print administrators, operators,
and application programmers with the need to perform command-line functions,
this publication describes the commands, utilities, transforms, attributes, and
attribute values associated with Infoprint.

v PSF Direct Network Configuration Guide for System/370, S544-5486. For system
administrators or network specialists responsible for configuring a system for
Print Services Facility (PSF) Direct. PSF Direct is a function of IBM Infoprint
Manager for AIX that allows a PSF program (PSF/390, PSF/400, PSF/MVS,
PSF/VM, or PSF/VSE) to print remotely, using the SNA LU 6.2 protocol, on
printers supported by Infoprint. The PSF program sends the print data stream
directly to the Infoprint printer.
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v IBM PSF for AIX: AFP Upload Configuration Guide Using SNA Server/6000,
S544-5422. For system administrators, this publication describes how to
configure AFP Upload on both AIX (client) and MVS (server) to send files to the
JES spool on the MVS server, using a SNA LU 6.2 protocol.

v IBM PSF for AIX: AFP Upload Configuration Guide Using TCP/IP, S544-5423. For
system administrators, this publication describes how to configure AFP Upload
on both AIX (client) and MVS (server) to send files to the JES spool on the MVS
server, using a TCP/IP protocol.

For information on the use of SAP R/3 with Infoprint Manager for AIX, visit the
Product Library page for Infoprint Manager for AIX at:
http://www.printers.ibm.com/R5PSC.NSF/Web/ipmrefinfo41.

Infoprint Manager for Windows publication library
Infoprint Manager for Windows provides publications in PDF format on a
CD-ROM supplied with the product. You can download PDF versions of these
publications or order printed copies of these publications from IBM at the
following website:

http://www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/pbi.cgi?CTY=US

Notes:

1. There is a fee for the printed manuals.
2. You can use the form number specified for a publication to download a PDF

version or order a printed version.

Here is the list of publications for Infoprint Manager for Windows:
v IBM Infoprint Manager for Windows: Introduction and Planning Guide, G544-5716.

This publication gives an overview of Infoprint Manager for Windows,
introduces its concepts, and helps you prepare to use it. It describes features of
this product and compares its functions to those of IBM Print Services Facility
for OS/2 (PSF for OS/2). It addresses migration from PSF for OS/2 at a high
level. Finally, this publication explains the differences between the AIX and
Windows versions of Infoprint.

v IBM Infoprint Manager for Windows: Getting Started, G544-5717. This publication
helps you install and configure Infoprint Manager for Windows. It focuses
primarily on server and client system software configuration, but it also includes
information for the IBM 4159 Model 001 S/390 Parallel Channel Emulator Card.

v IBM Infoprint Manager for Windows: Procedures, G544-5814. This publication
contains all the Infoprint Manager for Windows procedures that are available as
topics on the web in book format, including an index and table of contents for
ease of retrievability.

v IBM Infoprint Manager: Reference, S544-5475. For print administrators, operators,
and application programmers with the need to perform command-line functions,
this publication describes the commands, utilities, transforms, attributes, and
attribute values associated with Infoprint.

For information on the use of either PSF Direct or SAP R/3 with Infoprint
Manager for Windows, visit the Product Library page for Infoprint Manager for
Windows at http://www.printers.ibm.com/R5PSC.NSF/Web/ipmntref21.
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Chapter 3. Infoprint Manager’s OMS support

SAP R/3 Release 4 and above provides support to closely integrate an external
Output Management System (OMS) with a SAP system. Both Infoprint Manager
for AIX and Infoprint Manager for Windows (with PTF UR53740 or higher) are
SAP OMSs that provide synchronous functions for submitting jobs, canceling jobs,
querying jobs, and querying devices, as well as asynchronous event information.
The Infoprint Manager SAP Callback daemon (on AIX) or process (on Windows)
collects and delivers these events to the R/3 system.

Notes:

1. This support is not currently available on an SAP R/3 Release 3 system. If you
are either using an SAP R/3 Release 3 system or do not want to use the OMS
support, see Part 3, “Infoprint Manager non-Output Management Support”, on
page 67.

2. Support for SAP R/3 Release 3.1h is still available. For more information,
contact your IBM Printing Systems representative.

An overview of SAP R/3 and OMS
The Infoprint Manager SAP OMS support consists of a command-line interface and
either a SAP callback daemon (on AIX) or a SAP callback process (on Windows)
that logs onto a SAP system and delivers Infoprint Manager notifications back to
SAP R/3 by making RFCs (remote function calls). As print, cancel job, query job,
and device query requests are made by SAP users, the SAP Spool Work Process
(SWP) invokes the Infoprint Manager commands. As the job progresses through
the Infoprint Manager system, notifications are sent back to SAP through the
Infoprint Manager SAP Callback daemon (sapcbd) or the SAP Callback process
(sapcbd.exe). Only one SAP Callback daemon or process needs to be started for
each SAP system, regardless of how many application servers make up that
system. The SAP Callback daemon or process runs on the same server where
Infoprint Manager is running.

In Infoprint Manager for AIX 4.1 and Infoprint Manager for Windows 2.1, the
Infoprint Manager SAP Print Feature contains:
v Command-line interface
v SAP Callback daemon (sapcbd) on AIX and the SAP Callback process

(sapcbd.exe) on Windows
v SAPconnect daemon (sapconnectd), which is available on AIX only
v SAP (sap2afp) transform

The Infoprint Manager SAP Clients contain the command-line interface.

To allow either the sapcbd daemon or the sapcbd.exe process to deliver Infoprint
Manager notifications to a SAP system, you must install the SAP Print Feature on
at least one system where the Infoprint Manager servers are running. To allow
SAPGOF device type output (both OTF and ABAP data streams) to be transformed
and processed by Infoprint Manager, you must install the SAP Print Feature on
every system where Infoprint Manager actual destinations are going to transform
SAP data.
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To install the SAP Print feature on an Infoprint server, see Chapter 4, “Installing
the SAP print feature on the Infoprint server”, on page 17.

To allow SAP to issue the Infoprint Manager commands, you must install a
Infoprint Manager SAP Client on every SAP server where an SAP application
server will issue the commands. This includes every application server with an
SWP managing R/3 devices that have been configured to use the Infoprint
Manager OMS. If you have configured your SAP R/3 system to use alternate
servers, you must repeat these installation tasks on the alternate servers as well.

To install and configure Infoprint Manager as a SAP R/3 OMS when SAP:
v runs on other HP-UX or Sun Solaris servers, follow the procedures described in

Chapter 5, “Installing the Infoprint Manager OMS support when SAP runs on
HP-UX or Sun Solaris”, on page 21.

v runs on an AIX operating system, follow the procedures described in Chapter 6,
“Installing the Infoprint Manager OMS support when SAP runs on AIX”, on
page 25.

v runs on a Windows operating system, follow the procedures described in
Chapter 7, “Installing the Infoprint Manager OMS support when SAP runs on
Windows”, on page 27.

Notes:

1. The SAP Print Feature is available on both Infoprint Manager for AIX and
Infoprint Manager for Windows as a separately-priced feature that can be
installed from the Infoprint Manager: SAP Print Feature, LCD4-1921.

2. The AIX and Windows SAP clients are available to install from the IBM
Infoprint Manager: Common Clients, LCD4-1917.
The SAP clients for HP-UX and SUN Solaris systems are available on the SAP
Feature and are specific to either Infoprint Manager for AIX servers or Infoprint
Manager for Windows servers.

Note: If you are using an Infoprint Windows server, ensure that you FTP the
files to the HP-UX or SUN Solaris system before editing the files as
described in “Configuring the SAP System Server(s)” on page 23. If you
edit the files on a Windows system, the format will not be correct for
either the HP-UX or the SUN Solaris system.

3. These procedures presume that you have already installed and configured
Infoprint Manager on either a separate AIX or Windows server.

4. An SAP OMS interface restriction requires that your Infoprint server (pdserver)
name be no longer than nine characters.
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Chapter 4. Installing the SAP print feature on the Infoprint
server

To run either an Infoprint Manager for AIX SAP Callback deamon or an Infoprint
Manager for Windows SAP Callback processs, you must install the SAP Print
Feature on at least one of your Infoprint servers, if you have not already done so.

If you are printing either Output Text Format (OTF) or Advanced Business
Application Programming (ABAP) data, ensure that you have installed the sap2afp
transform and the fonts necessary for printing. To install the transform, you must
install the SAP Print Feature on each Infoprint Manager AIX server or Infoprint
Manager Windows server with actual destinations that will be transforming data.

Note: At a minimum, on every AIX system on which you will be running the SAP
(sap2afp) transform (on your Infoprint servers), you must have the following
fileset installed:
bos.loc.adt.iconv (Language Converter Development Toolkit)

To install the Infoprint Manager for AIX SAP Print feature on your AIX server, see
″Starting the Infoprint Installer for Version 4.1″ in the Infoprint Manager for AIX:
Getting Started manual.

To install the SAP Print Feature on your Infoprint Manager Windows server, follow
the directions under the ″Installing Infoprint Manager server software″ topic in the
Infoprint Manager for Windows: Getting Started manual. The install program will
guide you through installing Infoprint Manager: SAP Print Feature, LCD4-1921.

To install the necessary fonts and configure the SAP transform on both the
Infoprint Manager AIX server and the Infoprint Manager Windows server, see the
rest of this chapter.

Installing Infoprint fonts for printing with the SAP transform on an
Infoprint Manager AIX server

To print output from the sap2afp transform, you must install the Gothic fonts that
are specified in the fonts.tab configuration file in the /usr/lpp/psf/bin directory, as
well as the required code pages. You can obtain these font resources from the
product 5648-B45: IBM AFP Font Collection for AIX, OS/400 and OS/2
(LK2T-9269). For more information about purchasing this product, see either your
IBM sales representative or access the AFP Font Collection homepage
(http://www.printers.ibm.com/R5PSC.NSF/Web/AFPFontHome) on the World
Wide Web.

Note: If you are printing double-byte fonts, you may require the following AFP
Font Collection CD-ROMs:
v Japanese Fonts for AIX, Windows NT, and Windows 2000 (LK2T-9276)
v Korean Fonts for AIX, Windows NT, and Windows 2000 (LK2T-9278)

To load the fonts that are required to transform OTF or ABAP data from SAP R/3
on an Infoprint Manager system, use the following procedure:
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1. Load the CD-ROM for the AFP Font Collection into the CD-ROM drive on
your AIX server.

2. Create a mount point from which to add fonts from this CD-ROM by typing
smitty cdrfs from the AIX command line and taking the following path:
CDROM File Systems --> Add a CDROM File System.

3. Select F4 to set the DEVICE name field to the system-generated name
(usually cd0).

4. For the MOUNT POINT field, specify /cdrom.
5. Press the F10 key to exit SMIT.
6. From the AIX command line, mount the CD-ROM to your RS/6000 by

specifying the following two commands in sequence:
a. mount /cdrom

b. cd /cdrom

7. From the AIX command line, specify
smitty install_latest

8. For the INPUT device /directory for software field, specify
/cdrom/aix

9. To ensure that you install the correct fonts without over writing any existing
resources on your system, specify no for the COMMIT software updates?
field and yes for the SAVE replaced files? field.

10. Specify the F4 key to list all font options.
11. Use the F7 key to select the following four options:

a. afpfonts.bookmstr

b. afpfonts.compats

c. afpfonts.codepage

d. afpfonts.ocr

12. To install the fonts, press Enter.
These fonts should take approximately 43 MB on your AIX server.

13. Verify that the fonts cited in your fonts.tab configuration file have been
installed.

14. Infoprint Manager installs these fonts in the /usr/lpp/afpfonts directory.
15. To remove the IBM AFP Font Collection CD-ROM, specify the following two

commands in sequence:
a. cd /cdrom

b. umount /cdrom

16. Then you can remove the CD-ROM from your CD-ROM drive.

Installing Infoprint fonts for printing with the SAP transform on an
Infoprint Manager Windows server

To print output from the sap2afp transform, you must install the Gothic fonts that
are specified in the fonts.tab configuration file in the install_path\sap2afp directory,
as well as the required code pages. You can obtain these resources from the
product 5648–B45: IBM AFP Font Collection for AIX, OS/400 and OS/2
(LK2T-9269). For more information about purchasing this product, see either your
IBM sales representative or access the AFP Font Collection homepage
(http://www.printers.ibm.com/R5PSC.NSF/Web/AFPFontHome) on the World
Wide Web.
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Note: If you are printing double-byte fonts, you may require the following AFP
Font Collection CD-ROMs:
v Japanese Fonts for AIX, Windows NT, and Windows 2000 (LK2T-9276)
v Korean Fonts for AIX, Windows NT, and Windows 2000 (LK2T-9278)

To load the fonts that are required to transform OTF or ABAP data from SAP R/3
on an Infoprint Manager system, use the following procedure:
1. Insert the CD-ROM for the AFP Font Collection into the CD-ROM drive on

your Infoprint Manager Windows server.
2. If autorun does not start the install, double-click on the My Computer icon on

your desktop.
3. From the My Computer window, double-click on your CD-ROM drive and

then double-click on the NT folder icon.
4. From the NT folder window, double-click on the setup.exe executable to begin

the install.
5. Select the drive where you have installed Infoprint Manager to install these

fonts. For example, if Infoprint is installed on the D drive, the fonts should be
installed in the D:\afpfonts path.

6. While Infoprint recommends that you use the full installation option, if you
select a customized install, you should be certain to choose the following four
options:
v BookMaster Fonts

v Compatibility Fonts

v OCR Fonts

v Symbols Fonts

7. To install the fonts, press Next.
When the fonts finish loading, you will see a Font Collection pop-up dialog
with the message:
Installation of Font Collection 2.1.0.1 is complete.

8. Verify that the fonts cited in your fonts.tab configuration file (which is
installed in the install_path\sap2afp directory).
You can use a Notepad editor to both view and change this file.

9. Infoprint Manager installs these fonts in the install_path\afpfonts directory.
10. Remove the CD-ROM from your CD-ROM drive.

Configuring the SAP R/3 transform
Depending upon the types of data you are printing, you may need to configure
some of the files that are provided with the SAP transform. For example:
v If you want to use form definitions that are mapped to SAP Formats (Paper

Types), you must configure the pagedef.tab file as described in “Changing
document print orientation” on page 126.

v If you have created a new font in a SAP R/3 document, you must configure the
fonts.tab file as described in “Setting up your SAP R/3 system to support new
OTF user fonts” on page 140.

v If you want to expand or shorten the width of a barcode for printing, you must
configure the barcode.tab file as described in “Bar codes and printing from SAP
R/3 through Infoprint Manager” on page 147.

The SAP transform includes two types of files:
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v An executable named sap2afp, which converts Output Text Format (OTF) data
into MO:DCA-P output data and Advanced Business Application Programming
(ABAP) list format data into line data. On an Infoprint Manager AIX server, this
file is installed in the /usr/lpp/psf/bin directory. On an Infoprint Manager
Windows server, this file is installed in the install_path\bin path.

v Table 3 shows the configuration files that are installed in either the
/usr/lpp/psf/sap2afp directory on an Infoprint Manager AIX server or the
install_path\sap2afp path on an Infoprint Manager Windows server.

Table 3. SAP (sap2afp) transform configuration files for AIX

Configuration File Purpose Use

barcode.tab Provides list of valid SAP bar
codes.

OTF data only

xxxxyyyy.tab Maps ASCII code pages to
EBCDIC code pages.

OTF data only

fonts.tab Provides a list of raster fonts
with the appropriate
character set and code page.

OTF data only

6400fonts.tab Provides a list of raster fonts
that apply exclusively to the
IBM 6400 printer, with the
appropriate character set and
code page.

OTF data only

image.tab Defines the dither matrix for
half-tone color print jobs.

OTF data only

pagedef.tab Defines the form definition
(SAP PAPER TYPE) used, as
well as the page definition
and fonts for jobs that go
through ACIF.

ABAP/OTF

defcp.tab Converts ASCII into EBCDIC
characters.

ABAP data only
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Chapter 5. Installing the Infoprint Manager OMS support when
SAP runs on HP-UX or Sun Solaris

SAP R/3 installations that run on HP-UX or Sun Solaris systems work with
Infoprint Manager when these installations are configured to invoke commands
remotely on the Infoprint server.

To use the OMS support of the SAP Print feature with a SAP R/3 system running
on a non-AIX UNIX system, you must install the SAP feature on the Infoprint
server and perform the following tasks:
1. “Configuring the Infoprint Manager Server”
2. “Configuring the SAP System Server(s)” on page 23

Configuring the Infoprint Manager Server
Follow the appropriate procedure depending on which version of Infoprint
Manager you are using:
v “Configuring the Infoprint Manager Windows server”
v “Configuring the Infoprint Manager AIX server” on page 22

Configuring the Infoprint Manager Windows server

Note: The rshd and rexecd services are prerequisites for HP-UX and Sun Solaris
SAP client support.

Use the following procedure to configure the Windows server that has already
installed Infoprint Manager Version 2 Release 1 with the SAP Print Feature:
1. Install both an rshd and rexecd service on your Infoprint Manager Windows

server .
While Windows NT and Windows 2000 systems natively support both rcp and
rexec commands as a client, you just add these services to ensure that these
command requests are honored by the Infoprint Manager Windows server. One
company which sells software that provides rshd and rexecd services for
Windows NT and Windows 2000 is Denicomp Systems
(http://www.denicomp.com).

Note: During the installation of these services, ensure that remote users are
defined users on the Infoprint Manager for Windows 2.1 system so that
it is possible to write to this server from the Windows SAP client system.

2. From the Start menu, access the Programs → Administrative Tools → User
Manager path.

3. Create a new user named sapuser.

Note: This user does not have to be part of any special groups.
4. Authorize the sapuser userid to issue remote commands by adding the

following entry to the .rhosts or equivalent file: +sapuser.
5. Authorize all remote servers running the SAP R/3 applications to specify

remote commands on the Infoprint Manager Windows server by specifying:
fully_qualified_server_name +
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where fully_qualified_server_name is either the IP address (in dotted decimal
format) or the host name of the server.

Notes:

a. If you use a host name, TCP/IP must be able to resolve that name through
either the security file or through a Domain Name Server (DNS).

b. If a DNS is not being used, but the host name is specified in the hosts file,
specify the fully-qualified name in the .rhosts or equivalent file.

c. If a DNS is not being used, and the host name is not specified in the hosts
file, you must specify an IP address in the .rhosts or equivalent file (for
example, 172.16.8.10 +).

For added accountability among SAP systems and print jobs, you can create
separate NT users for each SAP system or SAP R/3 application server. Repeat
steps two through five below to create new userids that you can map to each SAP
application server from which you plan to use Infoprint Manager to print.

Configuring the Infoprint Manager AIX server
Use the following procedure to configure the AIX server that has already installed
Infoprint Manager Version 4 Release 1 with the SAP Print Feature:
1. Add a user called sapuser.

Note that this user does not have to be part of any special groups.
2. Authorize the sapuser userid to issue remote commands by adding the

following entry to the /etc/hosts.equiv file:
+ sapuser

3. Authorize all remote servers running the SAP R/3 application to specify remote
commands on the Infoprint Manager AIX server as sapuser by performing the
following procedure:
a. Add an .rhosts file with permissions of 600 to the /home/sapuser directory.
b. Edit the .rhosts file and add a line for each non-AIX server running a SAP

R/3 application with a plus (+) sign appended to it.
If a Domain Name Server is being used, specify the fully-qualified name to
the .rhosts file as shown below:
/home/sapuser/.rhosts: sol.penn.boulder.ibm.com +

If a Domain Name Server is not being used, you must also add the host
name and its IP address to the /etc/hosts file as show below:
/home/sapuser/.rhosts: sol.penn.boulder.ibm.com +

/etc/hosts: 172.16.8.10 sol.penn.boulder.ibm.com +

For added accountability among SAP systems and print jobs, you can create
separate AIX users for each SAP system or SAP R/3 application server. Follow the
three steps specified in this topic to create additional users (like sapuser) that are
mapped to each application server from which you will be using Infoprint
Manager to print.

For more information about using the rsh and rcp commands to connect to the
Infoprint Manager AIX server and send files between servers, refer to your AIX
Operating System documentation.
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Configuring the SAP System Server(s)
To allow SAP on either HP-UX or Sun Solaris to issue the Infoprint Manager
commands, you must install the Infoprint Manager SAP Client on every SAP
server where an SAP application server will issue the commands. This includes
every application server with a spool work process (SWP) managing R/3 devices
that have been configured to use the Infoprint Manager OMS. If you have
configured your SAP R/3 system to use alternate servers, you must repeat these
installation tasks on the alternate servers as well.

Use the following procedure to configure remote server(s) (HP-UX or Sun) running
the SAP R/3 application so you can print with Infoprint Manager:
1. Obtain access to each HP-UX or Sun Solaris server running SAP R/3 and log

on.
2. Verify that you can ping the Infoprint Manager server by hostname:

ping -c 3 hostname

where hostname is the unqualified name for the Infoprint Manager server, such
as nwser.
If the response shows that a good communication path exists, you will see the
following:
----tcpip_addr PING Statistics----

packets transmitted, 3 packets received, 0% packet loss

round-trip min/avg/max = 7/7/7 ms

3. If you cannot ping the Infoprint Manager server by hostname, edit the
/etc/hosts file and add the hostname and IP address of the Infoprint Manager
server:
/etc/hosts: 9.99.11.109 nwser

4. Create a small directory named /usr/lpp/pd/bin:
mkdir /usr/lpp/pd/bin

5. Use the file transfer protocol (FTP) of your choice to copy either the
/usr/lpp/pd/bin/ipm.omsdesc file from the Infoprint Manager AIX server or
the install_path\bin\ipm.omsdesc from the Infoprint Manager Windows
server to at least one of the SAP R/3 servers running the SAP R/3
application.
This file contains the Infoprint Manager Output Management System (OMS)
definition that is loaded into the SAP R/3 System. Ensure that the file is
readable by the sysadmin (where sys is the three-character SAP system name)
on the SAP R/3 application system.

6. Use the FTP of your choice to copy the following four files from the Infoprint
Manager server to an SAP R/3 application server in your configuration. If you
are using an Infoprint Manager AIX server, these files reside in the
/usr/lpp/pd/bin directory. If you are using an Infoprint Manager for Windows
server, these files reside in the install_path\bin folder:
a. ipm_submit.sys

b. ipm_job_cancel.sys

c. ipm_job_query.sys

d. ipm_dev_query.sys

For the secondary qualifier (sys), specify the name of the system where your
SAP applications are running, either sun for Sun Solaris or hp for HP-UX.

7. Ensure that each file copied in step 6 is executable.
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8. On the SAP application server in your installation, edit the four files so they
specify the name of the user (sapuser) and hostname where Infoprint
Manager is running.

9. Copy the four edited SAP command files to any other SAP application servers
in your installation that use the Infoprint Manager server.

10. To complete the configuration, complete the procedures in Chapter 8,
“Configuring and using the OMS support”, on page 31.
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Chapter 6. Installing the Infoprint Manager OMS support when
SAP runs on AIX

To allow SAP on AIX to issue the Infoprint Manager commands, you must install
the Infoprint Manager SAP Client on every SAP server where an SAP application
server will issue the commands. This includes every application server with an
SWP managing R/3 devices that have been configured to use the Infoprint
Manager OMS. If you have configured your SAP R/3 system to use alternate
servers, you must repeat these installation tasks on the alternate servers as well.

The SAP Client package installs the necessary filesets on the SAP application
server on AIX. The SAP Client package requires the following prerequisites:
1. bos.rte 4.2.1.0

2. bos.rte.printers 4.2.1.8

To install the SAP Client for AIX on your SAP application servers, use the
following procedure:
1. Log into the AIX system as root.
2. Insert the Infoprint Manager Common Client, LCD4-1917, into the CD-ROM

reader.
3. Open a terminal window.

If you are using the Common Desktop Environment (CDE), you may open a
terminal window by clicking on the terminal icon contained in the front panel.
(The front panel is the task bar that appears at the bottom of the screen.) By
default, the terminal icon is contained in a pop-up menu above the text editor
icon that appears on the front panel.

4. The first time you run the Installer, follow this procedure:
a. Type the following on the command line:

smit cdrfs

b. Select Add a CDROM File System from the list of choices presented.
c. Click the List button and select your CD-ROM device name (cd0, for

example).
d. Type the following in the MOUNT POINT field:

/cdrom

e. Click OK. The running person will raise his arms to indicate success. If he
instead falls down and you see crfs: 0506-909 /cdrom file system
already exists, do not interpret this as a failure. (The existing /cdrom file
system should be usable.)

f. Press the F12 key to exit SMIT.
5. Type the following on the command line:

mount /cdrom

6. The SAP Client package (ipr.sapclient) is installed at the command line by
specifying setup —x.
During the course of the install, you are prompted to specify values for both
PDHOST and PD_SOCKET.
These environment variables become effective the next time you reboot the
system. If you want to start using the OMS support without rebooting, edit the
following four files that are found in the /usr/lpp/pd/bin directory:
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v ipm_submit

v ipm_job_query

v ipm_job_cancel

v ipm_dev_query

Locate and uncomment the lines:
#export PDHOST
#export PD_SOCKET

Specify the same values that you specified during the install.

For another way to specify or change the Infoprint Manager host and socket
information to point to another Infoprint Manager system or server, see “Switching
Infoprint Manager servers” on page 60. You can also provide a failover connection
to another Infoprint Manager server in the same Infoprint Manager system
(see“Failing over to other servers in the same Infoprint Manager system” on
page 62 ) and how to send jobs to more than one Infoprint Manager system at the
same time (see “Supporting multiple Infoprint Manager systems” on page 55).

Note: Note that the SAP Client package cannot be installed if other ipr* filesets
reside on a SAP application server.

To complete the configuration, complete the procedures described in Chapter 8,
“Configuring and using the OMS support”, on page 31.
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Chapter 7. Installing the Infoprint Manager OMS support when
SAP runs on Windows

To allow SAP on Windows to issue the Infoprint Manager commands, you must
install the Infoprint Manager SAP Client on every SAP server where an SAP
application server will issue the commands. This includes every application server
with an SWP managing R/3 devices that have been configured to use the Infoprint
Manager OMS. If you have configured your SAP R/3 system to use alternate
servers, you must repeat these installation tasks on the alternate servers as well.

To install the Infoprint Manager SAP Client for Windows on your Windows SAP
system, use the following procedure:
1. Log in as the Administrator user.
2. Insert the IBM Infoprint Manager: Common Clients, LCD4-1917, into your

CD-ROM drive.
3. From the IBM Infoprint Manager: Common Clients window, click on Install

Infoprint Manager Products.
4. Click on Infoprint Manager SAP Clients.
5. Select a location for installing the clients (the default is install_path \Infoprint

Manager SAP Clients\).
6. From the IPM Server Settings pop-up dialog (see Figure 3 on page 28), specify

either the fully-qualified hostname or the IP address of the Infoprint Manager
server to which you will be sending jobs. The IPM Hostname field defaults to
showing the loop back address and must be changed.
The IPM Server Port Number field defaults to 6874, which you do not need to
change.
For another way to specify or change the Infoprint Manager host and socket
information to point to another Infoprint Manager system or server, see
“Switching Infoprint Manager servers” on page 60. You can also provide a
failover connection to another Infoprint Manager server in the same Infoprint
Manager system (see“Failing over to other servers in the same Infoprint
Manager system” on page 62 ) and how to send jobs to more than one Infoprint
Manager system at the same time (see “Supporting multiple Infoprint Manager
systems” on page 55).

Note: Do not check the IPM Debug Mode checkbox unless instructed to do so
by IBM support.

Once you have set the appropriate values, click OK to close this dialog.
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7. When the SAP client has been installed, click the Finish button shown in
Figure 4.

Figure 3. IPM Server Settings dialog

Figure 4. InstallShield Wizard Complete screen after installing SAP Clients on Windows
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8. To exit the install process, click the Back button, and then the Exit button on
the next screen.

9. To complete the OMS configuration, complete the tasks in Chapter 8,
“Configuring and using the OMS support”, on page 31.
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Chapter 8. Configuring and using the OMS support

The following topics describe how you can configure, customize, and use your
SAP R/3 Infoprint Manager environment to report enhanced job status that meet
the particular criteria of your installation.

The first set of topics (“Required configuration tasks” ) must be performed on both
the SAP application servers and the Infoprint Manager servers in order for
enhanced status reporting to work correctly. The second set of topics (“Using OMS
support tasks” on page 46 ) describes how to use the OMS to get more information
about your print jobs, including obtaining job status, device status, and the
capability to cancel jobs. The third set of topics (“Optional OMS configuration
tasks” on page 51 ) cover a variety of useful administration functions, including:
v “Activating end-user pop-ups” on page 51
v “Selecting event report levels” on page 53
v “Organizing OMS output devices into LOMSs” on page 54
v “Moving OMS definitions among SAP systems” on page 59
v “Switching Infoprint Manager servers” on page 60
v “Failing over to other servers in the same Infoprint Manager system” on page 62
v Shutting down the SAP Callback process or daemon on page 64

Use these topics in conjunction with relevant SAP R/3 online product
documentation.

Required configuration tasks
This section consists of the required configuration tasks that you must perform in
order to receive OMS callback reports.

When you finish defining the Infoprint Manager OMS to your SAP R/3 system,
you can define devices so you can print or fax from SAP R/3 with Infoprint
Manager as described in “Defining devices for Infoprint Manager that use the
Infoprint OMS” on page 44.

Defining the Infoprint Manager OMS to SAP R/3 on the SAP
system server

Infoprint Manager provides a configuration file (ipm.omsdesc) to assist in defining
Infoprint Manager as an OMS on your R/3 system. The following two procedures
are performed on your SAP application server to:
v Define Infoprint Manager as a Real Output Management System (ROMS) for

your SAP R/3 installation.
v Define your first Logical Output Management System (LOMS) so you can define

access method E devices in SAP R/3.

Defining a Real Output Management system
Use the following procedure to define a Real Output Management System for SAP
R/3:
1. Log onto your SAP R/3 Release 4 or above system.
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2. Import the Infoprint Manager OMS configuration file by entering transaction
SA38.

3. From the ABAP: Execute Program window, specify RSPOXOMS in the Program
field and click on the Execute (checkmark with a clock) icon.

4. From the Spool: Saving and Loading of Definitions window, perform one of
the following tasks:
v If configuring for SAP on UNIX, make the following changes to the Spool:

Saving and Loading of Definitions window:
– Specify /usr/lpp/pd/bin/ipm.omsdesc in the Export/Import file name field
– Set the File system info pane to Server

– Set the Operation pane to Import

– Check both the Execute import and Generate log options in the Options
pane

Once you have set these options, click on the Execute (checkmark with a
clock) icon, as shown in Figure 5 on page 33.
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v If configuring for SAP on Windows, make the following changes to the
Spool: Saving and Loading of Definitions window:
– Ensure that the Operation pane is set to Import

– Specify C:\Program Files\IBM\Infoprint Manager SAP
Clients\ipm.omsdesc in the Export/Import file name field

– Ensure that the File system info pane is set to Frontend computer

– Check both the Execute import and Generate log options in the Options
pane

Once you have set these options, click on the Execute (checkmark with a
clock) icon, as shown in Figure 6 on page 34.

Figure 5. Real Output Management System window for Infoprint Manager AIX server
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5. Running the report displays a list of the ROMS and LOMS that have been
imported into the system.

Defining a Logical Output Management system
Use the following procedure to define a Logical Output Management System for
SAP R/3:
1. From the SAP R/3 graphical user interface, complete the Logical Output

Management System (LOMS) definitions by specifying the spad transaction.
2. From the Spool Administration: Initial Screen window, click on the Extended

admin push-button and select the Logical OMS push-button from the Output
management systems pane (as shown in Figure 7 on page 35) to obtain a list of
the Logical Output Management Systems (LOMS) available on your
installation.

Figure 6. Real Output Management System window for Infoprint Manager Windows server
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3. From the Spool Admin.: List of Logical Output Management Systems
window, select the IPM001 LOMS and click on the Choose (checkmark with a
clock) icon.

4. From the Spool Admin.: Logical Output Management (Display) window, click
the Change (red pencil) icon.

5. From the Spool Admin.: Logical Output Management (Change) window on
the SAP Configuration tab (see Figure 8 on page 36),
v Select a value from the pulldown list of all SAP application servers for both

the Tasking target field and the Callback target field in the format:
hostname_systemname_instanceID, such as sap12_MBS_00.
The Tasking target field, specifies where the commands are invoked, while
the Callback target field specifies where the asynchronous callbacks are
delivered.

v Click on the Extended config. (photo film with two cards superimposed on
top) icon (seventh from left on the second toolbar line in Figure 8 on page 36)
and specify a value for the Event report level field in the SAP configuration
pane (see Figure 10 on page 38).

Note: Once you click on the Extended config. icon, it disappears from the
view and the Event report level field is always displayed (see Figure 9
on page 37).

You must select one of the following values:
– Final messages

– Also problems

Figure 7. Spool Administration: Initial Screen – Output management systems view
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– Also warnings

– Also status changes

– Also information

– All information options

In earlier versions of the SAP GUI, the Event report level field consists of
numeric message levels. For the earlier SAP GUI, use the down arrow to
determine the message level you want (1 is the least and 5 is the most).

Figure 8. LOMS (Change) window: Setting Tasking Target and the Callback Target
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Figure 9. LOMS (Change) window with Event Report Level field
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6. To ensure that users on your SAP R/3 system receive pop-up windows for both
problem and completion notification messages about a job’s status, check the
Status dialog box field in the Jobs pane.

Note: Until SAP R/3 Release 4.5B, the pop-up message is always reported only
to users in the client where the OMS callback daemon has logged on.
You defined this client when you “Defining a SAP user for the OMS
callback daemon or process” on page 39. Beginning with SAP R/3
Release 4.5B, SAP delivers asynchronous pop-ups to users who are
logged onto any SAP client.

7. From the OMS Configuration tab (Figure 11 on page 39), you can specify how
often (Send period field) in seconds or how many (No. of events field)
notification events the Infoprint Manager callback daemon should collect before
delivery to the SAP R/3 system. In other words, the callback daemon will only
deliver events for jobs on printers associated with this LOMS if it has collected
x number or x seconds have passed since the last delivery.

Figure 10. LOMS (Change) window: Setting the Events Report Level
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8. Save this information by clicking on the Save (diskette) icon.
9. Now you can use the SAP GUI for “Defining a SAP user for the OMS callback

daemon or process”.

Defining a SAP user for the OMS callback daemon or process
Because the OMS callback daemon must logon to the SAP system and its external
management interface (XMI) to make RFC requests, you must define a user for it.
You will need this user information when “Starting the SAP callback daemon or
process” on page 40.

The user should be a CPIC (or System) type and requires XOMI permissions to
log into the CCMS system management XOM application programming interface.
These authorizations can be provided in the S_XMI_XOM_A profile.

Note: If you ever change or modify this SAP user, remember to make the changes
where the SAP callback daemon is running:
v If on Infoprint Manager for AIX, edit the rc.iprsap file in the /etc directory

Figure 11. Specify Notification Event Values
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v If on Infoprint Manager for Windows, use the Infoprint Manager
Management Console to left-click on SAP Callback Processes from the
Objects view. This step allows you to access the SAP Callback Processes
in the main view. From the main view, you can right-click and select
Open (from the pop-up menu shown in Figure 12 on page 42).

Collecting information necessary to start an SAP callback
daemon or process
The following tables display the variables needed to start a SAP Callback Daemon
or Process. All variables in the tables are examples and will differ from values that
you specify, unless otherwise noted. These variables are grouped into two
categories:
1. SAP R/3 instance where the Callback Daemon logs on

Table 4. SAP R/3 instance where the Callback Daemon or Process (sapcbd) logs on

Variable Explanation

MBS The three-character System Name

sap12 The Host Name

00 The Instance ID

Note: If you are starting multiple SAP Callback Daemons and SAP Callback
Processes to run on different SAP application servers, you must ensure
that there is a unique SAP R/3 instance (system name, host name, and
instance ID) for each SAP Callback userid as shown in Table 5.

If you don’t know what values you can specify for these variables, you can
refer to the dropdown list for the Callback target field from the Spool Admin.:
Change Logical Output Management System window (for an example, see
Figure 8 on page 36 and 5 on page 35 of “Defining a Logical Output
Management system” on page 34).

2. Callback Daemon or Process Userid information

You defined the information for Table 5 when you performed the step described
in “Defining a SAP user for the OMS callback daemon or process” on page 39.

Table 5. Callback Daemon or Process Userid Information

Variable Explanation

ibm The User value. This value and the two that
follow were originally defined when you
created a SAP userid for the OMS Callback
daemon.

030 The Client value

newname The Password value

En The Language value: in this example,
English
Note: If you are creating a SAP Callback
Process on Windows, this value is not
required.

Starting the SAP callback daemon or process
Each SAP R/3 system using the Infoprint Manager Callback support needs to have
one callback daemon running. If your Callback support runs on an Infoprint AIX
server, you must perform both of the following procedures:
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v “Starting the SAP callback daemon on AIX”
v “Configuring to start callback daemons on system reboot on AIX”

If your Callback support runs on an Infoprint Manager Windows server, you must
complete the “Starting the SAP callback process on Windows” on page 42
procedure.

Starting the SAP callback daemon on AIX
To start the SAP Callback daemon, you must edit and run the /etc/rc.iprsap file
from the AIX command line from your Infoprint Manager AIX server.
1. From the AIX command line, access the rc.iprsap file in the /etc directory. Edit

the file to copy and uncomment the following two lines of code for callback
daemons:
a. An echo statement that states that the Callback daemon has been started:

echo Starting sapcbd <System Name>

b. The startcbd command (see Callback Daemon User ID Information) at the
top of the file:
/usr/lpp/pd/bin/startcbd <System Name> <Host Name> <Instance ID> <User>
<Client> <Password> <Language>

Note: This file also contains two lines of code for starting the SAPconnect
daemon. For more information, see “Configuring the SAPconnect
daemon on Infoprint Manager” on page 105.

2. Specify the same values for the items in angle brackets (< >) that you collected
in “Collecting information necessary to start an SAP callback daemon or
process” on page 40.

3. Verify that you can ping the SAP server by hostname:
ping -c3 hostname

where hostname is the unqualified name for the SAP server, such as nwser.
If you cannot ping the SAP server by hostname, edit the /etc/hosts file and add
both the hostname and the IP address of the SAP server (for example,
9.99.11.109 nwser).

4. Once you have saved and exited the file, start the SAP Callback daemon from
the command line by specifying:
/etc/rc.iprsap

If the callback daemon has started correctly, you should see the following
response:
0 Successfully\started\SAPCBD

If you receive any other message, the daemon has not started correctly. To
resolve the problem, refer any messages displayed in either the message
column or by selecting the Server Log object from the left pane of the Infoprint
Manager Management Console to access the Server Log view. Correct the
problems cited, and try to start the Callback daemon again. If it still does not
start correctly, contact your Printing Systems technical support representative.

Configuring to start callback daemons on system reboot on AIX
The SAP Callback daemon needs to run all the time. A monitor ensures that it is
restarted if it ever stops after it is started. However, to ensure that both the
daemon and its monitor are restarted if the AIX system that it runs on is rebooted,
you need to perform one more step to add the rc.iprsap file to the /etc/inittab
directory.
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To ensure that the SAP Callback daemon(s) are restarted automatically whenever
the system they are running on is restarted, use the Infoprint SMIT interface on
your Infoprint Manager AIX server:

Infoprint Printing Systems → Infoprint Utilities → SAP Daemons

From the SAP Daemons panel, select the Start SAP daemons at reboot option.

If you prefer the command line, you can enter the the following at the AIX
command line instead:
mkitab "rciprsap:2:once:/etc/rc.iprsap.out 2>&1 # Autostart of Infoprint sapcbd"

Both the SMIT interface and this command ensure that the SAP daemons (sapcbd)
are restarted automatically whenever the systems they are running on are
restarted.

As you add more callback daemons to your Infoprint configuration, you do not
have to perform this step, but you do need to add a new entry in the /etc/rc.iprsap
file and type /etc/rc.iprsap on the command line. Your new callback daemons
will start and any SAP Callback daemons that are already running will report that
they are running.

Starting the SAP callback process on Windows
Each SAP R/3 system using the Infoprint Manager Callback support needs to have
one callback process running. To start the SAP Callback process on an Infoprint
Manager Windows server, you must access the SAP Callback Processes from the
Infoprint Manager Management Console shown in Figure 12.

The SAP Callback Processes are only visible if you have installed both the
optional Infoprint Manager: SAP Print Feature, LCD4–1921 and Infoprint
Manager for Windows PTF UR53740.

1. Verify that you can ping the SAP server by hostname:

Figure 12. Infoprint Manager Management Console Main Panel showing SAP Callback Process
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From a either a Command or a Command Prompt window, specify ping
hostname

where hostname is the unqualified name for the SAP server, such as nwser.
If you cannot ping the SAP server by hostname, edit the Hosts file in the
C:\WINNT\system32\drivers\etc folder and add both the hostname and the
IP address of the SAP server (for example, 9.99.11.109 nwser).

2. From the Start menu, click on the Programs → IBM Infoprint Manager →
Management Console path.

3. Right click the SAP Callback Processes object in the Objects view in the left
pane of this window and select New.

4. Specify the values that you gathered in “Collecting information necessary to
start an SAP callback daemon or process” on page 40, click OK, and wait.

5. If the Callback process has started correctly, the SAP Callback Process in the
main panel should display a state of RUNNING, as displayed in Figure 12 on
page 42.
If the state shows Failed To Start, the process has not started correctly. To
resolve the problem, if the message displayed does not provide enough
information to correct the problem, you can switch to the Server Log view for
additional messages.
If you receive the following message,
5010-760: There are no available port numbers

see “Expanding server ports for SAP Callback Processes”.

For all other messages, correct the problems cited, and try to start the Callback
process again. If it still does not start correctly, contact your Printing Systems
technical support representative.

Note: If you are running the callback process on Infoprint Manager for Windows,
you do not need to configure to start SAP Callback Processes on a system
reboot because at reboot the Infoprint Manager SAP service is always started
and the service will restart any SAP Callback process that was not manually
stopped.

Expanding server ports for SAP Callback Processes: Creating and managing SAP
Callback Processes on your Infoprint Manager for Windows server may require
that you increase the number of server communication ports available on your
system. The following procedure shows how to perform this task.

Use the following procedure to increase the number of server ports available on
your Infoprint Manager for Windows server.
1. From the Infoprint Manager Management Console, stop the Infoprint

Manager server by selecting File → Stop Server from the main menu.
2. Access the Edit → Service Configuration dialog and access the Communication

Ports pane
3. Increase the number of Server Interface Ports by increasing the range to

include twenty ports and save your results.
The server interface ports default values range from 6880 to 6889. To ensure
that you have enough server communication ports for all SAP Callback
Processes, you should increase the final number in the range to 6899.

4. Use the Infoprint Manager Management Console to start the Infoprint
Manager server by selecting File → Start Server from the main menu.
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Defining devices for Infoprint Manager that use the Infoprint
OMS

Use the following procedure to define devices to SAP R/3. For more information,
consult the ″Connecting a Printer to an External Output Management System″
topic in the SAP R/3 online documentation.
1. Ensure that you have a logical destination defined in Infoprint Manager that

sends jobs to your actual destination device.
2. From the SAP R/3 graphical user interface, specify the spad transaction.
3. From the Spool Administration: Initial Screen (Change) window (displayed

on Figure 7 on page 35),
v Click the Devices/servers tab
v Select the Output Devices button
v Click on the Create icon next to the trash can icon

4. From the Spool Administration: Create Output Device window, fill in the
following pieces of information for device attributes and access method.:

Field Explanation Example Value

Output Device Specify a long name for the
device.

Device Number 1

(Output Device) Short name Specify a short name.
Note: Optionally, you can
allow the system to generate
a short name.

DEV1

Device type Specifies the driver that
generates the output data
stream.

SAPGOF

Host printer Specify the Infoprint
Manager logical destination.

printer-ld

Access method to host spool Ensure you specify this
Access Method.

E

LOMS Specify the LOMS to which
this device should be
assigned. You specified this
value on the Spool Admin.:
Logical Output Management
System window under
Define the Infoprint Manager
OMS to SAP R/3.

IPM001

Spool server Choose an applicable spool
server from the entries list on
the field.

sap12_MBS_00
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Figure 13. Display for Defining Access Method E Output Device: Device Attribute tab
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5. Save this information by clicking on the Save (diskette) icon, then exit the
interface.

Once you have saved these changes, you have a device that will print to Infoprint
Manager using Access Method E.

Because this device is defined to send jobs to Infoprint Manager, you can “Viewing
enhanced job status, job events, and querying jobs” on page 47, “Displaying device
status” on page 48, and “Canceling jobs” on page 50.

Using OMS support tasks
This section consists the procedures that are available once you have configured
your SAP OMS to obtain job status about your print environment.

Figure 14. Display for Defining Access Method E Output Device: Access Method tab
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Viewing enhanced job status, job events, and querying jobs
The following procedure describes Output Management System (OMS) support for
obtaining information about a print job sent to Infoprint Manager. By using this
feature, you can see asynchronous events and synchronous queries about jobs
reported to your SAP R/3 system.

To view the status of an output request, use the following procedure from the SAP
R/3 graphical user interface:
1. From the Output Requests for Spool Request xxxxxx window (where xxxxxx

refers to the SAP Spool ID), double-click on the output request you want to
view in the Status column on the far right.

2. From the Status Description pop-up window (see Figure 15), you can see
current information about the job, including the last event received.

3. Click on the Events button on the Status Description window to get the
Events for Output Requests window. From the Events for Output Requests
pop-up window (see Figure 16 and Figure 17 on page 48), you can view all the
events concerning this job.
This Events for Output Requests pop-up window is displayed twice to show
(1) the right side of the window with the date, time, and current status of the
job (Figure 16), and (2) the left-side of the window with its message text
(Figure 17 on page 48).

Figure 15. SAP R/3 Status Description field

Figure 16. Events for Output Requests field, view 1
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4. From the Status Description pop-up window, you can also click on the Query
button and issue a query to return the current information for a job, including
its position in the queue. For example, Figure 18 displays the result of a ’Query’
for a job that has been successfully submitted for printing. Notice that the first
line shows the job’s position in the print queue.

When you close this query Status Description window, the system updates the
latest status for that job in other displays.

Displaying device status
To display the status of Infoprint Manager printers and the queue of jobs that have
been sent to an Infoprint printer, use the following procedure from the SAP R/3
graphical user interface:
1. From the R/3 main menu, access the Spool Administration: Initial Screen

window by selecting the Tools main menu and then selecting the Tools →
Administration → Spool → Spool Administration path or typing /nSPAD in the
ok-Code field.

2. From the Spool Administration: Initial Screen window, click on the Output
devices button from the Configuration area.

3. From the Spool Administration: List of Output Devices window, do the
following:

Figure 17. Events for Output Requests field, view 2

Figure 18. Status Description field
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a. Highlight your Infoprint printer from the Devices column.
b. Click the Output device pull-down menu and click the Choose option.

4. From the Spool Administration: Change Output Device (Display) window,
click on the External jobs button.

5. The Device Information of Host Spool pop-up window displays the status of
this device.
The Device Information of Host Spool pop-up window is displayed twice to
capture both the right and the left sides. (1) This section indicates that there are
six jobs in the Infoprint Manager queue, two of which are being processed by
printers (Figure 19). (2) This section shows information about each job,
including its current status in Infoprint Manager (Figure 20 on page 50).

Figure 19. Device Information of Host Spool: first view
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Canceling jobs
The following procedure describes how you can cancel SAP print jobs that you
have sent to the Infoprint Manager AIX server. Use the following procedure from
the SAP R/3 graphical user interface. Note that this procedure provides only one
of many methods for accessing the Spool Output Requests for Spool Request
XXXXXXXXXX window, where XXXXXXXXXX is the number of your SAP spool
request.
1. From the R/3 main menu, access the Spool Administration: Initial Screen

window by typing /nspad in the ok-Code field.
2. From the Spool Administration: Initial Screen window, click on the Output

devices button from the Configuration area.
3. From the Spool Administration: List of Output Devices window, do the

following:
a. From the Devices column, use the mouse to highlight the SAP device that

you used to send your job to Infoprint Manager.
b. Click the Spool Requests button.

4. From the Spool Requests for Device XXX (where XXX is the name of the
device that you selected), double-click on the spool request of the output
request that you want to cancel.

Figure 20. Device Information of Host Spool: second view
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5. From the Spool: Attributes window, click on the Output requests button.
6. From the Spool Output Requests for Spool Request XXXXXXXXXX window

(where XXXXXXXXXX is the number of your SAP spool request), click on the
output request you want to cancel to highlight it and then click on the trash
can icon to delete the output request from Infoprint Manager.
This step invokes the Infoprint Manager command for canceling a job (pdrm).

Optional OMS configuration tasks
The following sections describe useful administrative functions, including ways of
configuring your OMS to improve performance. Be sure to consult your SAP R/3
Release 4 documentation in conjunction with any procedures described in this
section.

Activating end-user pop-ups
Infoprint Manager delivers information to SAP R/3 about output requests (print
jobs) as they process. SAP will alert job owners about problem and job completion
information delivered from Infoprint Manager through end-user pop-up messages.

Note: Until SAP R/3 Release 4.5B, the pop-up message is always reported only to
users in the client where the OMS callback daemon has logged on. You
defined this client when you “Defining a SAP user for the OMS callback
daemon or process” on page 39. In SAP R/3 Release 4.5B, SAP delivers
asynchronous pop-ups to users who are logged onto any SAP client.

To activate this support, ensure that you have done the following while installing
and configuring Infoprint Manager with SAP R/3:
1. From the SAP R/3 graphical user interface, modify the Logical Output

Management System (LOMS) definitions by specifying the spad transaction.
2. From the Spool Administration: Initial Screen window, click on the Extended

admin push-button and select the Logical OMS push-button from the Output
management systems pane to obtain a list of the Logical Output Management
Systems (LOMS) available on your installation.

3. From the Spool Admin.: List of Logical Output Management Systems
window, select the IPM001 LOMS or another appropriate LOMS and click on
the Choose icon.

Figure 21. Spool Output Requests window
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4. From the Spool Admin.: Logical Output Management (Display) window, click
the Change icon.

5. From the Spool Admin.: Logical Output Management System window that is
displayed below, check the Status dialog box field in the Jobs pane and save
the changes.

6. Once you have specified this setting, information from the Infoprint Manager
sent back to your SAP R/3 application server will be delivered in the form of a
pop-up window. For example, if an output request was canceled, a pop-up Info
window like Figure 23 on page 53 and Figure 24 on page 53 should appear on
the output requesters’ SAPGUI.

Figure 22. Logical Output Management window
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Note: All pop-up window text is scrollable, however a SAP R/3 limitation
limits the text of the Infoprint Manager messages (as well as those
received from any OMS) to 50 characters.

Selecting event report levels
The following procedure describes how you can specify the level of Events that the
callback daemon reports for jobs submitted through Infoprint Manager:
1. From the SAP R/3 graphical user interface, modify the Logical Output

Management System (LOMS) definitions by specifying the spad transaction.
2. From the Spool Administration: Initial Screen window, click on the Extended

admin push-button and select the Logical OMS push-button from the Output
management systems pane to obtain a list of the Logical Output Management
Systems (LOMS) available on your installation.

3. From the Spool Admin.: List of Logical Output Management Systems
window, select the IPM001 LOMS and click on the Choose (checkmark with a
clock) icon.

4. From the Spool Admin.: Logical Output Management (Display) window, click
the Change (red pencil) icon.

5. From the Spool Admin.: Logical Output Management (Change) window
displayed below, specify a value for the Event report level field in the SAP
configuration pane. Use the menu field to select the most appropriate value for
your installation.
When you have finished, be sure to save your changed LOMS definition by
clicking the Save folder icon.

Figure 23. Info window showing cancelled output request: right-most text.

Figure 24. Info window showing cancelled output request: left-most text.
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Organizing OMS output devices into LOMSs
While you can assign all of your R/3 OMS output devices to a single Logical
Output Management System (LOMS), it might be useful to group output devices
into separate LOMS, each with different SAP devices assigned to them. After you
define one or more LOMS on your system (see “Defining another Logical Output
Management system” on page 55), you can assign different SAP devices to each
one, depending on the functions they perform, such as:
v “Using different report levels or event delivery criteria” on page 55
v “Using different OMS services” on page 55
v “Distributing the callback workload” on page 55
v “Supporting multiple Infoprint Manager systems” on page 55

Figure 25. Logical Output Management (Change) window
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Defining another Logical Output Management system

Use the following procedure to define another Logical Output Management System
for SAP R/3:
1. From the SAP R/3 graphical user interface, copy a Logical Output Management

System (LOMS) definition by specifying the spad transaction.
2. From the Spool Administration: Initial Screen window, click on the Extended

admin push-button and select the Logical OMS push-button from the Output
management systems pane to obtain a list of the Logical Output Management
Systems (LOMS) available on your installation.

3. From the Spool Admin.: List of Logical Output Management Systems
window, click the Change (red pencil) icon.

4. From the Spool Admin.: List of Logical Output Management Systems
(Change) window (see Figure 8 on page 36),
a. Highlight the Name field of the LOMS from which you want to copy.
b. Specify the Logical OMS → Create using template path.
c. From the Spool Administration: Copy Logical OMS from OMS_Name

window, specify the name for your new LOMS in the Logical OMS field
and click the Save (Diskette) icon.

5. By returning to the Spool Admin.: List of Logical Output Management
Systems window, you can see your new LOMS displayed.

Using different report levels or event delivery criteria
You can define LOMSs to specify different report levels on the Spool Admin.:
Logical Output Management System (Change) window, as described in “Selecting
event report levels” on page 53. On the second screen of this same window, you
can also define LOMSs to specify different Event Delivery Criteria. This allows you
to determine how often and how many events are delivered together by the
Callback daemon to your SAP system. Before implementing this feature, consult
both“Defining another Logical Output Management system” and the online
documentation about LOMS that is provided with your SAP R/3 system.

Using different OMS services
You can define LOMSs to allow for the use of different OMS services by a group of
printers. For example, you can restrict access to a particular ROMS feature like job
cancellation. By creating a LOMS and turning off job cancellation, you can prevent
SAP R/3 users from deleting output requests that are sent to the devices of the
LOMS. Before implementing this feature, consult both“Defining another Logical
Output Management system” and the online documentation about LOMS that is
provided with your SAP R/3 system.

Distributing the callback workload
You can define separate LOMSs to distribute the workload of processing status
reports from the Infoprint callback daemon. For each LOMS, specify a different
R/3 server as the callback target. Before implementing this feature, consult
both“Defining another Logical Output Management system” and the online
documentation about LOMS that is provided with your SAP R/3 system.

Supporting multiple Infoprint Manager systems
Infoprint Manager provides you with the ability to send jobs to multiple Infoprint
systems from the same SAP system. An Infoprint Manager system consists of one
or more Infoprint Manager servers residing on either the same or different
machines that are set up to interoperate by sharing the same namespace. If your
print installation is large, with many printers distributed across a wide area and
managed by different Infoprint Manager systems, this function can help you to
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manage your installation more efficiently by defining separate LOMS to send jobs
to separate systems (see Figure 26 on page 57).

You can implement this support by applying either PTF U484268 on Infoprint
Manager for AIX or PTF UR53740 on Infoprint Manager for Windows, and then
using the SAP GUI to add an optional flag with values in the form host:socket to
your Infoprint Manager OMS commands: ipm_submit, ipm_dev_query,
ipm_job_query, and ipm_job_cancel.

host represents the hostname where the Infoprint server is running and socket the
socket for the Infoprint server on that host.

Before using this function, ensure that you understand the following:
v You cannot make changes to any commands unless you have applied the service

update (either PTF U484268 or PTF UR53740) to each SAP application server
where the SAP Client is installed, as well as applying the service update to the
Infoprint Manager server.

v If you are using clients on HP-UX and Sun Solaris systems, you must first
update the feature on your Infoprint Manager server by applying the
appropriate PTF, and then use a file transfer protocol to update the client parts
(ipm_submit.sys, ipm_job_cancel.sys, ipm_job_query.sys, and
ipm_dev_query.sys) on the SAP application servers.

Using the procedure described in “Defining another Logical Output Management
system” on page 55, you can define a new LOMS for every Infoprint Manager
system to which you want to send jobs. For example, in the procedure below, you
might want to create an LOMS1 and an LOMS2, one for for each Infoprint
Manager system to which you want to send jobs. In Figure 26 on page 57, LOMS1
points to the New York system, while LOMS2 points to the London system.
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To modify the OMS commands from your SAP GUI, use the following procedure:
1. From the SAP R/3 graphical user interface, modify the Logical Output

Management System (LOMS) definitions by specifying the spad transaction.
2. From the Spool Administration: Initial Screen window, click on the Extended

admin push-button and select the Logical OMS push-button from the Output
management systems pane to obtain a list of the Logical Output Management
Systems (LOMS) available on your installation.

3. From the Spool Admin.: List of Logical Output Management Systems
window, select the appropriate LOMS (for example, the LOMS1) and click on
the Commands icon.
SAP displays a list of operating systems.

4. From the list of operating systems, double-click on the operating system where
your SAP system is running to access the OMS commands.
From this panel (see Figure 27 on page 58), you can modify the OMS
commands to switch from one Infoprint system to another. For example, if you
want to change the ipm_submit command to send jobs to an Infoprint system
that resides in New York ( ny1 at socket 6874), you can change the ipm_submit
command field as follows:

command
processor

command
processor

pdserver

pdserver

pdserver

pdserver

pdserver

pdserver

Id --> q

Id --> q

ad

ad

Infoprint Manager
New York System

Infoprint Manager
London System

LOMS1

SAP
System

LOMS2

Figure 26. Sending Jobs to Multiple Infoprint Manager Instances.
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Original ipm_submit command
ipm_submit &P &F &EI &Eg &Es ’&O’ ’&o’ ’&R’ ’&f’ ’&C’ ’&Y’ ’&E1’
"&T" "&D" ’&t’

Modified ipm_submit command
ipm_submit -c ny1:6874 &P &F &EI &Eg &Es ’&O’ ’&o’ ’&R’ ’&f’ ’&C’
’&Y’ ’&E1’ "&T" "&D" ’&t’

Notes:

a. Even though this example only shows changes to the submit command,
make sure that you make the same change to all Infoprint Manager OMS
commands.

b. Do not make changes to any other part of the commands; these parameters
are positional and must not be modified.

5. Save your changes by clicking on the Save (diskette) icon.

If you wanted another set of devices from this same SAP system to send jobs to
another Infoprint system that resides in London, ( lon at socket 6874), you can
return to Step 3 on page 57, access another LOMS on this SAP system, and proceed
to change the ipm_submit command fields for this LOMS as follows:

Figure 27. Spool Administration: Operating System Commands (Change) window
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Original ipm_submit command
ipm_submit &P &F &EI &Eg &Es ’&O’ ’&o’ ’&R’ ’&f’ ’&C’ ’&Y’ ’&E1’
"&T" "&D" ’&t’

Modified ipm_submit command
ipm_submit -c lon:6874 &P &F &EI &Eg &Es ’&O’ ’&o’ ’&R’ ’&f’ ’&C’ ’&Y’
’&E1’ "&T" "&D" ’&t’

As before, remember to save your changes before exiting the Spool
Administration: Operating System Commands (Change) window by clicking on
the Save (diskette) icon.

Moving OMS definitions among SAP systems
You can maintain OMS definitions on a single application by replicating your
Infoprint Manager OMS definitions in other SAP R/3 systems. If you need to make
changes to OMS definitions, you can then transport the OMS objects from the
maintenance system to your other systems.

If you decide to transport the OMS objects from this maintenance system, then you
must use only logical spool servers in the following:
v OMS ROMS and LOMS definitions
v Infoprint Manager Output device definitions

Logical servers allow you to organize your printing architecture and manage
printers. By using only logical spool servers, you will not have to change server
names in the OMS definitions after you have transported them. For more
information about Logical servers, see the ″Spool Server Definitions: Classifying
Servers, Using Logical Servers, and Using Alternate Servers″ topic in your SAP
R/3 documentation.

The following procedure describes how you can use the R/3 logistics (transport)
system to move OMS definitions between SAP R/3 systems:
1. From the R/3 main menu, access the Real OMS window by using the

following path Tools→CCMS→ and Spool→Spool Administration or type spad in
the ok-Code field.

2. From the Spool Admin.: Initial Screen window, click on the Extended admin
push-button and select the Real OMS push-button from the Output
management systems pane to obtain a list of the Real Output Management
Systems (ROMS) available on your installation.

3. From the Spool Admin.: List of Real Output Management Systems window,
select the Change mode push-button from the ROMS list and double-click on
the ROMS definition that you want to transport.

4. From the the Spool Admin.: Real Output Management System window,
choose the appropriate transport function:
v To transport only the ROMS definition, push the Transport (truck) icon.
v To transport both the ROMS definition and all LOMS definitions that

reference it, push the Transport all (truck) icon to the right.

In either case, a transport request is created for transporting the OMS definition
objects to other R/3 systems.

5. To transport your OMS definitions, type /SE09 in the ok-Code field so you can
complete this task from the R/3 software logistics transport system.
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Switching Infoprint Manager servers
Infoprint Manager provides you with the ability to switch the Infoprint server to
which your SAP system is sending commands. This can be a valuable feature to
use if a particular Infoprint command processor fails and you want to switch to
one that is still active, or when switching from an Infoprint test system to an
Infoprint production system (as shown in Figure 29 on page 61). An Infoprint
Manager system consists of one or more Infoprint Manager servers residing on
either the same or different machines that are set up to interoperate by sharing the
same namespace.

Note: If switching from one Infoprint Manager system to another, you must ensure
that the same logical destination names have been defined on both systems.

You can implement this support by applying either PTF U484268 on Infoprint
Manager for AIX or PTF UR53740 on Infoprint Manager for Windows and then
and then using the SAP GUI to add an optional flag with values in the form
host:socket to your Infoprint Manager OMS commands: ipm_submit,
ipm_dev_query, ipm_job_query, and ipm_job_cancel.

host represents the hostname where the Infoprint server is running and socket the
socket for the Infoprint server on that host.

Figure 28. OMS Transport window
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Before using this function, ensure that you understand the following:
v You cannot make changes to any commands unless you have applied the service

update (either PTF U484268 or PTF UR53740) to each SAP application server
where the SAP Client is installed, as well as applying the service update to the
Infoprint Manager server.

v If you are using clients on HP-UX and Sun Solaris systems, you must first
update the feature on your Infoprint Manager server by applying the
appropriate PTF, and then use a file transfer protocol to resend the client parts
(ipm_submit.sys, ipm_job_cancel.sys, ipm_job_query.sys, and
ipm_dev_query.sys) to their SAP application servers.

To modify the OMS commands from your SAP GUI, use the following procedure:
1. From the SAP R/3 graphical user interface, modify the Logical Output

Management System (LOMS) definitions by specifying the spad transaction.
2. From the Spool Administration: Initial Screen window, click on the Extended

admin push-button and select the Logical OMS push-button from the Output
management systems pane to obtain a list of the Logical Output Management
Systems (LOMS) available on your installation.

command
processor

command
processor

pdserver

pdserver

pdserver

pdserver

pdserver

pdserver

Id --> q

Id --> q

ad

ad

Infoprint Manager
Test System

Infoprint Manager
Production System

SAP
System

Figure 29. Switching from one Infoprint Server to another.
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3. From the Spool Admin.: List of Logical Output Management Systems
window, select the appropriate LOMS (for example, the IPM001 LOMS) and
specify the Commands icon.
SAP displays a list of operating systems.

4. From the list of operating systems, double-click on the operating system where
your SAP system is running to access the OMS commands.
From this panel, you can modify the OMS commands to switch from one
Infoprint server to another. For example, if you want to change the ipm_submit
command to send jobs to the Infoprint server info1 at socket 6874, you can
change the ipm_submit command field as follows:

Original ipm_submit command
ipm_submit &P &F &EI &Eg &Es ’&O’ ’&o’ ’&R’ ’&f’ ’&C’ ’&Y’ ’&E1’
"&T" "&D" ’&t’

Modified ipm_submit command
ipm_submit -c info1:6874 &P &F &EI &Eg &Es ’&O’ ’&o’ ’&R’ ’&f’ ’&C’
’&Y’ ’&E1’ "&T" "&D" ’&t’

Notes:

a. Even though this example only shows changes to the submit command,
make sure that you make the same change to all Infoprint Manager OMS
commands.

b. Do not make changes to any other part of the commands; these parameters
are positional and must not be modified.

Failing over to other servers in the same Infoprint Manager
system

Infoprint Manager provides you with the ability to send jobs to destinations in
multiple Infoprint servers through any Infoprint Manager server in that Infoprint
Manager system. An Infoprint Manager system consists of one or more Infoprint
Manager servers residing on either the same or different machines that are set up
to interoperate by sharing the same namespace. A distributed installation that uses
an Infoprint server (pdserver) as a command processor might want to define
another pdserver as a backup command processor to fail over to if the primary
command processor goes down so you can continue to send jobs to the
destinations. As shown in Figure 30 on page 63, you might want to specify either
the Infoprint Manager server with the actual destination or the Infoprint Manager
server with the logical destination as the back up server.

You can implement this support by applying either PTF U484268 on Infoprint
Manager for AIX or PTF UR53740 on Infoprint Manager for Windows and then
and then using the SAP GUI to add an optional flag with values in the form
host:socket to your Infoprint Manager OMS commands: ipm_submit, ipm_query,
ipm_job_query, and ipm_job_cancel.

host represents the hostname where the Infoprint server is running and socket the
socket for the Infoprint server on that host.

Before using this function, ensure that you understand the following:
v You cannot make changes to any commands unless you have applied the service

update (either PTF U484268 PTF UR53740) to each SAP application server where
the SAP Client is installed, as well as applying the service update to the
Infoprint Manager server.
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v If you are using clients on HP-UX and Sun Solaris systems, you must first
update the feature on your Infoprint Manager server by applying the
appropriate PTF, and then use a file transfer protocol to resend the client parts
(ipm_submit.sys, ipm_job_cancel.sys, ipm_job_query.sys, and
ipm_dev_query.sys) to their SAP application servers.

v Even though this example only shows changes to the submit command, make
sure that you make the same change to all Infoprint Manager OMS commands.

v Do not make changes to any other part of the commands; these parameters are
positional and must not be modified.

To modify the OMS commands from your SAP GUI, use the following procedure:
1. From the SAP R/3 graphical user interface, modify the Logical Output

Management System (LOMS) definitions by specifying the spad transaction.
2. From the Spool Administration: Initial Screen window, click on the Extended

admin push-button and select the Logical OMS push-button from the Output
management systems pane to obtain a list of the Logical Output Management
Systems (LOMS) available on your installation.

3. From the Spool Admin.: List of Logical Output Management Systems
window, select the appropriate LOMS (for example, the IPM001 LOMS) and
specify the Commands icon.
SAP displays a list of operating systems.

4. From the list of operating systems, double-click on the operating system where
your SAP system is running to access the OMS commands.
From this panel, you can modify the OMS commands to switch from one
Infoprint server to another. For example, if you want to change the ipm_submit
command to failover to another Infoprint (pdserver) that resides within the
same Infoprint Manager system, you can change the ipm_submit command
field as follows:

Original ipm_submit command
ipm_submit &P &F &EI &Eg &Es ’&O’ ’&o’ ’&R’ ’&f’ ’&C’ ’&Y’ ’&E1’
"&T" "&D" ’&t’

command
processor

pdserver

failover pdserver

pdserver

pdserver
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ad

Infoprint Manager
Production System

SAP
System

Figure 30. Failing Over from One Infoprint Server to Another on the Same System
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Modified ipm_submit command for Infoprint server failover
ipm_submit -c ’info1:6874 info1:5157’ &P &F &EI &Eg &Es ’&O’ ’&o’
’&R’ ’&f’ ’&C’ ’&Y’ ’&E1’ "&T" "&D" ’&t’

Notes:

a. Even though this example only shows changes to the submit command,
make sure that you make the same change to all Infoprint Manager OMS
commands.

b. Do not make changes to any other part of the commands; these parameters
are positional and must not be modified.

Shutting down the callback daemon on AIX
The following procedure describes how you can shut down the SAP Callback
daemon. This procedure is useful if you are migrating the SAP Callback daemon
from one Infoprint Manager server to another or if the SAP R/3 system it supports
is not going to be used for awhile.

From an AIX command line on the system where the SAP Callback daemon is
currently running, type:

stopcbd systemname

where systemname is your 3-character SAP R/3 system name.

If you do not want a reboot of the system to restart the SAP Callback daemon,
remove its entry from the /etc/rc.iprsap file. If you remove its entry from the file,
you do not have to perform the following task, which would also prevent any
SAPconnect fax daemons from restarting automatically.

To ensure that no SAP Callback daemons are restarted automatically whenever the
systems they are running on are restarted, use the Infoprint SMIT interface:

Infoprint Printing Systems → Infoprint Utilities → SAP Daemons

From the SAP Daemons panel, select the Do not start SAP daemons at reboot
option.

If you are moving the SAP Callback daemon to another system, remember to
follow the instructions for both “Starting the SAP callback daemon or process” on
page 40 and “Configuring to start callback daemons on system reboot on AIX” on
page 41.

Shutting down the callback process on Windows
The following procedure describes how you can shut down the SAP Callback
process. This procedure is useful if you are migrating the SAP Callback daemon
from one Infoprint Manager server to another or if the SAP R/3 system it supports
is not going to be used for awhile.

To shut down the SAP Callback process on an Infoprint Manager Windows server,
you must access the SAP Callback Processes from the Infoprint Manager
Management Console .
1. From the Start menu, click on the Programs → Infoprint Manager →

Management Console path.
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2. From the Objects view in the left pane of this window, click on SAP Callback
Processes to switch the main view to SAP Callback Processes.

3. Select the particular SAP Callback Process you want to stop from those shown
in the main view. You can either perform either one of the following options:
v Right click and select Stop SAP Callback.
v From the menu bar select Actions → Stop.

If you are moving the SAP Callback process to another system, remember to follow
the instructions for “Starting the SAP callback process on Windows” on page 42.

Deleting a SAP callback process on Windows
The following procedure describes how you can delete a SAP Callback process.
This procedure is useful if you are removing one SAP Callback process and
replacing it with another, or if the SAP R/3 system it supports is not going to be
used for awhile. If you accidentally created a SAP Callback process for the wrong
host or instance ID and you want to remove it from the Infoprint Manager
Management Console and the Infoprint Manager namespace, you would use this
procedure:

To delete the SAP Callback process on an Infoprint Manager Windows server, you
must access the SAP Callback Processes from the Management Console.

Note: Before deleting a particular SAP Callback process, you must first stop it as
described in “Shutting down the callback process on Windows” on page 64.

1. From the Start menu, click on the Programs→Infoprint Manager → Management
Console path.

2. Select the SAP Callback Process object.
3. From here, you can perform either one of the following action to remove the

process from the system:
v Specify Edit → Delete → SAP Callback Process.
v Right click on the SAP Callback Process object and select Delete.
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Chapter 9. Understanding SAP access method L support

If you either cannot or choose not to use SAP Output Management System (OMS)
support, IBM recommends using SAP’s local access method L (Infoprint Manager’s
ipm_print command) to send jobs to the Infoprint Manager server. Infoprint
Manager provides a command-line client interface for SAP to submit jobs to
Infoprint Manager with job attribute information and to query for jobs to
determine when they have completed.

The Infoprint Manager ipm_print command provides SAP job information to
Infoprint Manager. For example, each SAP userid can be used to track a job
through the system. The corresponding ipm_query command allows Infoprint
Manager to provide job status to SAP. A job is not identified as complete until it
actually prints or is deleted from the print queue. You can also use the ipm_print
command to fax jobs from SAP.

For an alternative method of submitting jobs from non-AIX SAP R/3 application
servers that provide no feedback to the SAP servers, see Appendix B, “Alternate
access methods for submitting SAP jobs to Infoprint Manager”, on page 153.

If you want to use the Infoprint Manager SAP Transform, you must install the SAP
Print Feature and fonts on every Infoprint Manager server with actual destinations
that transforms either SAP OTF or ABAP data. For information on installing the
SAP Print Feature and fonts on the Infoprint Manager server, see Chapter 10,
“Installing the SAP print feature on the Infoprint server”, on page 71.

Depending on the platform that your SAP system runs on, see the appropriate
chapter from the list below to install and then see Chapter 14, “Configuring your
SAP system to use the Infoprint Manager Client command”, on page 85 to
configure your SAP system to use Infoprint Manager’s SAP access method L client:
v For installing Infoprint Manager’s client when SAP runs on either HP-UX or Sun

Solaris servers, see Chapter 11, “Installing Infoprint SAP Client support when
SAP runs on either HP-UX or Sun Solaris”, on page 75.

v For installing Infoprint Manager’s client when SAP runs on AIX servers, see
Chapter 12, “Installing the SAP Client when SAP runs on AIX”, on page 79.

v For installing Infoprint Manager’s client when SAP runs on Windows systems,
see Chapter 13, “Installing the SAP Client when SAP runs on Windows”, on
page 81.

Once you have installed the Infoprint Manager’s client for the appropriate
operating system, see Chapter 14, “Configuring your SAP system to use the
Infoprint Manager Client command”, on page 85 to configure your SAP system to
use the Infoprint Manager command.
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Chapter 10. Installing the SAP print feature on the Infoprint
server

If you are printing either Output Text Format (OTF) or Advanced Business
Application Programming (ABAP) data, ensure that you have installed the sap2afp
transform and the fonts necessary for printing. To install the transform, you must
install the SAP Print Feature on each Infoprint Manager Windows server or
Infoprint Manager Windows server with actual destinations that will be
transforming data.

Note: At a minimum, on every AIX system on which you will be running the SAP
(sap2afp) transform (on your Infoprint servers), you must have the following
fileset installed:
bos.loc.adt.iconv (Language Converter Development Toolkit)

To install the Infoprint Manager for AIX SAP Print Feature on your AIX server, see
″Starting the Infoprint Installer for Version 4.1″ in the Infoprint Manager for AIX:
Getting Started manual.

To install the SAP Print Feature on your Infoprint Manager Windows server, follow
the directions under the ″Installing Infoprint Manager server software″ topic in the
Infoprint Manager for Windows: Getting Started manual. The install program will
guide you through installing Infoprint Manager: SAP Print Feature, LCD4-1921.

To install the necessary fonts and configure the SAP transform on both the
Infoprint Manager AIX server and the Infoprint Manager Windows server, see the
rest of this chapter.

Installing Infoprint fonts for printing with the SAP transform on an
Infoprint Manager AIX server

To print output from the sap2afp transform, you must install the Gothic fonts that
are specified in the fonts.tab configuration file of the /usr/lpp/psf/bin directory on
an Infoprint Manager AIX server, as well as the required code pages. You can
obtain these font resources from the product 5648-B45: IBM AFP Font Collection
for AIX, OS/400 and OS/2 (LK2T-9269). For more information about purchasing
this product, see either your IBM sales representative or access the AFP Font
Collection homepage
(http://www.printers.ibm.com/R5PSC.NSF/Web/AFPFontHome) on the World
Wide Web.

Note: If you are printing double-byte fonts, you may require the following AFP
Font Collection CD-ROMs:
v Japanese Fonts for AIX, Windows NT, and Windows 2000 (LK2T-9276)
v Korean Fonts for AIX, Windows NT, and Windows 2000 (LK2T-9278)

To load the fonts that are required to transform OTF or ABAP data from SAP R/3
on an Infoprint Manager system, use the following procedure:
1. Load the CD-ROM for the AFP Font Collection into the CD-ROM drive on

your AIX server.
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2. Create a mount point from which to add fonts from this CD-ROM by typing
smitty cdrfs from the AIX command line and taking the following path:
CDROM File Systems→Add a CDROM File System.

3. Select F4 to set the DEVICE name field to the system-generated name
(usually cd0).

4. For the MOUNT POINT field, specify /cdrom.
5. Press the F10 key to exit SMIT.
6. From the AIX command line, mount the CD-ROM to your RS/6000 by

specifying the following two commands in sequence:
a. mount /cdrom

b. cd /cdrom

7. From the AIX command line, specify
smitty install_latest

8. For the INPUT device /directory for software field, specify
/cdrom/aix

9. To ensure that you install the correct fonts without over writing any existing
resources on your system, specify no for the COMMIT software updates?
field and yes for the SAVE replaced files? field.

10. Specify the F4 key to list all font options.
11. Use the F7 key to select the following four options:

a. afpfonts.bookmstr

b. afpfonts.compats

c. afpfonts.codepage

d. afpfonts.ocr

12. To install the fonts, press Enter.
These fonts should take approximately 43 MB on your AIX server.

13. Verify that the fonts cited in your fonts.tab configuration file have been
installed.

14. Infoprint Manager installs these fonts in the /usr/lpp/afpfonts directory.
15. To remove the IBM AFP Font Collection CD-ROM, specify the following two

commands in sequence:
a. cd /cdrom

b. umount /cdrom

16. Then you can remove the CD-ROM from your CD-ROM drive.

Installing Infoprint fonts for printing with the SAP transform on an
Infoprint Manager Windows server

To print output from the sap2afp transform, you must install the Gothic fonts that
are specified in the fonts.tab configuration file in the install_path\sap2afp directory,
as well as the required code pages. You can obtain these resources from the
product 5648–B45: IBM AFP Font Collection for AIX, OS/400 and OS/2
(LK2T-9269). For more information about purchasing this product, see either your
IBM sales representative or access the AFP Font Collection homepage
(http://www.printers.ibm.com/R5PSC.NSF/Web/AFPFontHome) on the World
Wide Web.

Note: If you are printing double-byte fonts, you may require the following AFP
Font Collection CD-ROMs:
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v Japanese Fonts for AIX, Windows NT, and Windows 2000 (LK2T-9276)
v Korean Fonts for AIX, Windows NT, and Windows 2000 (LK2T-9278)

To load the fonts that are required to transform OTF or ABAP data from SAP R/3
on an Infoprint Manager system, use the following procedure:
1. Insert the CD-ROM for the AFP Font Collection into the CD-ROM drive on

your Infoprint Manager Windows server.
2. If autorun does not start the install, double-click on the My Computer icon on

your desktop.
3. From the My Computer window, double-click on your CD-ROM drive and

then double-click on the NT folder icon.
4. From the NT folder window, double-click on the setup.exe executable to begin

the install.
5. Select the drive where you have installed Infoprint Manager to install these

fonts. For example, if Infoprint is installed on the D drive, the fonts should be
installed in the D:\afpfonts path.

6. While Infoprint recommends that you use the full installation option, if you
select a customized install, you should be certain to choose the following four
options:
v BookMaster Fonts

v Compatibility Fonts

v OCR Fonts

v Symbols Fonts

7. To install the fonts, press Next.
When the fonts finish loading, you will see a Font Collection pop-up dialog
with the message:
Installation of Font Collection 2.1.0.1 is complete.

8. Verify that the fonts cited in your fonts.tab configuration file (which is
installed in the install_path\sap2afp directory).
You can use a Notepad editor to both view and change this file.

9. Infoprint Manager installs these fonts in the install_path\afpfonts directory.
10. Remove the CD-ROM from your CD-ROM drive.

Configuring the SAP R/3 transform
Depending upon the types of data you are printing, you may need to configure
some of the files that are provided with the SAP transform. For example:
v If you want to use form definitions that are mapped to SAP Formats (Paper

Types), you must configure the pagedef.tab file as described in “Changing
document print orientation” on page 126.

v If you have created a new font in a SAP R/3 document, you must configure the
fonts.tab file as described in “Setting up your SAP R/3 system to support new
OTF user fonts” on page 140.

v If you want to expand or shorten the width of a barcode for printing, you must
configure the barcode.tab file as described in “Bar codes and printing from SAP
R/3 through Infoprint Manager” on page 147.

The SAP transform includes two types of files:
v An executable named sap2afp, which converts Output Text Format (OTF) data

into MO:DCA-P output data and Advanced Business Application Programming
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(ABAP) list format data into line data. On an Infoprint Manager AIX server, this
file is installed in the /usr/lpp/psf/bin directory. On an Infoprint Manager
Windows server, this file is installed in the install_path\bin path.

v Table 6 shows the configuration files that are installed in either the
/usr/lpp/psf/sap2afp directory on an Infoprint Manager AIX server or the
install_path\sap2afp path on an Infoprint Manager Windows server.

Table 6. SAP (sap2afp) transform configuration files for AIX

Configuration File Purpose Use

barcode.tab Provides list of valid SAP bar
codes.

OTF data only

xxxxyyyy.tab Maps ASCII code pages to
EBCDIC code pages.

OTF data only

fonts.tab Provides a list of raster fonts
with the appropriate
character set and code page.

OTF data only

6400fonts.tab Provides a list of raster fonts
that apply exclusively to the
IBM 6400 printer, with the
appropriate character set and
code page.

OTF data only

image.tab Defines the dither matrix for
half-tone color print jobs.

OTF data only

pagedef.tab Defines the form definition
(SAP PAPER TYPE) used, as
well as the page definition
and fonts for jobs that go
through ACIF.

ABAP/OTF

defcp.tab Converts ASCII into EBCDIC
characters.

ABAP data only
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Chapter 11. Installing Infoprint SAP Client support when SAP
runs on either HP-UX or Sun Solaris

SAP R/3 installations that run on HP-UX or Sun Solaris systems work with
Infoprint Manager when these installations are configured to invoke commands
remotely on the Infoprint server.

To use the access method L support of the SAP Print feature of Infoprint Manager
with a SAP R/3 system running on a non-AIX UNIX system, you must perform
the following tasks:
1. “Configuring the Infoprint Manager Server”
2. “Configuring the SAP System Server(s)” on page 77

Configuring the Infoprint Manager Server
Follow the appropriate procedure depending on which version of Infoprint
Manager you are using:
v “Configuring the Infoprint Manager Windows server”
v “Configuring the Infoprint Manager AIX server” on page 76

Configuring the Infoprint Manager Windows server

Note: The rshd and rexecd services are prerequisites for HP-UX and Sun Solaris
SAP client support.

Use the following procedure to configure the Windows server that has already
installed Infoprint Manager Version 2 Release 1 with the SAP Print Feature:
1. Install both an rshd and rexecd service on your Infoprint Manager Windows

server .
While Windows NT and Windows 2000 systems natively support both rcp and
rexec commands as a client, you just add these services to ensure that these
command requests are honored by the Infoprint Manager Windows server. One
company which sells software that provides rshd and rexecd services for
Windows NT and Windows 2000 is Denicomp Systems
(http://www.denicomp.com).

Note: During the installation of these services, ensure that remote users are
defined users on the Infoprint Manager for Windows 2.1 system so that
it is possible to write to this server from the Windows SAP client system.

2. From the Start menu, access the Programs→Administrative Tools→User
Manager path.

3. Create a new user named sapuser.

Note: This user does not have to be part of any special groups.
4. Authorize the sapuser userid to issue remote commands by adding the

following entry to the .rhosts or equivalent file: +sapuser.
5. Authorize all remote servers running the SAP R/3 applications to specify

remote commands on the Infoprint Manager Windows server by specifying:
fully_qualified_server_name +
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where fully_qualified_server_name is either the IP address (in dotted decimal
format) or the host name of the server.

Notes:

a. If you use a host name, TCP/IP must be able to resolve that name through
either the security file or through a Domain Name Server (DNS).

b. If a DNS is not being used, but the host name is specified in the hosts file,
specify the fully-qualified name in the .rhosts or equivalent file.

c. If a DNS is not being used, and the host name is not specified in the hosts
file, you must specify an IP address in the .rhosts or equivalent file (for
example, 172.16.8.10 +).

For added accountability among SAP systems and print jobs, you can create
separate NT users for each SAP system or SAP R/3 application server. Repeat
steps two through five below to create new userids that you can map to each SAP
application server from which you plan to use Infoprint Manager to print.

Configuring the Infoprint Manager AIX server
Use the following procedure to configure the AIX server that has already installed
Infoprint Manager Version 4 Release 1 with the SAP Print Feature.
1. Add a user called sapuser.

Note that this user does not have to be part of any special groups.
2. Authorize the sapuser userid to issue remote commands by adding the

following entry to the /etc/hosts.equiv file:
+ sapuser

3. Authorize all remote servers running the SAP R/3 application to specify remote
commands on the Infoprint Manager AIX server as sapuser by performing the
following procedure:
a. Add an .rhosts file with permissions of 600 to the /home/sapuser directory.
b. Edit the .rhosts file and add a line for each non-AIX server running a SAP

R/3 application with a plus (+) sign appended to it.
If a Domain Name Server is being used, specify the fully-qualified name to
the .rhosts file as shown below:
/home/sapuser/.rhosts: sol.penn.boulder.ibm.com +

If a Domain Name Server is not being used, you must also add the host
name and its IP address to the /etc/hosts file as show below:
/home/sapuser/.rhosts: sol.penn.boulder.ibm.com +

/etc/hosts: 172.16.8.10 sol.penn.boulder.ibm.com +

For added accountability among SAP systems and print jobs, you can create
separate AIX users for each SAP system or SAP R/3 application server. Follow the
three steps specified in this topic to create additional users (like sapuser) that you
can map to each application server from which you will be using Infoprint
Manager to print.

For more information about using the rsh and rcp commands to connect to the
Infoprint Manager AIX server and send files between servers, refer to your AIX
Operating System documentation.
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Configuring the SAP System Server(s)
To allow SAP on either HP-UX or Sun Solaris to issue the Infoprint Manager
commands, you must install the Infoprint Manager SAP Client on every SAP
server where an SAP application server will issue the commands. This includes
every application server with a spool work process (SWP) managing R/3 devices
that have been configured to use access method L. If you have configured your
SAP R/3 system to use alternate servers, you must repeat these installation tasks
on the alternate servers as well.

Use the following procedure to configure remote server(s) (HP-UX or Sun) running
the SAP R/3 application so you can print with Infoprint Manager:
1. Obtain access to each HP-UX or Sun Solaris server running SAP R/3 and log

on.
2. Verify that you can ping the Infoprint Manager server by hostname:

ping -c 3 hostname

where hostname is the unqualified name for the Infoprint Manager server, such
as nwser.
If the response shows that a good communication path exists, you will see the
following:
----tcpip_addr PING Statistics----

packets transmitted, 3 packets received, 0% packet loss

round-trip min/avg/max = 7/7/7 ms

3. If you cannot ping the Infoprint Manager server by hostname, edit the
/etc/hosts file and add the hostname and IP address of the Infoprint Manager
server:
/etc/hosts: 9.99.11.109 nwser

4. Create a small directory named /usr/lpp/pd/bin:
mkdir /usr/lpp/pd/bin

5. Use the FTP of your choice to copy the following two files from the Infoprint
Manager server to an SAP R/3 application server in your configuration. If you
are using an Infoprint Manager AIX server, these files reside in the
/usr/lpp/pd/bin directory. If you are using an Infoprint Manager for Windows
server, these files reside in the install_path\bin folder:
a. ipm_print.sys

b. ipm_query.sys

For the secondary qualifier (sys), specify the name of the system where your
SAP applications are running, either sun for Sun Solaris or hp for HP-UX.

6. Ensure that each file copied in step 6 is executable.
7. On the SAP application server in your installation, edit both files so they

specify the name of the user (sapuser) and hostname where Infoprint Manager
is running.

8. Copy the edited SAP command files to any other SAP application servers in
your installation that use the Infoprint Manager server.

Once you have completed this procedure, follow the directions for updating the
SAP Profile to activate the SAP Print command and define SAP devices that use
access method L in Chapter 14, “Configuring your SAP system to use the Infoprint
Manager Client command”, on page 85.
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Chapter 12. Installing the SAP Client when SAP runs on AIX

To allow SAP to issue the Infoprint Manager commands, you must install the
Infoprint Manager SAP client on every SAP server where an SAP application
server will issue the commands. This includes every application server with an
SWP managing R/3 devices that have been configured to use access method L for
sending jobs to Infoprint Manager. If you have configured your SAP R/3 system to
use alternate servers, you must repeat these installation tasks on the alternate
servers as well.

The SAP client package installs the necessary filesets on the SAP application server.
The SAP Client package requires a small set of prerequisites:
1. bos.rte 4.2.1.0

2. bos.rte.printers 4.2.1.8

To install the SAP client for AIX on your SAP application servers, use the following
procedure:
1. Log into the AIX system as root.
2. Insert the Infoprint Manager Common Client, LCD4-1917, into the CD-ROM

reader.
3. Open a terminal window.

If you are using the Common Desktop Environment (CDE), you may open a
terminal window by clicking on the terminal icon contained in the front panel.
(The front panel is the task bar that appears at the bottom of the screen.) By
default, the terminal icon is contained in a pop-up menu above the text editor
icon that appears on the front panel.

4. The first time you run the Installer, follow this procedure:
a. Type the following on the command line:

smit cdrfs

b. Select Add a CDROM File System from the list of choices presented.
c. Click the List button and select your CD-ROM device name (cd0, for

example).
d. Type the following in the MOUNT POINT field:

/cdrom

e. Click OK. The running person will raise his arms to indicate success. If he
instead falls down and you see crfs: 0506-909 /cdrom file system
already exists, do not interpret this as a failure. (The existing /cdrom file
system should be usable.)

f. Press the F12 key to exit SMIT.
5. Type the following on the command line:

mount /cdrom

6. The SAP Client package (ipr.sapclient) is installed at the command line by
specifying setup —x.
During the course of the install, you are prompted to specify values for both
PDHOST and PD_SOCKET.

Note: Note that the SAP Client package cannot be installed if other ipr* filesets
reside on a SAP application server.
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Once you have completed this procedure, follow the directions for updating the
SAP profile to activate the SAP Print Command and define SAP devices that use
access method L in Chapter 14, “Configuring your SAP system to use the Infoprint
Manager Client command”, on page 85.
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Chapter 13. Installing the SAP Client when SAP runs on
Windows

To allow SAP to issue the Infoprint Manager commands, you must install the
Infoprint Manager SAP client on every SAP server where an SAP application
server will issue the commands. This includes every application server with an
SWP managing R/3 devices that have been configured to use access method L for
sending jobs to Infoprint Manager. If you have configured your SAP R/3 system to
use alternate servers, you must repeat these installation tasks on the alternate
servers as well.

To install the Infoprint Manager SAP Client for Windows on your Windows SAP
system, use the following procedure:
1. Log in as the Administrator user.
2. Insert the IBM Infoprint Manager: Common Clients, LCD4-1917, into your

CD-ROM drive.
3. From the IBM Infoprint Manager: Common Clients window, click on Install

Infoprint Manager Products.
4. Click on Infoprint Manager SAP Clients.
5. Select a location for installing the clients (the default is install_path \Infoprint

Manager SAP Clients\).
6. From the IPM Server Settings pop-up dialog (see Figure 31 on page 82), specify

either the fully-qualified hostname or the IP address of the Infoprint Manager
server to which you will be sending jobs. The IPM Hostname field defaults to
showing the loop back address and must be changed.
The IPM Server Port Number field defaults to 6874, which you do not need to
change.

Note: Do not check the IPM Debug Mode checkbox unless instructed to do so
by IBM support.
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Once you have set the appropriate values, click OK to close this dialog.

7. When the SAP client has been installed, click the Finish button shown in
Figure 32.

8. To exit the install process, click the Back button, and then the Exit button on
the next screen.

9. To complete the configuration, follow the directions for updating the SAP
Profile to activate the SAP print command and define SAP devices that use

Figure 31. IPM Server Settings dialog

Figure 32. InstallShield Wizard Complete screen after installing SAP Clients on Windows
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access method L as described in Chapter 14, “Configuring your SAP system to
use the Infoprint Manager Client command”, on page 85.
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Chapter 14. Configuring your SAP system to use the Infoprint
Manager Client command

SAP R/3 systems work best with Infoprint Manager when these installations are
configured to use our ipm_print command.

The Infoprint Manager ipm_print command provides SAP job information to
Infoprint Manager. For example, each SAP userid can be used to track a job
through the system. The corresponding ipm_query command allows Infoprint
Manager to provide job status to SAP. A job is not identified as complete until it
actually prints or is deleted from the print queue. You can also use the ipm_print
jobs to fax jobs from SAP.

Use the “Modifying the Print Profile for SAP” before “Defining SAP devices to
send jobs to Infoprint Manager” on page 89.

Modifying the Print Profile for SAP
In order to print with access method L from an SAP server, you must edit the Print
Profile on your SAP application server. From your SAP R/3 graphical user
interface, use the following procedure:
1. Enter RZ10 in the OK-Code field to access the Edit Profiles window shown in

Figure 33 on page 86.
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2. Select the Extended maintenance radio button and click the change button to
access the Maintain R/3 Profile print_profile window shown in Figure 34 on
page 87.

Figure 33. print_profile window
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3. In the appropriate fields, specify the following values, and click the check icon
in the upper left corner to save the values. You will return to the screen two
more times to add rspo/host_spool/query, and rspo/host_spool/answer_format
values:

Parameter name:
rspo/host_spool/print

Parameter val:
ipm_print -P &P -F &F -O ’&O’ -o ’&o’ -R ’&R’ -C &C -Y ’&Y’ -T
"&T" -D "&D" -t ’&t’

Parameter name:
rspo/host_spool/query

Parameter val:
rspo/host_spool/query=ipm_query -P&P

Parameter name:
rspo/host_spool/answer_format

Parameter val:
rspo/host_spool/answer_format=lpstat

Note: For the rspo/host_spool/print values, some parameters are single-quoted
(’&o’) and some are double-quoted ("&T").

ipm_print -P &P -F &F -O &'O' -o '&o' -R '&R' -C &C -Y '&Y' -T "&T" -D "&D" -t'

Figure 34. Maintain R/3 Profile Print Profile window
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4. Specify the check icon in the upper left corner to save this data.
The SAP system responds by providing a display that demonstrates how this
print profile has been changed. Note the two highlighted sections to see the
ipm_print and ipm_query SAP clients:

5. Once you have completed steps 4 and 5 three times to enter all the appropriate
values, you must save these print profile changes. To save these print profile
changes, be sure you check yes for the dialog box about the parameter change.

6. Then ensure that you click yes for the dialog box about the profile change.

Note: If you neglect to specify yes for both dialog boxes, the SAP system may
not save your changes.

Once you verify these changes to the print profile, SAP R/3 may display the
following message, which you can ignore:

0/12/2001 Active parameters 14:33:04
Parameter name Parameter value

rspo/host_spool/query ipm_query -P &P
rspo/host_spool/print ipm_print -P &P -F &F -O "&O" -o "&o" -R "&R" -C &C -T "&T"
eu/iwb/server_win32 hrmsds1.jones.s10.ca.us
eu/iwb/server_mac hrmsds1.jones.s10.ca.us
eu/iwb/path_mac zdummy
login/system_client 400
SAPLOCALHOST hrmssbx
eu/iwb/path_win32 saphelp\helpdata
:

Figure 35. Active parameters list display from changed print profile

Figure 36. Maintain R/3 Profile display: accepting parameter change

Figure 37. Maintain R/3 Profile display: accepting profile change
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7. Once you have notified the other SAP R/3 application users, click on the Save
folder and restart (bounce) the R/3 application servers.

Once you have completed these procedures, you can create devices to print from
your SAP R/3 system, using Infoprint Manager to driver the printer(s). Use the
procedure for “Defining SAP devices to send jobs to Infoprint Manager”.

Defining SAP devices to send jobs to Infoprint Manager
The following topic describes how to create a new output device for printing to
Infoprint Manager. To enable this support, a SAP R/3 administrator must perform
the following procedure from the SAP R/3 graphical user interface:
1. Ensure that you have a logical destination defined in Infoprint Manager, which

will send jobs to your physical printer device.
2. From the R/3 main menu, access the Spool Administration window by

selecting the Tools main menu and then selecting the Tools → Administration →
Spool → Spool Administration path. or typing /nSPAD in the ok-Code field.

3. From the Spool Administration window, select the Output devices option and
select the Change push-button.

4. Select the Create icon and fill in the following information on the Create
Output Device window:

Table 7. Devices that use the Infoprint Manager OMS.

Field Explanation Example Value

Output Device Type the name that R/3
users will need to access the
printer.

PRT1

Device type Select the device type that
has been defined in the R/3
system for the printer model.
POSTSCPT applies to any
PostScript printer, while
HPLJ4 applies to a
Hewlett-Packard LaserJet 4
printer. SAPGOF sends both
OTF and ABAP data to be
transformed into AFP by the
Infoprint Manager SAP
Transform.

POSTSCPT

Figure 38. System warning display
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Table 7. Devices that use the Infoprint Manager OMS. (continued)

Spool server Select the name of the R/3
application server which will
be the SAP R/3 spool server
(spool work process) that
processes requests for this
device.

us01d2_P40_41

Host printer Type the name of the
Infoprint Manager logical
printer.

prt1-lp

Device class Enter a space so that this
field accepts the default
value of printer, which is P.

Access method in host spool Select the method that the
spool work process uses to
pass data to the host spool
system.

L

5. From the menu bar, click on the Back icon and the system will prompt you to
save the new output device.
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Part 4. Customizing your print environment
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Chapter 15. Fax support in SAP R/3

Infoprint Manager provides two distinct methods for providing fax support to SAP
users: either the SAPcommunications (SAPcomm) interface or the SAPconnect
interface. The SAPcomm interface applies to all SAP releases until Release 6 and
only provides you the ability to send faxes (fax-out). The SAPconnect interface
supports future releases of SAP R/3 and provides you with the capability to both
send (fax-out) and receive (fax-in) faxes from your SAP user interface, using your
Infoprint Manager AIX server.

IBM recommends using the SAPcomm method if possible, since it combines all the
benefits of using Infoprint Manager’s OMS support (see Part 2, “Installing and
Configuring Infoprint Manager’s Output Management (OMS) Support”, on
page 13) with the ability to send faxes. You can also send faxes from your SAP
system to Infoprint Manager, using access method L (see Part 3, “Infoprint
Manager non-Output Management Support”, on page 67).

In order to submit faxes from SAP R/3 systems, you must have installed and
configured the separately-priced Infoprint Manager for AIX Fax Line Feature,
LCD4-5577. For information about installing and configuring Infoprint Fax Line
Feature, see both the Infoprint Manager for AIX: Getting Started and Infoprint
Manager for AIX: Procedures manuals.

Note: Fax support is not currently available with Infoprint Manager for Windows,
unless you are also using Infoprint Manager for AIX.

Using SAPcomm support for fax-out
Faxing jobs from SAP R/3 to Infoprint Manager is similar to printing jobs from
SAP R/3 to Infoprint Manager: you must define a SAP device that is connected to
an Infoprint Manager destination. However, you must define a SAP device so that
a fax number can be passed to Infoprint Manager.

To submit faxes from SAP R/3 systems using SAPcomm, you must:
v Configure the Infoprint Fax support on your Infoprint Manager AIX server
v Have set you SAP system to send print jobs to Infoprint Manager using either

the OMS support (see Part 2, “Installing and Configuring Infoprint Manager’s
Output Management (OMS) Support”, on page 13) or access method L (see
Part 3, “Infoprint Manager non-Output Management Support”, on page 67)

Once you have verified that these prerequisites have been done, use the following
two procedures to implement sending faxes from SAP R/3.

Creating an R/3 fax device
The following procedure describes how you can create a SAP R/3 fax device for
submitting jobs to an Infoprint Manager AIX server:
1. Ensure that you have defined a logical destination in Infoprint Manager that

will send jobs to the fax destination.
2. From the SAP R/3 graphical user interface, specify either /nspad transaction

in the ok-Code field, or take the Tools → Administration:Spool → Spool
Administration) path from the main menu.
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3. From the Spool Administration: Initial Screen window, click the Output
Devices button, click the Change (red pencil) icon, and push the Output
Devices push-button.

4. From the Spool Administration: List of Output Devices window, click the
Create (white paper image to the right of the trash can) icon.

5. From the Spool Administration: Create Output Device window, fill in the
following information:

Field Value

Output Device FAX

Type the name that R/3 users will need to
access the device.

Device class F

Select a device class for the fax.

Host printer ip01-sam

Type the Infoprint Manager logical
destination (printer) name that will send the
job to the Infoprint fax destination. .

Access method to host spool access method E or access method L .

Ensure that you specify the appropriate
access method, depending upon how you
configure your SAP system to communicate
with Infoprint Manager.

LOMS

(only applies to access method E).

IPM001

If you are running with the Infoprint
Manager OMS support (access method E),
specify the LOMS to which this device
should be assigned. You specified this value
on the Spool Admin.: Logical Output
Management System window when you
Defined the Infoprint Manager OMS to SAP
R/3 on the SAP System Server.

Spool server ibmbtt15_BTF_15

Choose an applicable spool server from the
entries list on the field.

6. Save your device definition, by specifying Output Device → Save from the
menu options.

7. Specify the /nscon (Tools → Communication → Configuration) transaction.
8. From the SAPcomm: Configuration window, select the Location option from

the Destination pane and click on the Change push-button.
9. Click on the check box to close the pop-up message window that displays

information about the table’s client independent status.
10. From the SAPcomm: ″destination location″: Overview window, click on the

New entries push button and specify the Output Device that you created in
step 4.
Note: Specify the appropriate country code in the Cntry column. For example,
specify US for an installation in the United States.
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11. From the New Entries: Details of Created Entries window, click on the save
folder icon to save your changes.

12. From the SAPcomm: Configuration window, select the Selection option from
the Destination pane and click on the Change push-button.

13. Click on the check box to close the pop-up message window that displays
information about the table’s client independent status.

14. From the SAPcomm: ″destination selection″ window, click on the New
Entries field.

15. From the New Entries: Details of Created Entries window, fill in the
following values on the Selection pane:

Field Value

Service TELEFAX

Specify the type of service.

Cntry US

Specify the country code that you specified
in step 9 above.

Note: The Key, Type, Area Served, and Device group fields should all be left
blank.

16. Under the Destination pane, specify the output device that you created in
step 4: FAX.

Note: The Country of location field should be left blank.
17. Save your fax definition by clicking the Save folder icon.

Once you have completed this procedure, you are ready to submit a fax request
from SAP R/3 to Infoprint Manager.

Submitting a fax from SAP R/3 to Infoprint Manager
Once you have finished creating an R/3 fax device, you can use the following
procedure to submit a fax from your SAP R/3 system to the Infoprint Manager
AIX server:
1. From the SAP R/3 graphical user interface, create a spool request for a

document that you want to fax.

Note: Ensure that the Print immediate push-button is not selected.
2. Enter /nsp01 in the ok-Code field.
3. From the Spool Requests window, select the spool request that you specified in

step 1 and click on the Printer icon.
4. From the Spool: Output Request window, specify the relevant fields in the

Print parameters and Title page pane, then click on the Fax icon button.
5. From the Spool: Query FAX Number pop-up window, specify the number to

which you are sending the fax in the Recipient number field and the
appropriate country key in the Country key field.

6. Click on the Fax button.
7. Your fax job will be sent to the Infoprint Manager fax destination and be faxed.

You can also fax from SAP applications by providing the fax number and
selecting the Fax device.
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Using SAPconnect support for fax-out and fax-in
SAPconnect is the successor to the SAP Communications Server (SAPcomm). By
using remote function call (RFC) technology SAPconnect allows SAP R/3 users to
access a variety of communication systems – including fax servers – directly from
R/3. The Fax function of Infoprint Manager allows the Infoprint Manager AIX
server to act as a fax server. Infoprint Manager for AIX 4.1 offers the
separately-priced Infoprint Manager for AIX Fax Line Feature, LCD4-5577.

With Infoprint Manager SAPconnect support, a SAP user can log onto a SAP
system from his or her personal computer and either send or receive a fax through
Infoprint Manager. This SAP user can create a document in their SAP Office
outbox, select attachments, and send a fax through Infoprint Manager. When ready,
the user can select the Fax icon and enter a fax number. The SAPconnect interface
on the SAP system forwards the job to Infoprint Manager’s SAPconnect daemon,
which passes the job through an Infoprint server to an Infoprint Fax actual
destination. For more information about how to use this support, see “Using
SAPconnect for fax out support (sending faxes)” on page 98

SAPconnect support also allows a SAP user to receive incoming fax messages from
others through Infoprint Manager. Another person can fax something to a SAP
user’s fax number, which is being monitored by Infoprint Manager. Infoprint
Manager Fax In support forwards the fax through an Infoprint Manager server to a
sapconnect actual destination, which delivers the fax to the user’s SAP system. The
SAP system receives the fax request for a particular fax number through the
SAPconnect interface and delivers it to that SAP user’s SAP Office in box. For more
information about how to use this support, see “Using SAPconnect for fax in
support (receiving faxes)” on page 118.

Figure 39. SAPconnect Fax-Out Overview
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Using examples from the New Visual Design SAP GUI on a Release 4.6c system,
this topic provides the following information:
1. “Installing the SAPconnect Support” on page 98.
2. “Using SAPconnect for fax out support (sending faxes)” on page 98.

a. “Preparing to connect the SAP System to an Infoprint Manager SAPconnect
daemon” on page 99.

b. “Customizing SAPconnect” on page 103.
c. “Using the Infoprint fax actual destination for fax-out” on page 98.
d. “Configuring the SAPconnect daemon on Infoprint Manager” on page 105.
e. “Testing the RFC from SAP R/3” on page 110.
f. “Preparing and sending faxes from R/3” on page 111.

3. “Using SAPconnect for fax in support (receiving faxes)” on page 118.
a. “Creating a CPIC or system type userid for the Infoprint Manager

sapconnect actual destination” on page 119.
b. “Creating Infoprint Manager objects” on page 119.
c. “Logging the Infoprint actual destination onto the SAP system” on page 120.
d. Configure the Fax-in lines to feed the appropriate SAPconnect actual

destination on an Infoprint Manager AIX server.

Figure 40. SAPconnect Fax-In Overview
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Installing the SAPconnect Support
To use the SAPconnect support for either fax-out or fax-in support, you need to
install and configure the following on your Infoprint Manager AIX server(s) before
performing the configuration tasks described in this publication:
v Infoprint Manager SAP Print Feature, LCD4-1921.

You must install this feature through the Infoprint Installer in order to use the
SAPconnect daemon for fax-out support and the sapconnect DSS for fax-in
support. For more information about installing the SAP Print feature, see
Chapter 4, “Installing the SAP print feature on the Infoprint server”, on page 17.

v Infoprint Fax function.
Fax support is available with the separately-priced Infoprint Manager for AIX
Fax Line Feature, LCD4-5577, of the base Infoprint Manager for AIX 4.1 product.
See ″Configuring and using Infoprint Manager Fax″ in the Infoprint Manager for
AIX: Procedures manual to perform the necessary configuration tasks on your
Infoprint Manager AIX server.

Note: If you have multiple interoperating AIX servers running Infoprint servers,
the Infoprint Fax feature can be installed on a different Infoprint Manager
AIX server than the server that runs the SAP Print feature.

Using SAPconnect for fax out support (sending faxes)
By configuring SAP to use the new Infoprint Manager SAPconnect support, the
SAP System sends the request in the form of a SAP RFC call to the Infoprint
Manager SAPconnect daemon that is running on the Infoprint Manager AIX server.
The SAPconnect daemon converts the RFC call into a print request (an Infoprint
Manager pdpr command), which is sent to an Infoprint Manager Fax destination.
The Fax destination faxes this job to the fax number specified by the SAP user.

An Infoprint Manager SAPconnect daemon supports a single SAP system. Start
one SAPconnect daemon for each SAP system that you plan to support.

Once you have ensured that the prerequisites are installed on your Infoprint
Manager AIX server (see “Installing the SAPconnect Support”), you must complete
the following configuration tasks in order for SAP users to send faxes:
1. “Using the Infoprint fax actual destination for fax-out”.
2. “Preparing to connect the SAP System to an Infoprint Manager SAPconnect

daemon” on page 99.
3. “Customizing SAPconnect” on page 103.
4. “Configuring the SAPconnect daemon on Infoprint Manager” on page 105.
5. “Testing the RFC from SAP R/3” on page 110.
6. “Preparing and sending faxes from R/3” on page 111.

Note: To make this task more manageable, you may want to access Appendix A,
“SAPconnect fax-out configuration worksheet”, on page 151 and print out
copies so you can keep track of the different values specified throughout
your configuration.

Using the Infoprint fax actual destination for fax-out
Before you configure the SAPconnect daemon, you must have an Infoprint actual
destination to send fax output. In order to send faxes through Infoprint Manager,
you must first configure the Infoprint Fax support, using the ″Configuring and
Using Infoprint Fax″ section of the Infoprint Manager for AIX: Procedures manual.
You must purchase, install, and configure the Infoprint Manager for AIX Fax Line
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Feature, LCD4-5577. Ensure that this Fax DSS Infoprint actual destination works
correctly. Use the Infoprint logical destination that feeds this actual destination or
create a new one for SAPconnect fax output. Record the name of this destination
for use later when you define the start command for the SAPconnect daemon. You
specify the name of this destination for the IPMLogicalDestinationName
parameter value in “Starting the SAPconnect daemon from the Infoprint Manager
AIX server” on page 107.

Preparing to connect the SAP System to an Infoprint Manager
SAPconnect daemon
The following three procedures must be completed in sequence before your
Infoprint Manager Fax support can be connected to your SAP R/3 system:
1. “Creating a CPIC or system type user for the Infoprint Manager SAPconnect

daemon”.
2. “Creating a SAP RFC destination”.
3. “Activating fax function in SAP Office” on page 103.

Creating a CPIC or system type user for the Infoprint Manager SAPconnect
daemon: Because the Infoprint Manager SAPconnect daemon (sapconnd) daemon
must logon to the SAP system to make RFC calls to the SAP system sending fax
output, you must create a user for it. This userid allows the SAPconnect daemon to
send asynchronous data about the results of the fax back to the SAP system.

To create a user for the Infoprint Manager SAPconnect daemon (sapconnd)
daemon, use transaction su01 to access the User Maintenance: Initial Screen
window.

The user must be either a CPIC or System type and have authorizations provided
in the S_A.SCON profile. Record the user, password, and client values for use later
when you define the start command for the SAPconnect daemon in “Starting the
SAPconnect daemon from the Infoprint Manager AIX server” on page 107.

If you ever modify this SAP user, remember to make the changes to the rc.iprsap
file in the /etc directory on the Infoprint Manager AIX server where the
SAPconnect daemon is running.

Creating a SAP RFC destination: Before you can submit faxes from SAP R/3
using Infoprint Manager fax support, you must create a Remote Function Call
(RFC) destination. You will need this destination for “Configuring the SAPconnect
daemon on Infoprint Manager” on page 105.
1. Login to the SAP R/3 GUI.
2. Type SM59 in the field on the left side of the menu bar.

If this field is closed, you may need to click on the right-facing arrow on the
left side of the menu bar between the Enter (green checkmark) key and
diskette icons.

3. From the Display and maintain RFC destinations window (Figure 41 on
page 100), click on the Create button.
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4. From the RFC destination window shown in Figure 41, you must:
a. Enter the name of the destination in the RFC destination field.

Record the destination name for use later when you define the start
command for the SAPconnect daemon in “Starting the SAPconnect
daemon from the Infoprint Manager AIX server” on page 107 and in
“Configuring the RFC initialization file on Infoprint Manager” on page 105.
Note that this value must match the DEST= parameter value in the
saprfc.ini file that resides on your Infoprint Manager AIX server.

b. Specify T in the Connection type field to indicate an external TCP/IP
connection.

c. Specify a short description (such as IPM FAX destination) in the
Description field.

d. Press the Enter key.

Figure 41. Display and maintain RFC destinations window
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Figure 42. RFC Destination window
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5. From Figure 43, access the Activation Type and press the Registration
push-button next to Activation Type.

6. Enter a Program ID field value for the Infoprint Manager SAPconnect daemon
in the format sysname.program_name, such as info1.sapconnd, where info1 is
the name of the Infoprint Manager AIX server where the SAP Print feature
was installed and sapconnd is the name of the program.
Record this value for use in “Configuring the RFC initialization file on
Infoprint Manager” on page 105. Note that this value must match the
PROGID= parameter value in the saprfc.ini file that resides on your Infoprint
Manager AIX server.

7. From the RFC Destination NEW_DEST827 window main menu, take the
Destination → Gateway options path.

8. From the RFC Destination NEW_DEST827 pop-up dialog, specify values for
both the Gateway host and the Gateway service fields.
Record this value for use in “Configuring the RFC initialization file on
Infoprint Manager” on page 105. Note that these values must match the
GWHOST= and the GWSERV= parameter values respectively in the
saprfc.ini file that resides on your Infoprint Manager AIX server.

9. Select the OK button to save these values.

Figure 43. RFC Destination window for registration
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10. Use F11 to save your entries.
At the very bottom of the window to the right of the green checkbox, you
should see a message similar to the following:
Destination NEW_DEST827 saved

Activating fax function in SAP Office: You must activate the Fax function in the
SAP Office component of your SAP R/3 application using the following procedure
if you are running with a SAP R/3 Release 4.0. If you are using a SAP R/3 Release
4.5 system or higher, this procedure is unnecessary, but you should still verify the
fax component is selected after customizing SAPconnect for faxing.
1. Login to the SAP R/3 GUI.
2. Type SO16 in the field on the left side of the menu bar.

If this field is closed, you may need to click on the right-facing arrow on the
left side of the menu bar, between the Enter (green checkmark) and diskette
icons.

3. From the Shared office settings window, select the Send tab and click the
checkbox for the Fax component.

4. Press the F11 key to save your entries.

Customizing SAPconnect
Before you can use the Infoprint SAPconnect daemon to send faxes from a SAP
R/3 system, you must perform the following two customization tasks on your SAP
system:
1. “Customize SAPconnect for faxing”.
2. “Creating a SAPconnect node”.

Customize SAPconnect for faxing:

1. From the SAP R/3 GUI, type SCOT in the field on the left side of the menu bar.
If this field is closed, you may need to click on the right-facing arrow on the
left side of the menu bar between the Enter (green checkmark) and diskette
icons.

2. From the SAPconnect:Administration (jobs) window, take the Settings →
Communication methods options path.

3. From the Change View ″SAPconnect: Maintenance view — communication
methods″:.. window,
v Set the Typ field value to FAX.
v Set the Method field value to SAPCONNECT.

4. Press the F11 key to save your entries.

Creating a SAPconnect node: In R/3, a node is a logical view of a
communication system that can represent a fax system, an e-mail system, or
another R/3 system. This SAP node is being created to represent the Infoprint
Manager fax server.
1. Login to the SAP R/3 GUI.
2. From the SAP R/3 GUI, type SCOT in the field on the left side of the menu bar.

If this field is closed, you may need to click on the right-facing arrow on the
left side of the menu bar between the Enter (green checkmark) and diskette
icons.

3. From the SAPconnect: Administration (jobs) window, take the View → Node
options path.
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4. From the SAPconnect: Administration (nodes) window, select the Create icon
(piece of paper) on the far left.

5. From the Create nodes pop-up dialog:
v Set the Node field value to the name you select for this node, such as

IPMFAX.
v Set the Description field value to IPMFAX Node for Fax Support.

6. Click the continue button and specify the object you created in “Creating a
SAP RFC destination” on page 99 (NEW_DEST827) in the RFC destination field.
If defined correctly, you should be able to click on the circular icon of two
superimposed pages to the right of this field to select this value instead of just
typing it into the field.

7. Click the continue button and ensure that the Fax radio button is selected.
8. Click the continue button and ensure that the Address area field contains a *.

By specifying a *, you ensure that this node will send faxes to any series of
numbers. If you were limiting this node to a particular number, you would
specify it in the form of ctry num where ctry specifies the abbreviation for
faxes sent to a particular country and num specifies the fax number without
any special characters. To ensure that you correctly specify these fax numbers,
IBM recommends that you select the Click here for further
information.... link.

9. Click the continue button, ensure that the Only the fll formats radio button is
clicked, and type in each of the following as separate entries in the Format
table:
PDF
PS
RAW
GIF
JPEG
PCL

10. Click the continue button and specify a valid PostScript device type, such as
POST2, in the Dev. type field.
This defines the SAP device type for which SAPscript documents are prepared
if SAPconnect data is converted into a print format.

11. Click the continue button and click on the check box next to Country so you
can use the drop down list to select the appropriate country code for sending
fax output.
From the Country key pop-up dialog, use the cursor to select the appropriate
country abbreviation, then click on the Enter (green checkmark) key to save
your value and exit the dialog.
Before deciding on whether to check the Node-specific fax number changes
check box, IBM recommends that you select the Click here for further
information... link. Selecting this check box allows you to define general
replacement rules for nodes that replace one row of digits with another, such
as deleting the area code for all faxes submitted from the local area.

12. Click the continue button and select the radio button N next to the question
Set further address types?

13. Click the continue button and specify the Maximum waiting time for repeat
send attempt procedure: in the Hours and Minutes fields.

14. Click the continue button and specify the appropriate radio buttons to
indicate that this node cannot resolve path references.

15. Click the continue button and specify the Node is ready for use radio button.

January 27, 2003

104 Printing Systems Division: Infoprint Manager: SAP R/3 Configuration and Printing Tasks



Once you set this value, you receive a status panel that shows your node
defined to the SAP R/3 system as shown on Figure 44

Configuring the SAPconnect daemon on Infoprint Manager
Before you can begin to send faxes from your SAP R/3 system to Infoprint
Manager, you must perform the following steps to configure the SAPconnect
daemon on your Infoprint Manager AIX server:
1. “Configuring the RFC initialization file on Infoprint Manager”.
2. “Starting the SAPconnect daemon from the Infoprint Manager AIX server” on

page 107.
3. “Configuring to start SAPconnect daemons on system reboot” on page 108.

Configuring the RFC initialization file on Infoprint Manager: Before your
Infoprint Manager AIX server can begin to receive SAPconnect RFC requests from
a particular SAP R/3 system, you must edit and configure both the RFC Server
Information (see step 2 on page 106) and the RFC Client Information (see step 4 on
page 106) found in the saprfc.ini file.

Figure 44. Display of defined node On SAP system
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Use the following procedure to perform this task on your Infoprint Manager AIX
server:
1. From an AIX command line, copy the default saprfc.ini file from its default

location to the /var/pd directory where it must be installed by typing :
cp /usr/lpp/pd/bin/saprfc.ini /var/pd/saprfc.ini

If you are reinstalling, ensure that you copy any customization you’ve made
from your existing /var/pd/saprfc.ini file to the new file so it is not lost.

2. From the /var/pd directory, edit the saprfc.ini file and copy the following
sample block of server information to the bottom of the file:
# RFC Server Information

#DEST=<SAP defined Destination>
#TYPE=R
#PROGID=<SAP defined Program ID>
#GWHOST=<HostName of the SAP Gateway>
#GWSERV=<Service Name of the SAP Gateway>
#RFC_TRACE=1

3. Remove the comment indicator (#) in front of each line that follows the # RFC
Server Information line and fill in the appropriate values for these fields by
replacing the terms defined within the angle brackets with the actual values
that you used on your SAP R/3 system in “Creating a SAP RFC destination” on
page 99.
Please note that these values must match exactly the values you used in
creating your RFC Destination:
# RFC Server Information

DEST=NEW_DEST827
TYPE=R
PROGID=info1.sapconnd
GWHOST=cpmat00
GWSERV=sapgw10
RFC_TRACE=1

4. Copy one of the following sample blocks of SAP client information to the
bottom of the file.
If you copy the Load Balancing block, SAP R/3 will determine which SAP
application server the SAPconnect daemon logs onto at runtime, using the load
balancing feature of SAP R/3.
Copy the Specific Application Server block if you have only one SAP
application server:
# RFC Client Information - Specific Application Server

#DEST=<SAP System Name>
#TYPE= A
#ASHOST=<SAP Application Server Host>
#SYSNR=<SAP System Number>
#GWHOST=<optional, default: gateway on Application Server>
#GWSERV=<optional, default: gateway on Application Server>
#RFC_TRACE=1
#ABAP_DEBUG=0
#USE_SAPGUI=0
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Copy the Load Balancing block if you have more than one SAP application
server and you want the SAP R/3 system to determine which SAP application
server the SAPconnect daemon logs onto at runtime:
# RFC Client Information - Load Balancing

#DEST=<SAP System Name>
#TYPE=B
#R3NAME=<SAP System Name>
#MSHOST=<Host Name of the Message Server>
#GROUP=<Application Servers group name, optional, default: PUBLIC>
#RFC_TRACE=1
#ABAP_DEBUG=0
#USE_SAPGUI=0

5. Remove the comment indicator (#) in front of each line that follows the # RFC
Server Information line, and fill in the appropriate values for these fields by
replacing the terms defined within the angle brackets with the actual values
that you used on your SAP R/3 system.
Please note that these values must match exactly to those set on the SAP
system. The only exception to this rule are the GWHOST and GWSERV
parameters, which can be left commented out.
# RFC Client Information - Specific Application Server

DEST=SJD
TYPE=A
ASHOST=cpmat00
SYSNR=10
#GWHOST=cpmat00
#GWSERV=sapgw10
RFC_TRACE=1
ABAP_DEBUG=0
USE_SAPGUI=0

6. Exit the saprfc.ini file and save your changes.
7. To ensure that the Infoprint SAPconnect daemon will be able to communicate

with whatever SAP application server, SAP Gateway server, and SAP Message
server that you refer to in the saprfc.ini file, you must be able to issue a ping
command against these servers by name (not an IP address in dotted decimal
notation format).
If you cannot ping the various SAP hosts by name (for example, ping cpmat00),
you must
a. From an AIX command line, move to the /etc directory: cd /etc

b. Using your AIX editor of choice, edit the hosts file and copy the host names
of the SAP Gateway (GWHOST=cpmat00), the SAP application server
(ASHOST=cpmat00), and the message server (MSHOST=cpmat00 ) in the format:
ip_address cpmat00 # SAP Gateway hostname address

Note: It is not sufficient to be able to issue a ping command using the
dotted decimal notation IP address of the SAP application server.

Starting the SAPconnect daemon from the Infoprint Manager AIX server: Each
SAP R/3 system using the Infoprint Manager SAPconnect Fax support needs to
have one SAPconnect daemon running. To start the SAPconnect daemon, you must
edit and run the /etc/rc.iprsap file from the AIX command line on your Infoprint
Manager AIX server.
1. From the AIX command line, copy the following lines of this file from the

/usr/lpp/pd/bin/rc.iprsap that you just installed to the /etc/rc.iprsap file, being
careful not to overwrite any previous definitions:
# echo Starting sapconnectd <System Name>
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# /usr/lpp/pd/bin/startsapconnectd <SAPDestinationName <SAPSystemName>
<IPMLogicalDestinationName> <User> <Client> <Password> <Language>

2. From the AIX command line, access the rc.iprsap file in the /etc directory. Edit
the file to copy and uncomment the two lines for the SAPconnect daemon:
a. An echo statement that states that the SAPconnect daemon has been started:

echo Starting sapconnectd <System Name>

b. The startsapconnectd command:
/usr/lpp/pd/bin/startsapconnectd <SAPDestinationName <SAPSystemName>
<IPMLogicalDestinationName> <User> <Client> <Password> <Language>

3. Specify the appropriate values for the items within angle brackets.

SAPDestinationName
Specifies the name of the destination that you defined in “Creating a
SAP RFC destination” on page 99 and put in the server DEST= field
value in the saprfc.ini file.

SAPSystemName
Specifies the three-character name of the SAP system. This value must
match the client DEST= field value in the saprfc.ini file.

IPMLogicalDestinationName
Specifies the name of the logical destination on your Infoprint Manager
AIX server that feeds faxes to the Infoprint Manager fax actual
destination.

User The SAP user name defined in “Creating a CPIC or system type user
for the Infoprint Manager SAPconnect daemon” on page 99.

Client The SAP client name.

Password
The SAP R/3 system password.

Language
The two-character language value.

4. Once you have saved and exited the file, start the SAPconnect daemon from
the command line by specifying:
/etc/rc.iprsap

If the SAPconnect daemon starts correctly, you should see the following
response:
Starting sapconnectd SJD
5010-405 Successfully started server sapconnd.SJD

where SJD represents the name of your SAP system.

If you receive any other message, the daemon has not started correctly. To
resolve the problem, refer to the /var/pd/sapconnd.sysname/error.log file (where
sysname is the SAP R/3 system name to which the SAPconnect daemon is
connected), correct the problems cited, and try to start the SAPconnect daemon
again. If it still does not start correctly, contact your Printing Systems technical
support representative.

Configuring to start SAPconnect daemons on system reboot: The SAPconnect
daemon needs to run all the time. To ensure that the daemon is restarted if the AIX
system that it runs on is rebooted, you need to perform one more step to add the
rc.iprsap file to the /etc/inittab directory, if it has not already been added.
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To ensure that the SAPconnect daemons are restarted automatically whenever the
system they are running on is restarted, use the Infoprint SMIT interface:

Infoprint Printing Systems → Infoprint Utilities → SAP Daemons

From the SAP Daemons panel, select the Start SAP daemons at reboot option.
This action affects SAP Callback daemons (sapcbd) as well and only needs to be
performed once.

If you prefer the command line, you can enter the following at the AIX command
line instead: mkitab "rciprsap:2:once:/etc/rc.iprsap.out 2>&1 # Autostart of
Infoprint SAP daemons"

Both the SMIT interface and this command ensure that the SAP daemons
(sapconnectd) are restarted automatically whenever the systems they are running
on are restarted.

As you add more SAPconnect daemons to your Infoprint Manager configuration,
you do not have to perform this step, but you do need to add a new echo and
startsapconnectd entry in the /etc/rc.iprsap file and type /etc/rc.iprsap on the
AIX command line. This line starts your new SAPconnect daemons and causes any
running SAPconnect daemons or SAP Callback daemons to report that they are
already running.

Shutting down the SAPconnect daemon
The following procedure describes how you can shut down the SAPconnect
daemon. This procedure is useful if you are migrating the SAPconnect daemon
from one Infoprint Manager AIX server to another, or if the SAP R/3 system it
supports is not going to be used for awhile.

From an AIX command line on the system where the SAPconnect daemon is
currently running, type:

stopsapconnectd systemname

where systemname is your 3-character SAP R/3 system name.

If you do not want a reboot of the system to restart the SAPconnect daemon,
remove its entry from the /etc/rc.iprsap file.

To ensure that neither SAPconnect daemons or SAP Callback daemons are
restarted automatically whenever the systems they are running on are restarted,
use the Infoprint SMIT interface:

Infoprint Printing Systems → Infoprint Utilities → SAP Daemons

From the SAP Daemons panel, select the Do not start SAP daemons at reboot
option.

Note: Remember that this action also means that the SAP Callback daemon
(sapcbd) is not restarted when the Infoprint Manager AIX server reboots.
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Testing the RFC from SAP R/3
Once you have performed the configuration tasks on both the SAP R/3 system and
your Infoprint Manager AIX server for sending Remote Function Calls (RFCs)
consisting of fax data, it is time to test your installation. Use the following two
procedures:
v “Verify your RFC connection”.
v “Verify that node can route fax numbers”.

Once you have verified that your Infoprint Manager AIX server and your SAP R/3
server can communicate, you can begin sending faxes from your SAP R/3 system.

Verify your RFC connection: From the RFC Destination NEW_DEST827 window
main menu, take the Test → Connection options path to verify the connection. The
RFC — Connection Test pop-up dialog will display either a working connection or
provide an error message to indicate the source of the problem.

Verify that node can route fax numbers: To verify that SAP can route fax
numbers to the node you created in “Creating a SAPconnect node” on page 103,
use the following procedure to perform a routing test. For our example, we
defined an unrestrictive value of *, so all numbers should correctly resolve:
1. Login to the SAP R/3 GUI.
2. Type SCOT in the field on the left side of the menu bar.

If this field is closed, you may need to click on the right-facing arrow on the
left side of the menu bar, between the Enter (green checkmark) and diskette
icons.

3. From the SAPconnect: Administration (view) window (where view specifies one
of a series of views; it does not matter which view you select), select the
Utilities → Routing test path.

4. From the SAPconnect: Test routes window, fill in the following field values:

Sender
Specifies the SAP sender ID from which the fax is to be submitted.

RecipientAddr.type
Select or type in FAX.

Recipient addr.
Specify the complete fax number to which you are submitting the fax
job, prepended with the destination country abbreviation.

5. Once you have specified these values, press the Enter key to test these values.
If the number is provided in the correct format (which you defined in Step 8 of
“Creating a SAPconnect node” on page 103), the Outbound node and modified
recipient address portion of the window displays the node to be used in the
Node field and the number as it is sent to Infoprint Manager in the Recipient
addr. field. No message appears in the text block at the bottom of the window.
If the number provided is not in the correct format, the text block at the bottom
of the page displays a red circle embossed with a white X and a message
similar to the following: No delivery to 99999, invalid recipient address

6. If you receive an error, either select the magnifying glass icon on the upper-left
side of the window to access the SAPconnect: Explanation of Routing and
Address Conversion window.
This window explains each step in the SAP routing process and shows any
errors where they appeared. Use this window to diagnose problems connecting
to SAP fax numbers.
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7. Once you discover the source of your error if you need to modify the node’s
address area, you should access your Node definition by:
a. Typing the SCOT transaction.
b. Clicking the View → Node path.
c. Clicking the Change (pencil) icon.
d. Double-clicking on the value under FAX (for our example *) and specifying

a different set of criterion in the SAPconnect: Maintain address area
pop-up dialog.

Once changed, repeat this procedure until you stop receiving an error.

Preparing and sending faxes from R/3
Once you have verified the connection, you should use the following procedures
from your SAP R/3 system to ensure that you can prepare and send faxes:
1. “Creating addresses”.
2. “Creating documents”.
3. “Configuring to send faxes automatically” on page 116.

Once these steps have been verified, you can assign the necessary fax numbers and
permissions to SAP users on the system so they can submit faxes through Infoprint
Manager.

Creating addresses: Before sending faxes, an SAP administrator must assign a
personal fax number to any SAP user who plans to use this feature. To perform
this task, use the following procedure:
1. Login to the SAP R/3 GUI.
2. Type SU01 in the field on the left side of the menu bar.

If this field is closed, you may need to click on the right-facing arrow on the
left side of the menu bar between the Enter (green checkmark) and diskette
icons.

3. From the User Maintenance: Initial Screen window, specify the ID from which
you will be faxing output in the User field and click on the Change (pencil)
icon on the left side of the menu.

4. From the Maintain User window, select the Address tab, scroll down to the
Fax field, and type your number.
For all outgoing calls, this fax number is used as the originator address.

5. Select the Save (diskette) icon to save this data.

Creating documents: To create a document either with or without attachments in
the SAPoffice Outbox, use the following procedure:
1. Login to the SAP R/3 GUI.
2. Type SBWP in the field on the left side of the menu bar.

If this field is closed, you may need to click on the right-facing arrow on the
left side of the menu bar between the Enter (green checkmark) and diskette
icons.

3. Start the Business Workplace application from the Business Workplace of ...
window, and then access the Workplace pane on the left side, click open the
Outbox, and double-click on Documents.
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4. From the resulting right pane view (Figure 45), click on the Create Document
icon (second icon to the left).

Figure 45. Business Workplace of ... window
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5. From the Create Document pop-up dialog, access the Documents contents tab
and type in your message (see Figure 46):

Figure 46. Create Document window
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6. To add an attachment to this document, take the Document → Create
attachment options path.
Once selected, you can access the Attachments tab and see the result:

7. Click on the Send icon (envelope sticking out of a mail slot on far left).

Figure 47. Viewing an attachment on a Fax document
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8. From the Send Document pop-up menu (Figure 48), you can specify a single
recipient for a fax or create a distribution list to use to send the fax. Remember
to start with the country code for each recipient. For example, specify
us9303123456 and then select either the Send icon (envelope sticking out of a
mail slot on far left) at the bottom of the window.

SAP R/3 submits your job to the SAPconnect queue and puts a message at the
bottom of the Business Workplace of ... window. This message indicates that
the document has been sent to the SAPconnect queue. To move the document
to the Infoprint server, you must follow the procedure in “Starting the send
process”.

Starting the send process: Any fax jobs that you have submitted to the
SAPconnect queue will be available for selecting. To test fax documents that have
been received in the SAPconnect queue on the SAP system are successfully sent
onto the Infoprint Manager AIX server, use the following procedure.
1. Login to the SAP R/3 GUI.
2. Type SCOT in the field on the left side of the menu bar.

If this field is closed, you may need to click on the right-facing arrow on the
left side of the menu bar between the Enter (green checkmark) and diskette
icons.

3. From the SAPconnect: Administration (jobs) window (the particular view does
not matter), select the Utilities → Start send process path from the menu bar.

Figure 48. Send Document window
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4. On the Start send process pop-up dialog, select an Addr. type field value of
FAX and click on the green checkmark in the lower left corner.

5. From the SAPconnect Send Process: List of Objects Selected window, select
the Choose icon.
The Express information pop-up dialog provides status on your job.

Configuring to send faxes automatically: Once you have verified that you can
send faxes through the manual process described in “Starting the send process” on
page 115, you should configure your SAP system so the send processes are
scheduled as a background process that executes automatically on a periodic basis.
To schedule the sending of faxes as a background job, use the following procedure:
1. Login to the SAP R/3 GUI.
2. Type SCOT in the field on the left side of the menu bar.

If this field is closed, you may need to click on the right-facing arrow on the
left side of the menu bar between the Enter (green checkmark) and diskette
icons.
Ensure that you select View → Jobs from the drop-down menu.

3. From the SAPconnect: Administration (jobs) window, click on the Dispatch
(piece of paper with upper-right corner folded) icon.

4. From the Schedule send process pop-up dialog, enter a name to represent the
batch job for sending faxes and click the Enter key.

5. To schedule, you can either:
v Click on FAX and then click on the Schedule job icon.
v From the SAPconnect send process: Variants window, highlight the Fax

variant and select the Schedule job (second from left) icon.
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6. From the SAPconnect send process Scheduling: Start Time window
(Figure 49), you can specify the sending characteristics of this job by clicking on
the Schedule Periodically button and set values for how often you want the
fax requests to be sent.

Figure 49. SAPconnect send process Scheduling: Start Time window
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7. From the Period duration window, set a time, being sure to move the radio
button to select the time designation that you are setting.
For example, note that the window (Figure 50) sets the Months field value.

Once you have set your value, be sure that it is saved by checking the green
checkbox at the bottom of the dialog and then accessing the settings again to
verify.

Using SAPconnect for fax in support (receiving faxes)
By configuring SAP to use the new Infoprint Manager SAPconnect support, the
SAP System receives the request in the form of an SAP RFC call. The SAP user’s
fax line uses Infoprint Manager’s fax in support to send incoming faxes to an
Infoprint Manager logical destination, which forwards faxes to a sapconnect actual
destination that is running on the Infoprint Manager AIX server. The sapconnect
actual destination makes SAP RFC calls to the SAP system. When the SAP System
receives the fax request for a particular fax number, it delivers the job to that user’s
In box.

One sapconnect actual destination can deliver faxes for all users on one SAP
system who have defined fax lines. Create one sapconnect destination for each
SAP system you plan to support.

Once you have ensured that the prerequisites are installed on your Infoprint
Manager AIX server (see “Installing the SAPconnect Support” on page 98), you
must complete the following configuration tasks in order to send faxes to a SAP
user:
1. “Creating a CPIC or system type userid for the Infoprint Manager sapconnect

actual destination” on page 119.
2. “Creating Infoprint Manager objects” on page 119.
3. “Logging the Infoprint actual destination onto the SAP system” on page 120.
4. “Assigning fax numbers to SAP users” on page 120.
5. “Configure the fax-in lines to feed the SAPconnect actual destination on an

Infoprint Manager AIX server” on page 121.
6. “Test sending faxes to SAP system” on page 121.

Figure 50. Repeat period window

January 27, 2003

118 Printing Systems Division: Infoprint Manager: SAP R/3 Configuration and Printing Tasks



Creating a CPIC or system type userid for the Infoprint Manager
sapconnect actual destination
Because the Infoprint Manager sapconnect actual destination must logon to the
SAP system to deliver RFC requests to the SAP system that is receiving fax input,
you must create a SAP userid for it. This userid allows the sapconnect actual
destination to send data to the SAP system.

To create a user for the sapconnect actual destination, use transaction su01 to
access the User Maintenance: Initial Screen window.

The user must be a CPIC or System type and have authorizations provided in the
S_A.SCON profile. Remember to record the userid, password, and client values for
when you create the sapconnect actual destination in “Creating Infoprint Manager
objects”.

If you ever modify this SAP userid, remember to make the same changes to the
sapconnect actual destination on the Infoprint Manager AIX server.

Creating Infoprint Manager objects
To create the objects on an AIX Infoprint Manager server necessary to send fax jobs
to the SAP system, use the following procedure.

Note: The Infoprint Manager Administration GUI provides a wizard to
accomplish steps 2 through 7. You can either use the command line
procedure described below, or access the GUI and create the appropriate
printer and objects. For more information on using the GUI, see both the
Infoprint Manager Administration GUI online help and the ″Creating and
managing actual destinations″ chapter of the Infoprint Manager for AIX:
Getting Started manual.

1. Collect the information you require to define this actual destination to
communicate with a SAP system:

Required Information Example

SAP system name SJD

SAP system hostname cpmat00

SAP system number 01

CPIC userid sapuser1

CPIC userid password password

CPIC userid client 095

SAP Gateway Service (for future use)

SAP Gateway Host (for future use)

Program ID (for future use)

2. Use the pdcreate command to define both a queue and a logical destination to
feed the sapconnect actual destination:
v For example, to create a queue named sjd-faxin-queue on the server IPM1,

type:
pdcreate —c queue IPM1:sjd–faxin-queue

v For example, to create a logical destination named sjd-faxin-ld that is
associated with the sjd–faxin-queue queue, type:
pdcreate -x "associated-queue=sjd–faxin-queue" IPM1:sjd-faxin-ld
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3. From an AIX command line, access the SAPconnect attributes file from the
/usr/lpp/pd/attr directory.

4. Copy and rename this file in another directory on your system:
cp /usr/lpp/pd/attr/SAPconnect /var/pd/SAPconnect1

5. Use your AIX editor of choice to edit the file (in this case, SAPconnect1) and
fill in the values you collected in step 1 and the name of the queue that you
created in step 2.
The following contains a copy of the SAPconnect attributes file that is provided
with Infoprint Manager:
# This attribute file contains all the attributes you need to
# create a SAPConnect Actual Destination.
# Copy this file and add in the required information.
#
#
device-support-system = sapconnect
printer-realization = physical
associated-queue =
sap-system-name =
sap-system-hostname =
sap-system-number =
sap-logon-userid =
sap-logon-password =
sap-logon-client =
sap-gateway-service =
sap-gateway-host =
sap-program-id =

6. From an AIX command line, enter the following command to create the
sapconnect actual destination.
pdcreate -X SAPconnect1 IPM1:sjd-faxin

where IPM1 is the name for your Infoprint Manager AIX server and sjd-faxin
is the name of the sapconnect actual destination.

7. From the AIX command line, enable the logical destination:
pdenable sjd-faxin-ld

Logging the Infoprint actual destination onto the SAP system
Before the Infoprint Manager Fax and SAPconnect support can deliver incoming
faxes to SAP, the sapconnect actual destination must be enabled. Issue a pdenable
command on this actual destination:
pdenable -c destination sjd-faxin

When enabled, the sjd-faxin actual destination logs onto the SAP system. Once the
sapconnect DSS actual destination is enabled and logged onto the SAP system, the
SAP users on that system can begin receiving faxes.

Note: The SAP logon may appear to work even if the logon information is
incorrect. When the first fax is processed, if the sapconnect actual
destination on the Infoprint Manager AIX server becomes disabled, look at
the problem message attribute on the actual destination to see the cause of
the problem.

Assigning fax numbers to SAP users
Before receiving faxes, an administrator must assign a personal fax number to any
SAP user who plans to use this feature. To perform this task, use the following
procedure:
1. Login to the SAP R/3 GUI.
2. Type SU01 in the field on the left side of the menu bar.
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If this field is closed, you may need to click on the right-facing arrow on the
left side of the menu bar between the Enter (green checkmark) and diskette
icons.

3. From the User Maintenance: Initial Screen window, specify the ID from which
you will be faxing output in the User field and click on the Change (pencil)
icon on the left side of the menu.

4. From the Maintain User window, select the Address tab, scroll down to the
Fax field, and type your number.
For all outgoing calls, this fax number is used as the originator address.

5. Select the Save icon to save this data.

These fax numbers are those that must be mapped to channel numbers in
“Configure the fax-in lines to feed the SAPconnect actual destination on an
Infoprint Manager AIX server”.

Configure the fax-in lines to feed the SAPconnect actual
destination on an Infoprint Manager AIX server
In order to receive incoming faxes through Infoprint Manager, you must first
purchase, configure, and install the Infoprint Fax feature.

To perform this task, refer to the ″Configuring Fax In (Receiving)″ topic from the
″Configuring and using Infoprint Manager Fax″ in the Infoprint Manager for AIX:
Procedures manual to perform the necessary configuration tasks on your Infoprint
Manager AIX server.

Test sending faxes to SAP system
To verify that you have configured the system correctly and can send faxes, send a
fax to one of the SAP users defined fax numbers and verify that the fax appears in
their SAP Business Workplace Inbox.
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Chapter 16. Print support that applies to both Infoprint AIX
and Infoprint Manager Windows servers

The following topics describe SAP R/3 features that can be used by installations
running SAP R/3 Release 4 and above with either Infoprint Manager for AIX 4.1
or Infoprint Manager for Windows 2.1. Please note that unless clearly identified
with a particular operating system, all interfaces apply to both AIX and Windows
platforms.

Customizing print characteristics
The following topics describe how you can change output appearance when
printing through Infoprint Manager by modifying SAP devices and formats.

How Infoprint processes code pages from ABAP and OTF jobs
Code page support for OTF jobs is more flexible than for ABAP jobs.

Because OTF jobs request a specific font, the SAP transform compares the specified
font name and point size values with the entries in the fonts.tab configuration file.
If the transform finds a match, it uses both the AFP character set and AFP code
page for the print job.

ABAP jobs can use different character sets, but are confined to using the same code
page. When processing ABAP files, the SAP transform uses:
1. the defcp.tab file to map single-byte ASCII code points to EBCDIC code points

before calling the iconv utility.
2. the pagedef.tab file to match the Paper parameter value with the PJPAPER

parameter value in the ABAP print job.
Once they are matched, the SAP transform uses the FontNorm and FontBold
parameters on the selected line within the pagedef.tab file to determine which
character sets to use in both normal and bold mode.

As a result, all ABAP jobs sent to a particular Infoprint server use the same code
page, but potentially different character sets, depending upon the PJPAPER value
specified in the job.

Defining a customized device type
An SAP device type is a collection of table entries that you can access and modify
online to describe the fonts, the printer driver to use to create the data, and the
formats that can be used for SAPscript printing. Every output device must have a
device type that is used to process the output document. An actual destination can
have many output devices, with different device types for each one.

For basic printing, the SAP transform can use existing device types (such as
SAPGOF) and existing formats, such as LETTER or X_65_255. However, if you
plan on customizing any of these print characteristics, you should create a
customized device type so that you will not loose data when you upgrade your
SAP R/3 system.

To create a customized device type, a SAP R/3 administrator must perform the
following procedure from the SAP R/3 graphical user interface:
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1. From the R/3 main menu, access the Spool Administration window by
selecting Tools main menu and then selecting the Tools → Administration →
Spool → Spool Administration path or typing /nSPAD in the ok-Code field.

2. From the Spool Administration window, select Utilities → Copy device type
pull-down option.

3. From the Copy Device Type window, specify the device type you want to
customize (in this case, SAPGOF) in the Copy device type field and provide a
name for your customized Device Type (in this case, ZDOCGOF) in the to device
type field.

Note: Any customized Device Type must start with the Z character or it will be
overwritten when you upgrade to a new level of SAP R/3.

4. From the menu bar, click on the execute icon.
5. From the Create object catalog entry window (Figure 51 on page 125), decide

whether or not you want to be able to copy this customized device type to
another SAP system. If you do, specify a Development class field value.
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If you do not need to copy this Device Type to another SAP system, click on
the Local object push-button:

6. Click on the save icon.

SAP R/3 provides a screen to show the customized Device Type and the original
device type from which it was copied.

Figure 51. Create Object Catalog Entry window
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Changing document print orientation
The sap2afp transform allows you to enhance the quality of your printing from a
SAP R/3 enterprise through the use of form definitions. Form definitions allow
you to use electronic overlays and specify both media orientation (how the page is
printed) and bin selection. The sap2afp transform defines which form definition
should be used for printing through the use of Formats. Every spool job in R/3
requires a Format (Paper type), whether it is ABAP data (″X_65_80″) or OTF data
(″LETTER″). SAP R/3 formats are mapped to Advanced Function Presentation (AFP)
form definitions in the pagedef.tab configuration file. You can display the Format
of a spool request in the output controller (SP01).

By default, the sap2afp transform uses “F1SAP form definition” on page 134,
which by default defines duplex, portrait printing. In addition, Infoprint Manager
provides an assortment of form definitions, which are documented in the IBM
Infoprint Manager: Reference. Consult this list to find a form definition that meets
your printing needs.

The following topic describes how to specify landscape media orientation through
a form definition for an entire document and then connect the newly-created
format to a device type. By mapping an SAP Format to a form definition in the
pagedef.tab file, you can define the media style for the entire job. Depending upon
the type of data you wish to print, there are two separate procedures:
v “Defining a customized device type for ABAP jobs”
v “Defining a new OTF format” on page 127

Defining a customized device type for ABAP jobs
If you are printing Advanced Business Application Programming (ABAP) jobs, you
must create a blank ABAP Format in the SAP system by using the following
procedure:
1. From the R/3 main menu, access the Spool Administration window by

selecting the Tools main menu and then selecting Tools → Administration →
Spool → Spool Administration path, or typing /nSPAD in the ok-Code field.

2. From the Spool Administration: initial screen window, select the Formats
option and click the Change push-button.

3. From the Spool Administration: Format window, select an existing Format (in
this case, X_65_255) from which to copy.

Note: All ABAP system formats follow the naming convention of
X_number-of-rows_number-of-columns.

4. From the Spool Administration: Copy Format from X_65_255 window, specify
the name of your customized Format with the naming convention of
Z_number-of-rows_number-of-columns_more-identifying-text as shown in Figure 52
on page 127:
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5. Select the back icon (the left-pointing arrow) and the system prompts you to
save the new ABAP format.

Once you have saved the new ABAP format, you must use “Connecting a new
format to a device type” on page 129.

Defining a new OTF format
If you are printing Output Text Format (OTF) jobs, you must create page format
with the same name as the customized format you plan to apply:
1. From the R/3 main menu, access the Spool Administration window by

selecting the Tools main menu and then selecting the Tools → Administration
→ Spool → Spool Administration path. or typing the /nSPAD transaction in the
ok-Code field.

2. From the Spool Administration: initial screen window, select the Page
formats option and click the Change push-button.

3. Select the page format that you want to copy (in this case, LETTER) and click
on the copy from push-button.

Figure 52. Spool Administration: Copy Format from X_65_255 window
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4. From the Spool Administration: Copy Page Format from LETTER window,
specify the name of the customized paper type that you are creating (in this
case, ZLETDOC).

5. Select the back icon (the left-pointing arrow) and the system prompts you to
save the new page format.

6. Specify /nSPAD in the ok-Code field.
7. From the Spool Administration: initial screen window, select the Formats

option and click the Change push-button.
8. Select the Format that you wish to copy (in this case, ZLETDOC), and select the

copy from push-button.
9. From the Spool Administration: Copy Format from LETTER window, fill in

the values as displayed in Figure 53:

10. Select the Back icon (the left-pointing arrow) and the system prompts you to
save the new OTF format.

Figure 53. Spool Administration: Copy Format from LETTER window
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Once you have saved the new OTF format, you must use “Connecting a new
format to a device type”.

Connecting a new format to a device type
To use the format you created, you must connect the format to a device type by
performing the following steps:
1. From the R/3 main menu, access the Spool Administration window by

selecting the Tools main menu and then selecting the Tools → Administration
→ Spool → Spool Administration path. or typing /nSPAD in the ok-Code field.

2. From the Spool Administration: initial screen window, select the Device
formats option and click the Change push-button.

3. From the Spool Administration: Choose Format for Device Type window,
specify the Device Type (link to creating custom device types) and your
customized Format name (in this case, Z_65_255_DOC or ZLETDOC) in the
appropriate fields.

Note: All ABAP customized user Formats follow the naming convention of
Z_number-of-rows_number-of-columns_descriptive-text.

4. Select the Execute icon.
5. From the Maintain Format for Device Type window shown in Figure 54 on

page 130, the blank left column indicates that the customized format has not
yet been initialized:
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6. Click on the Copy format push-button.

Figure 54. Spool Administration: Maintain Format for Device Type window
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7. From the Spool Administration: Copy Format window, you can see that the
system has filled in the information from the Maintain Format for Device
Type window as shown in Figure 55:

8. Press the Copy from push-button to initialize your new Format.
9. Select the back icon (the left-pointing arrow) and the system prompts you to

save the new format.
10. Access the pagedef.tab configuration file that resides in the

/usr/lpp/psf/sap2afp directory on an Infoprint Manager AIX server and the
install_path\sap2afp folder on an Infoprint Manager Windows server.

11. Within the pagedef.tab configuration file, create a new entry for the format
that you just created. If you are printing landscape, specify F1C10011 as the
form definition value.

Note: All fields must be specified in pagedef.tab. However, for OTF printing,
only the form definition value is used, while ABAP printing uses all
values.

12. Exit and save the pagedef.tab configuration file.

Changing page print orientation
The sap2afp transform allows you to enhance the quality of your printing from a
SAP R/3 enterprise through the use of form definitions. Form definitions allow
you to use electronic overlays and specify both media orientation (how the page is
printed) and bin selection. A form definition can consist of multiple copy groups,
which are also known as media maps.

The following procedure shows how you can define a name for each defined page
within an existing Layout Set. If you do not need to change page orientation on a
page-by-page basis, refer to “Changing document print orientation” on page 126.
Page-by-page mapping is necessary only if different pages within a document are
formatted differently. You should use a custom layout set when making these

Figure 55. Spool Administration: Copy Format window
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changes. If you use a system Layout Set, your changes are overwritten each time
you upgrade your SAP R/3 system. Remember that each media map remains in
effect until SAP R/3 encounters a new media map.

Every spool job in R/3 requires a format (Paper type), whether it is ABAP data
(X_65_80) or OTF data (LETTER). SAP R/3 formats are mapped to Advanced
Function Presentation (AFP) form definitions in the pagedef.tab configuration file.
You can display the format of a spool request in the output controller (SP01).

When mapping an SAP Format to a form definition in the pagedef.tab file, the first
media map within the form definition defines the media style for the entire job. If
you have a job that contains different electronic overlays on each page, you might
have to switch media styles on each page. The sap2afp transform converts names
defined within SAP Layout Sets in the paper resources for pages to AFP media
map names. For each page that defines a paper resource, the sap2afp transform
uses the AFP media map.

By default, the sap2afp transform uses “F1SAP form definition” on page 134,
which contains 25 separate media maps for simplex printing, duplex printing, bin
selection, and page orientation. In addition, Infoprint Manager provides an
assortment of form definitions, which are described in the Infoprint Manager:
Reference.

Use the following procedure on your SAP application server to modify the media
map on any page of a job by specifying the media map defined in the F1SAP form
definition for the Resource name field:
1. From the SAP R/3 graphical user interface, access the Layout Set menu screen.

You can access this view from the SAP R/3 main menu by either specifying the
SE71 transaction code in the ok-Code field, or by selecting: Tools → Word
Processing → Layout Set

Note: In SAP R/3 Release 4.6C, the Layout Set menu is the Page menu, which
contains the Resource Name field cited in 3 on page 133.

2. From the Layout Set main menu, access the Change Pages option and select
the job for which you are changing page orientation (in this case, ZASORDER1).
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3. From the first page of the job, double-click so that it is highlighted and fill in
the Resource Name field (under the Print Attributes pane) as shown in
Figure 56:

Figure 56. Layout Set Change Pages window, First page
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4. Double-click on the next page that you intend to modify and fill in the
Resource Name field on the second page as shown in Figure 57:

5. Continue with the same procedure on any page where you want to specify a
new media style.

6. Once you have finished, click on the save (open folder) icon to save this
setting.

F1SAP form definition
The form definition specified in the pagedef.tab configuration file is the default
submitted with every Advanced Function Presentation (AFP) data stream
document. F1SAP is the default form definition that each of the media maps
references. Table 8 on page 135 briefly describes the media maps contained within
this form definition.

Note: The print direction is across and the Page Position in inches from the edge
of the paper is 0.165,0.165 for all 25 media maps.

Figure 57. Layout Set Change Pages window, Next page
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Table 8. F1SAP Form Definition Values

Media Map Bin Sides Presentation Mode

F1A10111 1 2 Portrait

S100000P 1 1 Portrait

S200000P 2 1 Portrait

S300000P 3 1 Portrait

S400000P 4 1 Portrait

D100000P 1 2 Portrait

D200000P 2 2 Portrait

D300000P 3 2 Portrait

D400000P 4 2 Portrait

T100000P 1 2 (Tumble) Portrait

T200000P 2 2 (Tumble) Portrait

T300000P 3 2 (Tumble) Portrait

T400000P 4 2 (Tumble) Portrait

S100000L 1 1 Landscape

S200000L 2 1 Landscape

S300000L 3 1 Landscape

S400000L 4 1 Landscape

D100000L 1 2 Landscape

D200000L 2 2 Landscape

D300000L 3 2 Landscape

D400000L 4 2 Landscape

T100000L 1 2 (Tumble) Landscape

T200000L 2 2 (Tumble) Landscape

T300000L 3 2 (Tumble) Landscape

T400000L 4 2 (Tumble) Landscape

Enabling multi-byte character sets for Japanese fonts
The sap2afp transform supports the use of multi-byte character sets (MBCS)
through the use of the iconv utility . To use this support, you must run the
SAPGOF (or a compatible) device type on a SAP R/3 system at Release 4.0A or
higher.

Enabling Korean character sets on an Infoprint Manager AIX
server

To enable this support on an Infoprint Manager AIX server, an administrator must
perform the following procedure:
1. Ensure that the iconv utility is installed on the Infoprint Manager system where

the sap2afp transform is running.
To support the printing of box characters, IBM now provides three customized
conversion files with the sap2afp transform:
v IBM-932-SAP2AFP: which extends the IBM-932 conversion file
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v IBM-1030-SAP2AFP: which extends the IBM-930 conversion file
v IBM-1031-SAP2AFP: which extends the IBM-939 conversion file

For Japan, the sap2afp transform uses the conversion file IBM-932-
SAP2AFP_IBM-1031-SAP2AFP by default. You can modify the ’convert to’
segment of the 80000000.tab and defcp.tab.japan to match by setting the value
to IBM-1030-SAP2AFP.

2. Create a backup copy of the current /usr/lpp/psf/sap2afp/defcp.tab file.
3. Copy the /usr/lpp/psf/sap2afp/defcp.tab.japan file to the

/usr/lpp/psf/sap2afp/defcp.tab file.
4. Create a backup copy of the current /usr/lpp/psf/sap2afp/pagedef.tab file.
5. Copy the /usr/lpp/psf/sap2afp/pagedef.tab.japan to the

/usr/lpp/psf/sap2afp/pagedef.tab file.
6. Obtain the fonts needed for printing.

Font recommendations are given in both the files fonts.tab and pagedef.tab, which
reside in the /usr/lpp/psf/sap2afp directory on an Infoprint Manager AIX server
and the install_path\sap2afp folder on an Infoprint Manager Windows server.

Enabling Japanese character sets on an Infoprint Manager
Windows server

To support the printing of box characters on an Infoprint Manager Windows
server, IBM provides a customized conversion file with the sap2afp transform
named IBM-9932 that resides in the install_path\uconv folder.

To enable this support on an Infoprint Manager Windows server, an administrator
must perform the following procedure:
1. Create a backup copy of the current install_path\sap2afp\defcp.tab file. Ensure

that the iconv utility is installed on the Infoprint Manager system where the
sap2afp transform is running.

2. Copy the install_path\sap2afp\defcp.tab.japanpath file to the
install_path\sap2afp\defcp.tab file.

3. Create a backup copy of the current install_path\sap2afp\pagedef.tab file.
4. Copy the install_path\sap2afp\pagedef.tab.japan to the

install_path\sap2afp\pagedef.tab file.
5. Obtain the fonts needed for printing.

Font recommendations are given in both the files install_path\sap2afp\fonts.tab
and install_path\sap2afp\pagedef.tab.

Enabling multi-byte character sets for Korean fonts
The sap2afp transform supports the use of double-byte character sets (DBCS)
through the use of the iconv utility on both the AIX and Windows operating
systems. To use this support, you must run the SAPGOF (or a compatible) device
type on a SAP R/3 system at Release 4.0A or higher. Before performing either of
the following configuration tasks on AIX and Windows systems, you must first
obtain and install the selected Korean AFP fonts that are required for printing.

Once you have installed these fonts, ensure that your actual destination uses the
/usr/lpp/psf/fontlib directory as its primary search path for fonts. To modify the
font search path from the Infoprint Manager Administration GUI:
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1. From the Infoprint Manager Administration Servers window, highlight the
actual destination.

2. Right-click and select Properties from the pop-up menu.
3. From the printer properties window, select the AFP Resources tab and specify

v /usr/lpp/psf/fontlib in the Location of fonts field, as shown in Figure 58
on Infoprint Manager for AIX

v install_path\fontlib in the Location of fonts field, as shown in Figure 59 on
page 138 on Infoprint Manager for Windows

Figure 58. Printer Properties window for specifying the Fonts Path on AIX.
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Enabling Korean character sets on an Infoprint Manager AIX
server

To support the printing of box characters, IBM provides a customized conversion
files with the sap2afp transform: IBM-933-SAP2AFP, which extends the IBM-933
conversion file.

In addition, Infoprint provides the following resources in the
/usr/lpp/psf/sap2afp/koreanfonts directory:
v C0H0GW72.240 (dpi Korean Gothic character sets)
v C0H0GW96.240 (dpi Korean Gothic character sets)
v C0H0MW72.240 (dpi Korean Myengjo character sets)
v C0H0MW96.240 (dpi Korean Myengjo character sets)
v T1H01150

Figure 59. Printer Properties window for specifying the Fonts Path on Windows.
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With both dpi Korean Gothic character sets and dpi Korean Myengjo character sets
at either 7.2 point size or 9.6 point size, you can print with both box characters and
the check box on/off characters.

Note: To use this support, copy the contents of the /sap2afp/koreanfonts directory
into the /usr/lpp/psf/fontlib directory.

To enable Korean character sets on an Infoprint Manager AIX server, an
administrator must perform the following procedure:
1. Ensure that the iconv utility is installed on the Infoprint Manager system where

the sap2afp transform is running.
2. Create a backup copy of the current /usr/lpp/psf/sap2afp/defcp.tab file.
3. Copy the /usr/lpp/psf/sap2afp/defcp.tab.korea file to the

/usr/lpp/psf/sap2afp/defcp.tab file.
4. Create a backup copy of the current /usr/lpp/psf/sap2afp/pagedef.tab file.
5. Copy the /usr/lpp/psf/sap2afp/pagedef.tab.korea file to the

/usr/lpp/psf/sap2afp/pagedef.tab file.
6. Obtain the fonts needed for printing.

Font recommendations are given in both the files fonts.tab and pagedef.tab, which
reside in the /usr/lpp/psf/sap2afp directory on an Infoprint Manager AIX server.

Enabling Korean character sets on an Infoprint Manager
Windows server

To support the printing of box characters, IBM provides two customized
conversion files with the sap2afp transform:
1. IBM-9949-SAP2AFP: which extends the IBM-9949 conversion file.
2. IBM-9932-SAP2AFP: which extends the IBM-9932 conversion file.

In addition, Infoprint provides the following resources in the
install_path\sap2afp\koreanfonts directory:
v C0H0GW72.240 (dpi Korean Gothic character sets)
v C0H0GW96.240 (dpi Korean Gothic character sets)
v C0H0MW72.240 (dpi Korean Myengjo character sets)
v C0H0MW96.240 (dpi Korean Myengjo character sets)
v T1H01150

With both dpi Korean Gothic character sets and dpi Korean Myengjo character sets
at either 7.2 point size or 9.6 point size, you can print with both box characters and
the check box on/off characters.

Note: To use this support, copy the contents of the
install_path\sap2afp\koreanfonts directory into the install_path\fontlib
directory.

To enable this support on an Infoprint Manager Windows server, an administrator
must perform the following procedure:
1. Create a backup copy of the current install_path\sap2afp\defcp.tab file. Ensure

that the iconv utility is installed on the Infoprint Manager system where the
sap2afp transform is running.

2. Copy the install_path\sap2afp\defcp.tab.korea file to the
install_path\sap2afp\defcp.tab file.
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3. Create a backup copy of the current install_path\sap2afp\pagedef.tab file.
4. Copy the install_path\sap2afp\pagedef.tab.korea file to the

install_path\sap2afp\pagedef.tab file.
5. Obtain the fonts needed for printing.

Font recommendations are given in both the files install_path\sap2afp\fonts.tab
and install_path\sap2afp\pagedef.tab.

Setting up your SAP R/3 system to support new OTF user fonts
Use the following procedure when using the sap2afp transform to print with a
new font that you have created for the job:
1. From the R/3 main menu, access the Font window so you can create a font

family for this new, customized font, by selecting the Tools main menu and
then selecting the Word Processing→Font path. or typing /nSP73 in the
ok-Code field.

2. From the SAPscript Font Maintenance: Initial Screen window, select the Font
families option and select the Change push-button.

3. Select the Create icon and fill in the font information on the Create/Change
Font Family window as shown in Figure 60:

4. Select the Continue push-button.
5. When the system prompts you for a Change Request Query request, select

the Cancel push-button.
6. From the SAPscript Font Maintenance: Initial Screen window, select the

System Fonts option and select the Create push-button.
7. Fill in the information from the Create System... window as shown in

Figure 61 on page 141:

Figure 60. SAPScript Font Maintenance: Create/Change Font Family window
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8. Select the Continue push-button.
9. When the system prompts you for a Change Request Query request, select

the Cancel push-button.
10. From the SAPscript Font Maintenance: Initial Screen window, select the

Printer fonts/AFM metrics option and select the Change push-button.
11. From the Create/Change... window shown in Figure 62 on page 142, select the

intended device type (ZDOCOGF) and fill in the remaining information:

Figure 61. SAPScript Font Maintenance Create System... window
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12. Select the Continue push-button.
Before you can use this new Output Text Format (OTF) font, you must define
a layout set that contains this new font to use your device type.

13. Add an entry in the fonts.tab configuration file that identifies this new OTF
font and ensure that these resources are on the Infoprint server where your
Infoprint actual destination resides.

Printing oversize characters on an IBM 6400 printer with SAP R/3
Infoprint Manager gives you the ability to resize Output Text Format (OTF) fonts
on an IBM 6400 Printer. If your printer supports the graphics object content
architecture (GOCA) feature, you can use the 6400fonts.tab configuration file to
alter the height and width of characters printed. The SIZE= parameter allows you
to specify the height of a font (in points) and have it scaled appropriately. Since
there are 72 points in an inch, 720 indicates a height of an inch. The CPI=
(characters per inch) parameter defines the horizontal width to which the 6400
printer-resident fonts should be scaled. The smaller the number you specify, the
wider the font you receive.

To ensure that a font prints one inch high, specify the following line in the
6400fonts.tab configuration file:
FONT=TIMES SIZE=720 TYPE=3 CODEPAGE=T1V10273 CharSet=C0S0ESTR DB=0

The 6400fonts.tab configuration file resides in the /usr/lpp/psf/sap2afp directory on
an Infoprint Manager AIX server and the install_path\sap2afp folder on an
Infoprint Manager Windows server.

Figure 62. SAPScript Font Maintenance (Create/Change) window for OTF Fonts
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To ensure that a font prints one inch wide, specify the following line in the
6400fonts.tab configuration file:
FONT=TIMES SIZE=360 TYPE=3 CODEPAGE=T1V10273 CharSet=C0S0ESTR DB=0 CPI=1

To ensure that a font prints one-half inch wide, specify the following line in the
6400fonts.tab configuration file:
FONT=TIMES SIZE=360 TYPE=3 CODEPAGE=T1V10273 CharSet=C0S0ESTR DB=0 CPI=2

Once you have modified the 6400fonts.tab file appropriately, access the Print
Screen List window on the SAP R/2 graphical user interface and specify 6400 in
the Title field of the Spool request pane, as shown in Figure 63:

Adding box shading values to printed output
Infoprint Manager supports both Output Text Format (OTF) shading values and
border thickness values. The BX OTF command allows you to print boxes that are
either clear, solid, or contain four different levels of shading. The levels of shading
are a percentage between 0 and 100, with 0 indicating a clear box and 100 a solid
box.

Figure 63. SAP R/3 Interface: Print Screen List window
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The Infoprint Manager SAP transform recognizes the BX OTF command and
creates graphics object content architecture (GOCA) output if passed the -g flag.
Both the ipm_submit and ipm_print commands used by the OMS (see Part 2,
“Installing and Configuring Infoprint Manager’s Output Management (OMS)
Support”, on page 13) and access method L (see Part 3, “Infoprint Manager
non-Output Management Support”, on page 67) automatically pass the -g flag to
the SAP transform through the other-transform-options attribute. For more
information on the other-transform-options attribute and the sap2afp command,
see the Infoprint Manager: Reference manual. For more information on the BX
command values required to specify box shading, refer to your SAP R/3
documentation.

If you use this function with an IPDS Infoprint printer that is not enabled for
GOCA, the file prints a presentation text object content architecture (PTOCA) box
or boxes without shading and the following message sequence for each box at the
end of the job:
0420-535: ERROR: One or more graphics objects were encountered.
The printer does not support this type of object.
:
:
0420-879: Infoprint continues processing the print job: The STOP
when errors found in IMAGE and GRAPHICS data field on the
Infoprint SMIT Error Handling Options panel is set to no.
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Chapter 17. Using bar codes with SAP R/3

The following topics describe the bar codes for printing that can be used when
printing OTF and ABAP output from Infoprint Manager:
v “Bar codes supported by the Infoprint SAP (sap2afp) transform”
v “Setting up your SAP R/3 system to support new OTF user bar codes”
v “Bar codes and printing from SAP R/3 through Infoprint Manager” on page 147
v “Specifying width in SAP bar codes” on page 149.

Bar codes supported by the Infoprint SAP (sap2afp) transform
Some SAP R/3 applications require that data is printed as a bar code. If OTF
specifies bar code data, the sap2afp transform converts it into Bar Code Object
Content Architecture (BCOCA) data, which is understood directly by the control
unit of the AFP printer. This bar code data can also be converted to the Printer
Control Language (PCL) PCL4, PCL5, or PCL5c data streams. This allows Infoprint
Manager to print to any printers that accept Printer Control Language data.

BCOCA is supported by the following printers:
v IBM 3112 Page Printer
v IBM 3116 Page Printer
v IBM 3130 Advanced Function Printer
v IBM 3160 Advanced Function Printer
v IBM Infoprint 60 Printer
v IBM 3812 Page Printer
v IBM 3816 Page Printer
v IBM 3900-OW1 Advanced Function Printer
v IBM 3900-OW3 Advanced Function Printer
v IBM 3900 Advanced Function Duplex Printing System, Models D01, D02
v IBM 3900 Advanced Function Wide Duplex Printing System, Models DW1, DW2
v IBM 3912 Page Printer
v IBM 3916 Page Printer
v IBM 3930 Page Printer
v IBM 3935 Advanced Function Printer
v IBM InfoPrint 4000 Printer IBM
v LaserPrinter 4028
v Network Printer 12 (NP 12)
v Network Printer 17 (NP 17)
v Network Printer 24 (NP 24)

Setting up your SAP R/3 system to support new OTF user bar codes
Use the following procedure when using the sap2afp transform to print with a
new bar code that you have created for the job:
1. From the R/3 main menu, access the Font window by either taking the Word

Processing → Font path, or typing /nSP73 in the ok-Code field.
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2. From the SAPscript Font Maintenance: Initial Screen window, select the
System bar codes option and select the Change push-button.

3. Select the Create icon and fill in the bar code information on the
Create/Change System Bar Code window as shown in Figure 64:

4. Select the Continue push-button.
5. When the system prompts you for a Change Request Query request, select the

Cancel push-button.
6. From the SAPscript Font Maintenance: Initial Screen window, select the

Printer bar codes option and select the Change push-button.
7. From the Create/Change... window displayed below, select the intended bar

code (ZDOCGOF) and fill in the remaining information as shown in Figure 65 on
page 147:

Figure 64. SAPScript Font Maintenance (Create/Change) System Bar Code window
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8. Select the Continue push-button.
Before you can use this new Output Text Format (OTF) bar code, you must
define a layout set that contains this new bar code to use your device type (in
this case, ZDOCGOF).

9. Add an entry in the barcode.tab configuration file that identifies this new OTF
bar code name to an actual bar code type. The barcode.tab configuration file
identifies values in the following format:
BarCode=ZDOBAR Type=017 Mode=002 Flag=128

For more information about the barcode.tab configuration file and how it relates to
the Bar Code Object Content Architecture (BCOCA), see “Bar codes and printing
from SAP R/3 through Infoprint Manager”.

Bar codes and printing from SAP R/3 through Infoprint Manager
Table 9, Table 10 on page 148, and Table 11 on page 149 map the Bar Code Object
Content Architecture values with the SAP R/3 system values found in the
barcode.tab configuration file, which resides in the /usr/lpp/psf/sap2afp directory
on an Infoprint AIX system and the install_path\sap2afp folder on an Infoprint
Windows system.

Table 9. Bar Code Type Field Values

Bar Code Type Field Values Description

X’01’ Code 3 of 9

X’02’ MSI

X’08’ EAN-8

X’09’ EAN-13

X’0C’ Interleaved 2 of 5

X’11’ Code 128

X’18’ POSTNET

Figure 65. SAPScript Font Maintenance (Create/Change) window
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Table 10. Bar Code Mode Field Values

Mode Field Values Bar Code Type Meaning

1 X’01’ Present the bar code without a generated check
digit.

2 X’01’ Generate a check digit and present it with the bar
code.

1 X’02’ Present the bar code without check digits generated
by the printer.

2 X’02’ Present the bar code with generated IBM
modulo-10 check digit. This check digit is the
second check digit; the first check digit is the last
byte of the BSA data.

3 X’02’ Present the barcode with two check digits. Both
check digits are generated using the IBM
modulo-10 algorithm.

5 X’02’ Present the barcode with two check digits. The first
check digit is generated using the IBM modulo-11
algorithm; the second using the IBM modulo-10
algorithm. The first check digit equals the
remainder; exception condition EC-0E00 exists if
the first check-digit calculation results in a value of
10.

0 X’08’ Present an EAN-8 barcode symbol. The input data
consists of seven digits: two flag digits and five
article digits. All seven digits are encoded along
with a generated check digit.

0 X’09’ Present an EAN-13 barcode symbol. The input data
consists of twelve digits: two flag digits and ten
article digits, in that order. The first flag digit is not
encoded. The second flag digit, the article number
digits, and generated check digits are encoded. The
first flag digit is presented in HRI form at the
bottom of the left quiet zone. The first flag digit
governs the A and B number-set pattern of the
barcode and space coding of the six digits to the
left of the symbol center pattern.

1 Present the bar code without a generated check
digit. In sequence, the input data consists of a start
character, digits to be encoded, and a stop
character.

2 X’0C’ Generate a check digit and present it with the bar
code. In sequence, the input data consists of a start
character, digits to be encoded, and a stop
character.

2 X’11’ Generate a Code 128 symbol using subset A, B, or
C as appropriate, to produce the shortest possible
bar code from the given data. The Code 128 code
page is used to interpret the bar code symbol data.
Generate a check digit and present it with the data.

0 X’18’ Present the ZIP code as 5 digits.

1 X’18’ Present the ZIP code as 9 digits.
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Table 11. Bar Code Flag Values

Flag Field Values Meaning

128 Present without Human Readable Text (HRI)

0 Present with Human Readable Text

Specifying width in SAP bar codes
Infoprint Manager allows you to modify bar code width using the same command
syntax provided with the Page Printer Formatting Aid (PPFA) product. By
modifying the barcode.tab configuration file to use the ModWidth parameter, you
can change the width of bar codes and the wide-to-narrow ratio.

ModWidth
Specifies the width of the smallest defined bar code element, using mils
(thousandths of an inch). For bar code types that explicitly specify the
module width (for example, POSTNET and RM4SCC), this field is
ignored. The range of values allowed is 1–to-254. If ModWidth is not
specified in the barcode.tab file, the sap2afp transform uses the defaulted
bar code width.

n Specifies the width of each module, using thousandths of an inch (1/1000)
as the unit of measure.

Ratio Specifies a percent value in the form nnn. For example, 200 represents a
ration of 2.5 to 1. For most bar code symbols, the Ratio value should be
between 200and 300. For bar code types that explicitly specify the module
width (for example, POSTNET and RM4SCC), this field is ignored. If
Ratio is not specified, the default ratio for the bar code symbol is used.
This value must be a three-digit character between 100 and 500.

To shorten an existing bar code, you can specify the following line in the
barcode.tab file:
BarCode = BC_CD39 Type = 001 Mode = 001 Ratio = 2000 ModWidth = 10
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Appendix A. SAPconnect fax-out configuration worksheet

While configuring the SAP system for fax-out, use the following worksheet to
record the values that will be needed to configure and start the Infoprint Manager
SAPconnect daemon.

Table 12. SAPconnect Configuration Worksheet Values

Parameter Value Used in
/etc/rc.iprsap

Used in
/var/pd/saprfc.ini

IPMLogicalDestinationName x

Logon User x

Logon Password x

Logon Client x

RFC Destination x x

Program ID x

Gateway Host x

Gateway Server x

SAP System Name x x

SAP System Number (for specific
application server)

SAP Application Server Host (for specific
application server)

SAP Message Server (for load balancing)

SAP Application Server Group (for load balancing)
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Appendix B. Alternate access methods for submitting SAP
jobs to Infoprint Manager

To use Infoprint Manager as an SAP OMS you define your SAP devices to use
access method E (see Part 2, “Installing and Configuring Infoprint Manager’s
Output Management (OMS) Support”, on page 13). If you cannot use Infoprint
Manager as an SAP OMS, IBM recommends defining your SAP devices to use
access method L(see Part 3, “Infoprint Manager non-Output Management Support”
, on page 67). There are other access methods that can be used for submitting print
jobs from SAP systems to Infoprint Manager. This topic describes some of those
methods. These methods do not require an Infoprint SAP Client to be installed on
your SAP system, but do not allow SAP job attributes to be passed with the job or
provide for any status information regarding the job to be known on the SAP
system. You can install and use the SAP transform with these methods.

Defining SAP devices using access method U
From your SAP system, you can submit jobs to either an Infoprint AIX or Infoprint
Manager Windows server using LPD by defining your SAP device to use access
method U.

This method is intended for Infoprint Manager users whose SAP R/3 applications
run on non-AIX systems. This method is discouraged with SAP systems running
on AIX because you must create AIX print queues to use it. For a preferred method
of submitting jobs from SAP systems to Infoprint Manager that provides better
feedback, see either Part 2, “Installing and Configuring Infoprint Manager’s Output
Management (OMS) Support”, on page 13 or Part 3, “Infoprint Manager
non-Output Management Support”, on page 67.

To use access method U to send jobs to Infoprint Manager, you need to ensure that
the LPD service is running on the Infoprint server. Use the procedure appropriate
to your Infoprint Manager server operating system:
v “Verifying the Infoprint for Windows LPD service is started”
v “Verifying the LPD service is started on Infoprint AIX” on page 154

Verifying the Infoprint for Windows LPD service is started
In order to submit jobs to Infoprint Manager through the LPD service, the
Infoprint Manager LPD service that comes with Infoprint Manager for Windows
must be active. Note that this service is different from the LPD Windows service
that comes with the base operating system. Use the following procedure to verify
that the service is started on your Infoprint Manager Windows server, and if
necessary, to activate the Infoprint Manager LPD service:
1. From the Start menu, click on the Programs → Infoprint Manager →

Management Console path.
2. Click File→ Stop Server.
3. Access the Edit → Service Configuration... path.
4. From the Service Configuration window, ensure that the Run Infoprint

Manager LPD service check box has been checked (as shown in Figure 66 on
page 154). Press OK to save this change.
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5. Click File →Start Server.
6. Exit the Infoprint Manager Management Console.

Verifying the LPD service is started on Infoprint AIX
In order to submit jobs to Infoprint Manager through LPD, you must ensure that
the AIX lpd daemon is active on your Infoprint Manager AIX server.

Figure 66. MMC Service Configuration window
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To either verify that the lpd daemon is active or to start it on your Infoprint
Manager AIX server:
1. From an AIX command line, use either smit or smitty to access the System

Management Interface Tool.
2. From the main menu, take the Print Spooling → Manage Print Server path.
3. From the Manage Print Server panel, scroll down and click on the Show Status

of the Print Server Subsystem selection.
If the lpd subsystem displays an inoperative status, return to the Manage Print
Server panel and click on the Start the Print Server Subsystem (lpd daemon)
selection.
If the lpd subsystem displays an active status and shows a PID value, you can
exit the SMIT interface and do not have to take any action.

4. From the Start the Print Server Subsystem panel, take the default values and
press Enter.
The system responds with a message similar to the following:
0513-059 The lpd Subsystem has been started. Subsystem PID is 25550.

which indicates that the lpd daemon is now active.
5. Exit the SMIT interface.

Defining devices that use Infoprint Manager for access
method U

To define SAP devices to use access method U, follow this procedure:
1. Ensure that you have a logical printer defined in Infoprint Manager, which will

send jobs to your physical printer device.
2. From the R/3 main menu, access the Spool Administration window by

selecting the Tools main menu and then selecting the Tools → Administration →
Spool → Spool Administration path or typing /nSPAD in the ok-Code field.

3. From the Spool Administration window, select the Output devices option and
select the Change push-button.

4. Select the Create icon and fill in the following information on the Create
Output Device window:

Field Explanation Example Value

Output Device
Type the name that R/3
users need to access the
printer.

ipm1pms

Device type Select the device type that
has been defined in the R/3
system for the printer model.
For example, POST2 applies
to any PostScript printer.

POST2

Spool server Select the name of the R/3
application server, which will
be the SAP R/3 spool server
(spool work process), that
transfers output across a
network link.

hrmssbx_SBX_00

Destination hosts Type the hostname for the
Infoprint server.

nwser
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Host printer Type the name of the
Infoprint Manager logical
destination.

prt1-lp

Device class Enter a space so that this
field accepts the default
value of printer, which is P,
or you can specify Standard
printer, as in the example
on Figure 67.

Access method in host spool Select the method that the
spool work process uses to
pass data to the host spool
system.

U

5. From the menu bar, click on the Back icon and the system prompts you to save
the new output device.

Once you have completed this task, you can begin submitting jobs to Infoprint
Manager.

Figure 67. Sample printer definition for access method U from Spool Administration: Create Output Device window
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Submitting jobs from Windows SAP systems to Infoprint Manager
Windows with access method C

If your SAP system runs on a Windows system, you can submit jobs to a printer
running on an Infoprint Manager Windows server through Access Method C. To
configure your Windows SAP system to print through an Infoprint Manager
Windows server, you must create a Windows gateway printer on that Infoprint
Manager Windows server, and then define devices on your SAP system to use
access method C.

A Windows gateway printer is the combination of a printer driver and a port. You
can create a Windows printer using the Windows Add printer wizard. You can see
these printers from the Windows Printers window, but you should never open and
modify them from there.

To define SAP devices to use access method C, follow this procedure:
1. Ensure that you have a logical printer defined in Infoprint Manager that sends

jobs to your actual destination device.
2. From the R/3 main menu, access the Spool Administration window by

selecting the Tools main menu and then selecting the Tools → Administration →
Spool → Spool Administration path or typing /nSPAD in the ok-Code field.

3. From the Spool Administration window, select the Output devices option and
select the Change push-button.

4. Select the Create icon and fill in the following information on the Create
Output Device window:

Field Explanation Example Value

Output Device Type the name that R/3
users will need to access the
printer.

prt2

Device type Select the device type that
has been defined in the R/3
system for the printer model.
HPLJ4 applies to a
Hewlett-Packard LaserJet 4
printer.

HPLJ4

Spool server Select the name of the R/3
application server, which will
be the SAP R/3 spool server
(spool work process), that
transfers output across a
network link.

rt1_RT1_00

Host printer Type the hostname of the
Infoprint Manager Windows
server (ANAKE ), followed by
the Windows shared printer
name (EDPTEST).

\\ANAKE\EDPTEST

Device class Enter a space so that this
field accepts the default
value of printer, which is P.

Access method in host spool Select the method that the
spool work process uses to
pass data to the host spool
system.

C

January 27, 2003

Appendix B. Alternate access methods for submitting SAP jobs to Infoprint Manager 157



5. From the menu bar, click on the Back icon and the system prompts you to save
the new output device.

prt2

Figure 68. Sample printer definition for access method C from Spool Administration: Change Output Device window
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Notices

This information was developed for products and services offered in the U.S.A.

IBM® may not offer the products, services, or features discussed in this document
in other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property rights may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION ″AS IS″ WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) described in this publication at any time without
notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2–31 Roppongi 3–chome, Minato-ku
Tokyo 106, Japan
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Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
Department 11PA Building 002S
PO Box 1900
Boulder CO 80301 USA

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee. The licensed program described in this
document and all licensed material available for it are provided by IBM under
terms of the IBM Customer Agreement, IBM International Program License
Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

For online versions of this book, we authorize you to:
v Copy, modify, and print the documentation contained on the media, for use

within your enterprise, provided you reproduce the copyright notice, all
warning statements, and other required statements on each copy or partial copy.

v Transfer the original unaltered copy of the documentation when you transfer the
related IBM product (which may be either machines you own, or programs, if
the program’s license terms permit a transfer). You must, at the same time,
destroy all other copies of the documentation.

You are responsible for payment of any taxes, including personal property taxes,
resulting from this authorization.

Your failure to comply with the terms above terminates this authorization. Upon
termination, you must destroy your machine readable documentation.
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Trademarks
The following are trademarks or registered trademarks of International Business
Machines Corporation:

Advanced Function Printing
AFP
AIX
AS/400
eNetwork
IBM
IBM Cross Platform Technologies for Windows
Infoprint
Intelligent Printer Data Stream
IPDS
Micro Channel
MVS
OS/2
OS/390
OS/400
Print Services Facility
S/390
System/370

The following are trademarks of other companies:
v Java and all Java-based trademarks and logos are trademarks or registered

trademarks of Sun Microsystems, Inc. in the United States, other countries, or
both.

v Microsoft, MS-DOS, Windows, Windows NT, Windows 2000, Windows ME,
Microsoft Visual Basic, Microsoft Visual C++, and the Windows logo are
trademarks of Microsoft Corporation in the United States, other countries, or
both.

v Pentium is a registered trademark of Intel Corporation in the United States,
other countries, or both.

v UNIX is a registered trademark of The Open Group in the United States and
other countries.

Other company, product, and service names may be trademarks or service marks
of others.

EuroReady
Infoprint Manager is capable of processing data containing the euro sign. Font
character sets and code pages that contain and map the euro sign consistently with
the application must be present either in a host library or in the printer. AFP fonts
that support the euro sign are included in the AFP Font Collection (Program
Number 5648-B33).
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Special characters
/etc/hosts file 23

specifying SAP hosts for sapconnect fax support 107
/etc/hosts.equiv file 22, 76
/etc/rc.iprsap 40
/etc/rc.iprsap file 41, 107
/home/sapuser/.rhosts file 22, 76
/usr/lpp/pd/attr directory

SAPconnect file install location 120
/usr/lpp/pd/bin file 23
/usr/lpp/pd/bin/ipm_dev_query* file 23
/usr/lpp/pd/bin/ipm_job_cancel* file 23
/usr/lpp/pd/bin/ipm_job_query* file 23
/usr/lpp/pd/bin/ipm_print.sys file 77
/usr/lpp/pd/bin/ipm_query.sys file 77
/usr/lpp/pd/bin/ipm_submit* file 23
/usr/lpp/pd/bin/ipm.omsdesc file 23
/usr/lpp/psf/bin 17, 20, 71, 74
/var/pd directory

editing the saprfc.ini file 106
sapconnd.sysname/error.log file 108

install_path\bin 20, 74
install_path\sap2afp 20, 74

A
about this publication 7
access method C

printing PCL and PostScript 157
access method C, using 157
access method E install

SAP fonts, installing on Infoprint Manager AIX server 17,
71

SAP fonts, installing on Infoprint Manager Windows
server 18, 72

access method E, installing Infoprint 15
access method L

Installing the SAP Client when SAP runs on AIX 79
Installing the SAP Client when SAP runs on HP-UX 75
Installing the SAP Client when SAP runs on Sun

Solaris 75
Installing the SAP Client when SAP runs on Windows 81
modifying the print profile 85
non-OMS printing to Infoprint Manager AIX server 89

access method U
printing 155

activating the fax function in SAP Office 103
activating user pop-ups

for SAP R/3 access method E 51
limitation in pre SAP R/3 4.5B systems 51

adding box shading values 143
adding electronic forms and logos 4
adding electronic forms to text 4
Advanced Function Presentation data 4
advanced OMS configuration

for SAP R/3 access method E 51
afpfonts.codepage 18, 72
afpfonts.compats 18, 72
afpfonts.ocr 18, 72

AIX files
/etc/hosts.equiv 22, 76
/home/sapuser/.rhosts 22, 76
/usr/lpp/pd/bin/ipm_dev_query* 23
/usr/lpp/pd/bin/ipm_job_cancel* 23
/usr/lpp/pd/bin/ipm_job_query* 23
/usr/lpp/pd/bin/ipm_print.sys 77
/usr/lpp/pd/bin/ipm_query.sys 77
/usr/lpp/pd/bin/ipm_submit* 23
/usr/lpp/pd/bin/ipm.omsdesc 23

AIX filesets
bos.loc.adt.iconv 8, 17, 71

AIX Servers, installing Infoprint OMS support 25
audience

for this manual 7

B
bar codes

BCOCA values in barcode.tab file 147
ModWidth values in barcode.tab file 149
Ratio values in barcode.tab 149
supported by the SAP transform 145
supporting new user OTF bar codes 145

barcode.tab file
Flag values 147
Mode values 147
ModWidth values 149
Ratio values 149
Type values 147

barcode.tab file values 147
bos.loc.adt.iconv fileset

required for installs 8, 17, 71
box shading values 143
BX OTF command

box shading support 143

C
cancelling jobs

for SAP R/3 access method E 50
changing page print orientation

changing document print orientation 131
collecting information necessary to start an SAP callback

daemon or process 40
commands

-c flag for failing over Infoprint Manager servers 62
-c flag for sending jobs to other Infoprint Manager

servers 56
-c flag for switching Infoprint Manager servers 60
BX OTF 143
ipm_print 85
ipm_query 85
pdcreate 120
pdenable 120
startsapconnectd 108

configuration files
6400fonts.tab 21, 75
6400fonts.tab values 142
barcode.tab 21, 75
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configuration files (continued)
barcode.tab values 147, 149
defcp.tab 21, 75, 136, 139
fonts.tab 17, 21, 71, 75, 136, 139, 140
image.tab 21, 75
pagedef.tab 21, 75, 126, 131, 134, 136, 139, 140
stored in /usr/lpp/psf/bin 17, 71
table listing 20, 74
xxxxyyyy.tab 21, 75

configuration, access method C
submitting jobs from SAP Windows systems 157

configuration, access method U
defining SAP devices 153

configure to use SAP clients
Infoprint Manager AIX server 76
Infoprint Manager Windows server 21, 75

configuring
using access method E with Infoprint Manager AIX

server 31
configuring the Infoprint Manager AIX server

for HP-UX and Sun servers (OMS) 22
configuring the Infoprint server

for HP-UX and Sun Solaris servers 75
configuring the Infoprint server (OMS)

for HP-UX and Sun Solaris servers 21
configuring the RFC initialization file

Infoprint Manager AIX server tasks 105
configuring the SAP Callback daemon

for SAP R/3 access method E 41
configuring the SAP system server

for HP-UX and Sun servers 23
for HP-UX and Sun Solaris servers 77

configuring the SAP transform
for SAP R/3 access method E 19
for SAP R/3 access method L (non-OMS) 73

configuring the SAPconnect daemon
for SAP R/3 Release 4.6 108

configuring the SAPconnect daemon on Infoprint 105
configuring to send faxes automatically 116
connecting a format to a device type

changing document print orientation 129
CPIC userid 119
CPIC userid client 119
CPIC userid password 119
creating a SAP CPIC user

for SAP R/3 Release 4.6c 99
creating a SAP CPIC user (AD)

for SAP R/3 Release 4.6c 119
creating a SAP RFC destination

for SAP R/3 Release 4.6c 99
creating a SAPconnect node 103
creating an R/3 fax device (SAPcomm) 93
creating fax addresses 111
creating fax addresses, fax-in 120
creating fax documents 111
creating Infoprint Manager Objects 119
customized device type (ABAP), defining 126
customizing print characteristics 123

changing document print orientation 126
defining a customized device type 123

customizing SAPconnect 103

D
daemons

sapcbd 17, 71
sapcbd (for callback) 15

daemons (continued)
SAPconnect 99
sapconnectd (for fax) 15

data stream formats, accepted by SAPconnect node 104
default form definition

F1SAP 134
defcp.tab configuration file 136, 139
defining a customized device type (ABAP)

changing document print orientation 126
defining a Logical Output Management system

for SAP R/3 access method E 34
defining a new OTF format

changing document print orientation 127
defining a Real Output Management system

for SAP R/3 access method E 31
defining a SAP user for OMS Callback

for SAP R/3 access method E 39
defining another Logical Output Management system

for SAP R/3 access method E 55
defining devices

modifying the print profile for access method L 85
using access method C 157
using access method L 89
using access method U 155

defining devices to Infoprint OMS
for SAP R/3 access method E 44

defining devices with SAPGOF 44
defining SAP devices

configuration tasks, access method U 153
defining the Infoprint Manager OMS to SAP

for SAP R/3 access method E 31
deleting a callback process on Windows

for SAP R/3 access method E 65
description

for this manual 7
device status, displaying

for SAP R/3 access method E 48
device type

definition 123
directories

/usr/lpp/pd/attr 120
/usr/lpp/pd/bin/ 106
/usr/lpp/psf/bin 17, 20, 71, 74
/var/pd 106, 108

displaying device status
for SAP R/3 access method E 48

distributing the callback workload 55
document print orientation, changing 126
DSS

sapconnect 96

E
enabling multi-byte character sets for Japanese fonts 135
enabling multi-byte character sets for Korean fonts 136
enhanced job status, viewing

for SAP R/3 access method E 47
examples

creating a fax-in logical destination 120
enabling a fax-in logical destination 120
failing over to other servers in the same Infoprint Manager

system 63
sending jobs to multiple Infoprint Manager systems 57
switching Infoprint Manager servers 62

expanding server ports
for the SAP Callback process 43
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F
F1SAP form definition 134
failing over to other servers in the same Infoprint Manager

system 62
fax in support

creating a sapconnect actual destination 119
logging a sapconnect actual destination onto SAP 120

fax in support, creating a SAP user
for SAP R/3 Release 4.6c 119

fax numbers
assigning to fax users 120

fax support, using Infoprint 8
fax-out

SAPconnect configuration worksheet 151
fax-out using SAPcomm 93
faxes, creating addresses 111
faxes, creating addresses for fax-in 120
faxes, creating documents 111
faxes, sending automatically 116
faxes, sending faxes to the Infoprint Manager AIX server 115
files

/etc/hosts 23
/etc/rc.iprsap 41, 107, 151
/usr/lpp/pd/bin 23
/var/pd/saprfc.ini 151
ipm_dev_query 26
ipm_job_cancel 26
ipm_job_query 26
ipm_submit 26
ipm.omsdesc 31
rc.iprsap 40, 41
sapcbd 15
sapcbd.exe 15
SAPconnect 120
saprfc.ini 106

filesets
ipr.sapclient 25, 79

fonts.tab configuration file 17, 71, 136, 139, 140
format

defining 127
format, connecting to a device type 129
format, see paper type 126

G
Generic Output Format (SAPGOF)

support for Japanese PC language 4
support for OTF and ABAP data streams 5

H
how to use this document 7
HP-UX servers overview 8
HP-UX servers, installing Infoprint

configuring the Infoprint server 75
configuring the SAP system server 77

HP-UX Servers, installing Infoprint
configuring the Infoprint Manager AIX server (OMS) 22
configuring the SAP system server 23

HP-UX servers, installing Infoprint (OMS)
configuring the Infoprint server 21

HP-UX Servers, installing Infoprint OMS support 21
http://www.ibm.com/printers 7

I
IBM Printing Systems web page ii
Infoprint AIX, print support 123
Infoprint Fax Actual Destination

using for SAPconnect fax-out support 98
Infoprint fax support 8
Infoprint filesets

ipr.sapclient 25
Infoprint Manager AIX server

access method E configuration 31
configure to use SAP clients 76
configure to use SAP clients (OMS) 22

Infoprint Manager AIX server tasks
configuring the RFC initialization file 105
configuring the SAPconnect daemon 108
shutting down the SAPconnect daemon 109
starting the SAPconnect daemon 107

Infoprint Manager CD-ROMs
Common Clients 16
SAP Print Feature 16

Infoprint Manager for AIX SAP OMS
for reliable job status notifications 4

Infoprint Manager for AIX service updates (PTFs)
PTF U484268 56, 60, 61, 62

Infoprint Manager for Windows SAP OMS
for reliable job status notifications 4

Infoprint Manager for Windows service updates (PTFs)
PTF UR53740 42, 56, 60, 61, 62

Infoprint Manager jobs
sending to multiple Infoprint Manager systems 55

Infoprint Manager Management console
SAP Callback Processes support 64

Infoprint Manager Management Console
SAP Callback Processes support 65

Infoprint Manager OMS server switching
described 5
failing over 62
sending jobs 55
summary 8
switching servers within same name space 60

Infoprint Manager OMS, defining to SAP
for SAP R/3 access method E 31

Infoprint Manager SAP Callback daemon
overview 15

Infoprint Manager SAPconnect daemon
overview 15

Infoprint Manager servers
failing over within the same Infoprint server 62
switching 60

Infoprint Manager service updates
failing over to other Infoprint Manager servers support 62
PTF U484268 support 8
PTF UR53740 support 8
sending jobs to multiple Infoprint Manager systems

support 55
switching Infoprint Manager servers support 60

Infoprint Manager Windows server
configure to use SAP clients 21, 75

Infoprint Manager: Common Clients CD-ROM
for installing SAP Clients 16

Infoprint Manager: SAP Print Feature CD-ROM 16
Infoprint OMS, defining devices

for SAP R/3 access method E 44
Infoprint Windows, print support 123
install_path\bin\ipm.omsdesc file 23
installing

SAP/R3 overview 7
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installing (continued)
SAPconnect 98
the SAP Client when SAP runs on AIX 79
the SAP Client when SAP runs on HP-UX 75
the SAP Client when SAP runs on Sun Solaris 75
the SAP Client when SAP runs on Windows 81

Installing Infoprint Manager OMS support
when SAP runs on AIX servers 25
when SAP runs on HP-UX or Sun servers 21
when SAP runs on Windows 27

installing Infoprint overview
Infoprint fax support 8
print support for Infoprint AIX and Infoprint Windows

servers 8
SAP R/3 on HP-UX or SUN servers 8

Installing Infoprint with SAP R/3 for OMS support 15
Installing Infoprint with SAP R/3 for printing 69
Internet, information on

IBM Printing Systems ii
introduction

how to use this publication 7
ipm_dev_query

AIX Servers, installing Infoprint OMS support 26
ipm_job_cancel 56, 60, 62

AIX Servers, installing Infoprint OMS support 26
ipm_job_query 56, 60, 62

AIX Servers, installing Infoprint OMS support 26
ipm_print command 85
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ipm_query command 56, 60, 62, 85

for non-OMS printing 69
ipm_submit

AIX Servers, installing Infoprint OMS support 26
ipm_submit command 56, 60, 62
ipm.omdesc file
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ipm.omsdesc file 23
ipr.sapclient fileset 79

J
Japanese fonts, enabling multi-byte character sets 135
Japanese PC language support 4
jobs, cancelling

for SAP R/3 access method E 50

K
keyboard short cuts for the SAP GUI 9
Korean fonts, enabling multi-byte character sets 136
Korean PC language support 4

L
logging a sapconnect actual destination onto SAP

for SAP Fax-In support 120
Logical Output Management system, defining

for SAP R/3 access method E 34
Logical Output Management system, defining another

for SAP R/3 access method E 55
LOMS commands

failing over within the same Infoprint server 62
modifying for Infoprint server switching 60
sending jobs to multiple Infoprint Manager systems 55

LOMs, organizing OMS output devices
distributing the callback workload 55

LOMs, organizing OMS output devices (continued)
supporting multiple Infoprint Manager systems 55
using different different OMS services 55
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LPD service, from Infoprint Manager AIX server 154
LPD service, from Infoprint Windows 153

M
management console

SAP Callback Processes support 42, 64
modifying the print profile

defining devices for access method L 85
ModWidth values in barcode.tab 149
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moving OMS definitions among SAP systems

for SAP R/3 access method E 59

N
node routing, verify 110
non-OMS printing to Infoprint Manager AIX server

defining devices for access method L 89
non-OMS SAP R/3 , installing Infoprint 69
notices 159

O
OMS Callback, defining a SAP user

for SAP R/3 access method E 39
OMS commands

-c flag for failing over Infoprint Manager servers 62
-c flag for sending jobs to other Infoprint Manager

servers 56
-c flag for switching Infoprint Manager servers 60
host parameter 56, 60, 62
socket parameter 56, 60, 62

OMS configuration, advanced
activating user pop-ups 51
for SAP R/3 access method E 51
moving OMS definitions among SAP systems 59
organizing output devices into LOMS 54
selecting event report levels 53

OMS support
when SAP runs on AIX servers 25
when SAP runs on HP-UX or Sun servers 21
when SAP runs on Windows 27

OMS support tasks, using 46
OMS, see Output Management System 4
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for SAP R/3 access method E 54
OTF bar codes, support 145
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OTF format, defining 127
Output Management System (OMS)
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page print orientation, changing 131
pagedef.tab configuration file 126, 131, 134, 136, 139, 140
paper type, see format 126
paths

install_path\bin 20, 74
install_path\sap2afp 20, 74

pdcreate command 120
pdserver

Infoprint Manager server 16
penable command 120
preparing and sending faxes 111, 121
print management 4
print profile

modifying for access method L 85
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information to start 40

SAP Callback process
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SAP Callback process, starting
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SAP OMS overview
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